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    Safety Guidelines 
This manual contains notices which you should observe to ensure your own personal safety as well as to avoid 
property damage. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring to property damage only have no safety alert symbol. 

   
Danger 
indicates an imminently hazardous situation which, if not avoided, will result in death or serious injury.

   
Warning 
indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.

   
Caution 
used with the safety alert symbol indicates a potentially hazardous situation which, if not avoided, may 
result in minor or moderate injury. 

 Caution 
used without safety alert symbol indicates a potentially hazardous situation which, if not avoided, may 
result in property damage. 

 Notice 
used without the safety alert symbol indicates a potential situation which, if not avoided, may result in 
an undesirable result or state. 

When several danger levels apply, the notices of the highest level (lower number) are always displayed. If a 
notice refers to personal damages with the safety alert symbol, then another notice may be added warning of 
property damage. 

Qualified Personnel 
The device/system may only be set up and operated in conjunction with this documentation. Only qualified 
personnel should be allowed to install and work on the equipment. Qualified persons are defined as persons who 
are authorized to commission, to earth, and to tag circuits, equipment and systems in accordance with 
established safety practices and standards. 

Intended Use 
Please note the following: 

   
Warning 
This device and its components may only be used for the applications described in the catalog or 
technical description, and only in connection with devices or components from other manufacturers 
approved or recommended by Siemens. 
This product can only function correctly and safely if it is transported, stored, set up and installed 
correctly, and operated and maintained as recommended. 

Trademarks 
All designations marked with ® are registered trademarks of Siemens AG. Other designations in this 
documentation might be trademarks which, if used by third parties for their purposes, might infringe upon the 
rights of the proprietors. 

Copyright Siemens AG, 2004. All rights reserved 
Reproduction, transmission or use of this document or its contents is not permitted without 
express written authority. Offenders will be liable for damages. All rights, including rights 
created by patent grant or registration of a utility model or design, are reserved. 

 Disclaimer of Liability 
We have checked the contents of this manual for agreement with the hardware and 
software described. Since deviations cannot be precluded entirely, we cannot guarantee 
full agreement. However, the data in the manual are reviewed regularly, and any 
necessary corrections will be included in subsequent editions. Suggestions for 
improvement are welcomed. 

Siemens AG 
Automation and Drives Group 
P.O. Box 4848, D-90327 Nuremberg (Germany)  

© Siemens AG 2004  
Technical data subject to change 
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Preface 

Purpose of this manual 
This manual provides information based on the requirements defined by DIN 8418 regarding 
mechanical engineering documentation. This information relates to the device, its place of 
use, transport, storage, installation, use and maintenance. 
This manual is intended for the following target groups: 
• User 
• Commissioning engineers 
• Service technicians 
• Maintenance technicians 
Please read carefully the section "Safety information and general notes". 
The help integrated in WinCC flexible, the WinCC flexible Information System, contains 
detailed information. The Information System contains instructions, examples and reference 
information in electronic form. 

Basic knowledge required 
A general knowledge of automation technology and process communication is necessary in 
order to understand the manual. 
It is assumed users have good basic knowledge on the use of personal computers and MS 
Windows operating systems.  

Area of validity 
The manual applies to SIMATIC MP 370 in connection with the WinCC flexible 2004 
software packet. 

What's new since the 09/2002 release? 
This manual describes the use of the HMI device in combination with WinCC flexible 2004.  
The 09/2002 version is still valid for use of the HMI device with ProTool. 

Its place in the information landscape 
This manual is part of the SIMATIC HMI documentation. The information below presents an 
overview of the information landscape of SIMATIC HMI. 
User manual 
• WinCC flexible Micro: 
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� Describes basics of configuration using the WinCC flexible Micro engineering system. 
• WinCC flexible Compact/Standard/Advanced: 

� Describes basic principles of configuration using the WinCC flexible Compact 
Engineering System/WinCC flexible Standard/WinCC flexible Advanced 

• WinCC flexible Runtime: 
� Describes how to commission and operate your Runtime project on a PC. 

• WinCC flexible Migration: 
� Describes how to migrate an existing ProTool project to WinCC flexible. 
� Describes how to migrate an existing WinCC project to WinCC flexible. 
� Describes the conversion of ProTool projects together with changing the HMI device 

from OP7 to OP 77B. 
� Describes the conversion of ProTool projects with a change in the HMI device from a 

graphics device to a Windows CE device. 
• Communication: 

� Communication Part 1 describes the connection of the HMI device to SIMATIC PLCs. 
� Communication part 2 describes the integration of the HMI device into control systems 

of third-party suppliers. 
Operating instructions 
• Operating instructions for the SIMATIC OP 77B, 

TP 170micro/TP 170A/TP 170B/OP 170B, SIMATIC Mobile Panel 170, SIMATIC 
TP 270/OP 270/MP 270B, and SIMATIC MP 370 HMI devices. 

• Quick reference manuals for the SIMATIC OP 77B and SIMATIC Mobile Panel 170 HMI 
devices. 

Getting started 
• WinCC flexible for newcomers: 

� Based on a practical example, this is a step-by-step introduction to the basics of 
configuring screens, alarms, recipes and screen navigation. 

• WinCC flexible for advanced users: 
� Based on a practical sample project, this is a step-by-step introduction to the basics of 

engineering log files, project reports, scripts, user management, multilingual projects 
and integration into STEP 7. 

• WinCC flexible Options: 
� Based on a practical sample project, this is a step-by-step introduction to the basics of 

configuring the options WinCC flexible Sm@rtServices, Sm@rtAccess and OPC 
Server. 

 Online availability 
The following links provide direct access to technical documentation on SIMATIC products 
and systems in English, German, French, Italian, and Spanish. 
• SIMATIC Guide for Technical Documentation in German: 

http://www.ad.siemens.de/simatic/portal/html_00/techdoku.htm 
• SIMATIC Guide for Technical Documentation in English: 

http://www.ad.siemens.de/simatic/portal/html_76/techdoku.htm 
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Conventions 
A distinction was made in naming configuration and runtime software: 
• "WinCC flexible" refers to the configuration software. 
• "Runtime" refers to the runtime software that can be executed on HMI devices. 
The term "WinCC flexible" is used in the general context. A version name such as 
"WinCC flexible 2004" is always used when it is necessary to distinguish it from other 
versions. 
The following conventions are intended to facilitate easy reading: 

 
Layout Range of validity 
"Add screen" • Terminology of the user interface, e.g. dialog names, tabs, 

buttons, menu commands. 
• Input required, e.g. limit values, tag values. 
• Path specification 

"File ? Edit" Operating sequence, e.g. menu / context menu commands. 
<F1>, <Alt+P> Keyboard operation 

Please observe the following emphasized notes:  
 

 Note 
Notes containing important information about the product and its use or a specific section of 
the documentation to which you should pay particular attention. 

 

Trademarks 
All names designated with an ® are registered trademarks of Siemens AG.  

 
HMI® 
SIMATIC® 
SIMATIC HMI® 
SIMATIC ProTool® 
SIMATIC WinCC® 
SIMATIC WinCC flexible® 
SIMATIC MP 370® 

The remaining product names in this publication may be trademarks and the use of these 
names by third parties for their own purposes may violate the rights of the owner. 

Further support 

Representatives and offices 
If you have any further questions relating to the products described in this manual, please 
contact your local representative at the SIEMENS branch nearest you. 
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You local representative can be found under: 
http://www.siemens.com/automation/partner 

Training center 
We offer relevant courses to simplify your introduction to the world of automation systems. 
Please contact your regional training center, or the central training center in D-
90327 Nuremberg.  
Phone: +49 (911) 895-3200  
Internet: http://www.siemens.com/simatic 

Service & Support on the Internet 
Service & Support offers comprehensive information on SIMATIC products online at 
"http://www.siemens.com/automation/service&support": 
• The newsletter keeps you up-to-date with information relating to your products. 
• Our Service & Support search engine provides you with abundant documentation. 
• A bulletin board where users and experts exchange their knowledge worldwide. 
• Current product information, FAQs and downloads. 
• Your local contact for Automation & Drives. 
• Information about on-site services, repairs, spare parts and much more is available on 

our "Services" pages. 

A&D Technical Support and Authorization 
Available 24 hours worldwide: 

Johnson City
Nuremberg

Beijing

SIMATIC Hotline

 
 
Worldwide (Nuremberg) 
Technical Support 
(Free Contact) 

Worldwide (Nuremberg) 
Technical Support 
(fee-based, only with Automation Value Card) 
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Local time: 
Mon.–Fri. 07:00 a.m. to 5:00 p.m. 
Telephone: 
+49 (0) 180 5050-222 
Fax: 
+49 (0) 180 5050-223 
E-Mail: 
adsupport@siemens.com 
GMT: +1:00 

Local time: 
0:00 to 24:00, 365 days 
Telephone: 
+49 (911) 895-7777 
Fax: 
+49 (911) 895-7001 
E-mail: – 
 
GMT: +1:00 

Europe/Africa (Nuremberg) 
Authorization 
Local time: 
Mon.–Fri. 07:00 a.m. to 5:00 p.m. 
Telephone: 
+49 (911) 895-7200 
Fax: 
+49 (911) 895-7201 
E-Mail: 
adauthorisierung@siemens.com 
GMT: +1:00 

America (Johnson City) 
Technical Support and Authorization 
Local time: 
Mon.–Fri. 8:00 a.m. to 7:00 p.m. 
Telephone: 
+1 423 461-2522 
Fax: 
+1 423 461-2289 
E-Mail: 
simatic.hotline@sea.siemens.com 
GMT: –5:00 

Asia/Pacific (Beijing) 
Technical Support and Authorization 
Local time: 
Mon.–Fri. 8:30 a.m. to 5:30 p.m. 
Telephone: 
+86 (10) 64 75 75 75 
Fax: 
+86 (10) 64 74 74 74 
E-mail:  
adsupport.asia@siemens.com 
GMT: +8:00 

Information is available in German and English. 
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Overview 1
1.1 Multi Panel MP 370 

Multifunctional platform 
The SIMATIC Multi Panels are included in the "Multifunctional Platform" product category. 
This product category is positioned in the product hierarchy between the process-related, 
optimized application components, such as operator panels and controllers, and industrial 
PCs. This sector is completed by the introduction of the MP 370 15" Touch device variant 
intended for high-end users.  
The multifunctional platform is based on the innovative standard operating system, Microsoft 
Windows CE. It combines the robustness and speed of the dedicated hardware solutions 
with the flexibility of the PC world.  
Multi Panels provide the following advantages:  
• High degree of configuration efficiency 
• Configuration simulation on the configuration computer - no PLC required 
• Clear display and easy process operation using a Window-Based user interface 
• Large selection of predefined screen objects for use during configuration 
• Dynamic screen objects (e.g. moving objects), 
• Uncomplicated and quick handling of recipes and data records in recipe screens and 

recipe views 
• Logging of alarms, process values and login/logout procedures 
• Creation of vector graphics using the WinCC flexible configuration software without an 

external graphics editor, 
• Visual Basic Script for the realization of customized functions, 
• ALARM_S alarm procedure in connection with the SIMATIC S7, 
• Transfer: 

� Automatic switchover to transfer mode 
� Transfer via MPI, PROFIBUS/DP, USB and Ethernet 
� Serial transfer 
� Transfer via TeleService 

• Standard connections to SIMATIC S5/DP, SIMATIC S7 and SIMATIC 505, as well as to 
PLCs from other manufacturers 
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Position in the SIMATIC HMI environment 
The MP 370 extends the multifunctional platform product category for the upper performance 
range. It meets the demands placed on performance, display possibilities and 
price/performance ratio. In addition, it extends the communication potential of the office 
world. Customer needs and requests were taken into account in respect to extending data 
transfer functions, simplifying operation, and increasing acceptance when compared with 
Windows CE units. The introduction of the new touch panel unit with a 15” display means 
that this product category is now provided with a large screen with an increased visualization 
area. 
The MP 370 consistently implements the concept of multifunctionality. In addition to 
supporting the traditional HMI applications (visualization with WinCC flexible), it also 
supports other applications such as process diagnostics (SIMATIC ProAgent/MP), UPS, 
Terminal Client (SIMATIC ThinClient/MP) for the touch screen units and Soft PLC (SIMATIC 
WinAC-MP). In addition, the MP 370 can also be used within the scope of the OPP (Open 
Platform Program). 
The MP 370 is available as different device models with operation via touch panel or 
membrane keyboard according to the respective visualization tasks. 

1.2 Area of use 

Overview 
The HMI device allows graphic display of operating statuses, current process data and errors 
of connected PLCs. The user can operate and observe the machine or system being 
monitored easily using the HMI device.  
Applicable areas of use include machine and apparatus construction sectors, printing and 
packing industries, automobile and electrical industries and chemical and pharmaceutical 
industries. 
The high degree of protection (IP65 on the front side) and avoidance of moving storage 
media, such as hard disks and floppy disks, ensure that the HMI device is suitable for use in 
rough industrial environments and on site where a machine is located. 
Possible installation locations for the HMI device:  
• Switching cabinets/consoles 
• 19" cabinets/racks (keyboard units) 
Connection options for external peripherals (keyboard, mouse and printer) via a USB port, 
for example, and the possible use of CF and PC cards support multifunctionality. Due to the 
fact that the HMI device is equipped with high performance basic hardware and has a 
minimum installation depth means that it fulfills all the requirements for operation in the 
vicinity of the machine. 
The HMI device can be used to: 
• Operate and monitor the process using the menu system. Setpoint values or control 

element settings can be modified by entering values or activating configured softkeys 
• Display processes, machines and systems on full-graphic, dynamic screens 
• Display and process alarms and tags through output fields, bar graphs or trend curves 
• Use input to intervene directly in the running process 



 Overview 
 1.3 Configuring with WinCC flexible 

MP 370 (WinCC flexible) 
Operating Instructions, Edition 03/2004, 6AV6691-1DE01-0AB0 1-3 

1.3 Configuring with WinCC flexible 

Introduction 
In order to operate a machine or system using an HMI device, the user interface must be 
configured for the HMI device. This procedure is referred to as the "configuration phase". 

Create project data 
Save project data 
Test the configuration 
Simulate configuration 

Download project data

Connected to PLC

Configuration phase

PC/PU

PLC

MP 370

Process running phase

 
Figure 1-1 Configuration and process running phases  

Principle 
1. Configuring the functionality of the user interface. This includes the following: 

� Graphics 
� Text 
� Customized functions 
� Operating and indicator elements 
For this purpose, use a configuration computer (PC or programming device) containing 
the WinCC flexible configuration software. 

2. Connect the configuration computer to the HMI device. 
The following connection options are available:  
� Serial 
� MPI/PROFIBUS-DP network 
� USB or Ethernet interface 
� Standard modem path 

3. Transfer the configuration to the HMI device. 
4. Connect the HMI device to the PLC. 
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Result 
The HMI device communicates with the PLC and responds to the program progress in the 
PLC ("process running phase") according to the information configured.  

1.4 Features 

Overview of the HMI device 
 

 
Figure 1-2 MP 370 as keyboard unit and touch panel unit 

 
Features MP 370 12" 

Key 
MP 370 12" 

Touch 
MP 370 15" 

Touch 
Processor Type 64 bit RISC CPU 
Memory Capacity (max.) Free for user data:  

12 MB flash memory (max. 7 MB for WinCC 
flexible configurations) 

Software Operating system Microsoft Windows CE 
Standard HMI device 
interfaces for connection 
to PLC, PC/PU and 
printer 

1 x RS 232/TTY (active/passive) 
1 x RS 232 (9-pin) 
1 x RS 422/RS485 

S7 connection MPI/PROFIBUS–DP 

Interfaces 

More interfaces for 
network, external 
keyboard and mouse 

1 x Ethernet (10/100 Mbit) 
1 x USB (12 Mbaud/Host) 

Type TFT LCD TFT LCD with touch panel  
(analog resistive) 

Active screen diagonal 12,1" 15,1" 

Color display 

Resolution (pixels) 800 x 600 (Super VGA) 1024 x 768 
(XGA) 
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Features MP 370 12" 
Key 

MP 370 12" 
Touch 

MP 370 15" 
Touch 

Possible colors 256  
Back-lighting CCFL tubes 
System keys with 
dedicated functions 

38 (3 with 
LEDs) 

- 

Softkeys with 
configurable functions 

36 (with LEDs) - 

for local assignment 36 - 

Membrane keyboard 

Softkey labeling System-
specific with 

labeling strips 

- 

Acoustic 
acknowledgement 

In the case of touch 
control 

- x 

External memory 
extension for recipes, 
logs and alarms etc.: 

 Special features 

Slot for PC card 
Slot for CF card 

x 
x 

Further information 
The creation of projects for HMI devices and functions for the configuration software is 
described in detail in the "WinCC flexible" user manual and in the WinCC online help.  
Information on connecting the HMI device to the PLC is provided in the "WinCC flexible 
Communication" user manual.  
The "Readme.chm" file on the WinCC flexible CD contains the most current information 
which could not be included in the manuals and online help due to time constraints.  

1.5 Functional scope 

General information 
The following table summarizes the range of functions provided by the HMI device. The 
numeric values are maximum values which the HMI device is capable of managing. These 
values are not cumulative. It is not possible to simultaneously configure 4000 alarms and 
300 screens each with 400 tags per screen.  
The defined values are also limited by the size of the configuration memory.  

 
Function Keyboard unit Touch panel unit 

Number 4000 
Discrete alarms Yes 
Analog alarms Yes 

Alarms 

Indicators Alarm line/Alarm window/alarm view 
 



Overview  
1.5 Functional scope 

 MP 370 (WinCC flexible) 
1-6 Operating Instructions, Edition 03/2004, 6AV6691-1DE01-0AB0 

Function Keyboard unit Touch panel unit 
Process values in alarm text  8 
Length of the alarm text 80 characters (dependent on font) 
Color-coding of different alarm states x 
Warning alarms x 

 

Error alarms 
Type of display 
Acknowledge individual alarms 
Acknowledge several error alarms 
simultaneously (group 
acknowledgement) 

x 
First/last, selectable 

x 
16 acknowledgment groups 

ALARM_S Display S7 alarms x 
Alarm logging Output to printer x 

Alarm buffer capacity 1024 alarm events, circular buffer 
View alarms x 
Delete x 

Volatile alarm buffer 

Print x 
Time of occurrence  Date/time Alarm acquisition 
Alarm events Arrived, departed, acknowledged 
Number 500 
Text objects 30000 text elements 
Fields per screen 400 
Tags per screen 400 

Screens 

Screen objects • Button 
• Switch 
• I/O field 
• Graphic I/O field 
• Symbolic I/O field 
• Alarm indicator 
• Alarm view 
• Alarm window 
• Recipe view 
• Bar 
• Trend view 
• Slider control 
• Gauge 
• Date / time field 
• Clock 
• User view 
• Status force 
• Sm@rtClient view 
• Symbol library 
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Function Keyboard unit Touch panel unit 
Operator prompting: 
Help text 
Animation 
Unhide/hide objects 
Pictograms for function keys 
Tab order 
LEDs in function keys 

 
x 
x 
x 
x 
x 
x 

 
x 
x 
x 
- 
- 
- 

 

Fixed window x 
Tags Number 2048 1) 
Limit value monitoring Input/output x 
Conversion functions Input/output x 

Lines/characters 7/35 (dependent on font) 
For alarms x 
For screens x 

Help text 

For screen objects 
I/O field 
Symbolic I/O field 
Graphic I/O field 
Button 
Switch 
Hidden button 

 
x 
x 
x 
x 
x 
x 

 
x 
x 
x 
- 
- 
- 

Alarms x 
Tags x 
Log type Circular/sequential log 
Number of logs 50 
Number of tags for logging 50 
Number of sequential logs 400 
Entries per log 500000, limited by storage medium 2) 

Logging 

Memory location • PC card 
• CF card 
• Ethernet 

Number 500 
Graphics lists 500 

Lists 

Text lists 500 
Hardcopy of the screen content, also in 
color 

x 

Direct alarm logging x 

Print functions 

Freely configurable logs x 
Number of user groups 10 
No. of users 32 

Safety 

No. of authorizations Tag 
Number 500 Recipes 
Data records per recipe 2) 1000 
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Function Keyboard unit Touch panel unit 
Elements per recipe 1000  
Recipe memory 128 KB (integr. Flash, expandable) 
Number of languages 5 Online language change 
Project languages (with system alarms) Chinese (simplified), Chinese (traditional), 

Czechoslovakian, Danish, Dutch, English, 
Finnish, French, German, Greek, Hungarian, 
Italian, Japanese, Korean, Norwegian, Polish, 

Portuguese, Russian, Spanish, Swedish, 
Turkish 

SIMATIC S5 x PU functions 
(Status force) SIMATIC S7 x 
Scheduler Trigger functions cyclically or once x 

User-specific expansions of functionality x 
Number of scripts 100 

VBScript 

Number of lines per script 500 
Connections 3) Number 6 

 
 

1) Maximum total number for PowerTags and internal tags 
2) Storage media refers to PC cards, CF cards and network drives 
3) With SIMATIC S7 

1.6 Communication with PLCs 
The following table list the PLCs which can be connected to the HMI device.  

Table 1-1 Communication with SIMATIC PLCs 

PLC Keyboard unit Touch panel unit 
SIMATIC S5 AS511 
SIMATIC S5 DP 

x 
x 

SIMATIC S7–200  x 
SIMATIC S7–300/400  x 
SIMATIC 500/505 serial 
SIMATIC 500/505 DP 

x 
x 

SIMATIC HMI HTTP Protocol x 
OPC 1) x 
SIMATIC WinAC x 
SIMOTION x 

 
 

1) Data exchange only via XML (connection to OPC-XML server) 
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Table 1-2 Communication with PLCs from other manufacturers 

PLC Keyboard unit Touch panel unit 
Allen Bradley DF1 
Allen Bradley DH485 

x 
x 

LG GLOFA-GM x 
Modicon MODBUS x 
Mitsubishi FX 
Mitsubishi protocol 4 

x 
x 

GE Fanuc SNP  x 
Omron Hostlink/Multilink  x 

1.7 Options 

1.7.1 Hardware options 

1.7.1.1 Backup battery 

Function of the backup battery 
The battery ensures that in the event of a power failure, the HMI device's internal hardware 
clock continues to run. If no battery is available, the clock continues for approx. three days 
as long as the HMI device was in operation for 6 to 8 hours, without interruption, beforehand.  
The battery is not supplied with the HMI device. Please refer to the Siemens Catalog ST80 
for the order number.  

Procedure 
1. Secure the battery to the back of the HMI device with two cable ties. The position is 

indicated by an arrow for both touch panel and keyboard units in the following figures. 

 
Figure 1-3 MP 370 12" Key 
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Figure 1-4 MP 370 12" Touch 

 
Figure 1-5 MP 370 15" Touch 

2. Connect the plug on the battery cable to the two-pole connector strip on the underside of 
the device. The plug is coded to prevent reversed poling. 

See also 
Interfaces (Page 4-4) 
Replacing the optional backup battery (Page 11-2) 

1.7.1.2 PC card / CF card 

Purpose 
Changeable PC cards and Compact-Flash cards can be inserted in the two slots, Slot A and 
Slot B, at the rear of the HMI device. They are not supplied with the HMI device. 
Changeable memory cards can be used, for example, to store important process data or 
execute a backup/restore of the internal flash memory.  

Slot A Slot B

 
Figure 1-6 Positions of the slots 
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Cards supported 
The HMI device supports the use of all standard cards which operate with a programming 
voltage of 5 V (types I and II): 
• Slot A (PC card):  

� ATA Flash card 
� SRAM card 
� NE2000-compatible Ethernet card 

• Slot B (Compact Flash Card):  
� ATA Flash card 
� NE2000-compatible Ethernet card 

Remove memory card 
 

 Caution 
Ensure that the HMI device does not access the memory card during the removal process. 
Otherwise, the contents of the memory card will be fully destroyed. 

 

1. Terminate access made by the HMI device to the memory card. 
If the configuration planner has defined an operating element linked to the "CloseAllLogs" 
system function, press the element. Otherwise, press the operating element linked to the 
"Exit runtime" system function in the configuration. This stops the runtime software. 

2. Wait unit the HMI device displays the loader. 
Changeover to the loader may take several minutes depending on the size and number 
of logs stored. 

3. Remove the memory card. 

Switch off the HMI device with memory card inserted 
 

 Caution 
Always terminate the runtime software before switching off the voltage supply in order to 
prevent loss of data. 

 

1. Stop the runtime software. 
 Press the operating element linked to the "Exit runtime" system function in the 
configuration. 

2. Wait unit the HMI device displays the loader. 
Changeover to the loader may take several minutes depending on the size and number 
of logs stored. 
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3. Switch off the power supply.  
If the power supply is interrupted during normal operation, the HMI device checks the 
memory card after power is restored and repairs any defect sectors.  

See also 
HMI device loader (Page 6-1) 

1.7.2 Software options 

1.7.2.1 Internet Explorer 

Overview 
The Internet Explorer supplied with the HMI device has been specially adapted to the 
Windows CE operating system and has a restricted functional scope (Pocket Internet 
Explorer). Only small HTML pages, about 100 kb, can be displayed.  
Installation of the Internet Explorer is completed using the ProSave service tool. 
Files created in Internet Explorer (e.g. Favorites) are stored in the DRAM file system. The 
DRAM file system is deleted when the unit is switched off. However, using the system 
settings (OP Properties ? Persistent Storage ? Save Files), it is possible to backup the data 
currently available in the DRAM file system to the Flash memory. When the device is started 
up, the data saved is automatically restored. 
If you remove the Internet Explorers, the files created from Internet Explorer must also be 
deleted. To do this, delete the files in the DRAM file system using the standard Explorer. 
Then backup the DRAM file system ("OP Properties ? Persistent Storage ? Save Files"). 

 

 Note 
The initial configuration can be restored simply by updating the operating system. 

 

See also 
Update operating system (Page 7-18) 
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Safety notes and general information 2
2.1 Safety notes 

Work on the cabinet 
 

 
Warning 
Dangerous voltage 
Opening the cabinet will expose high voltage parts. Contact with these parts could be fatal. 
Switch off the power supply to the cabinet before opening it. 

High frequency radiation 
 

 Notice 
Undesirable operating conditions 
High-frequency emissions, e.g. from cell phones, can cause undesirable operating 
conditions. 

2.2 General information 

Industrial use 
The HMI device is designed for industrial use. The following standards are met: 
• Requirements for emitted interference in EN 61000-6-4: 2001 
• Requirements for noise immunity in EN 61000-6-2: 2001 
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Residential use 
If the HMI device is used in a residential area, you must take measures to achieve limit class 
B in accordance with EN 55011 for radio interference emissions. 
Suitable measures to achieve limit class B for suppression of radio interference include: 
• Installation of the HMI device in a grounded control cabinet 
• Use of filters in electrical supply lines 
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Plan deployment 3
3.1 Transport 

Only unpack the HMI device at its location of use. 
 

 Notice 
Ensure that no condensation develops on or in the HMI device after it has been transported 
at low temperatures or it has been exposed to extreme temperature fluctuations. 
Allow the HMI device to warm up to room temperature before starting it up. Do not attempt to 
warm the device using direct heat. If condensation has formed, the HMI device may only be 
switched on when it has completely dried, normally after waiting approximately 4 hours. 

 

Problem-free, reliable operation of the HMI device requires proper transport, storage, 
positioning and assembly as well as careful operation and maintenance. 
Failure to meet these requirements voids the rights to claims under the terms of warranty. 

 

 Notice 
The HMI device was function-tested before shipping. If a malfunction occurs nevertheless, 
please enclose a full description of the malfunction when returning the device. 

3.2 Electromagnetic compatibility 

Electromagnetic compatibility 
The HMI device fulfills the requirements stipulated in the EMC law of the Federal Republic of 
Germany as well as the EMC guidelines of the European Union. 
Installation in grounded metal cabinets, e.g. 8 MC cabinet complying to Siemens catalog 
NV21, ensures compliance to EN 61000-4-2. 
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Installing HMI devices conform to EMC requirements 
Conditions for error-free operation include a PLC design that conforms to EMC requirements 
and the use of interference-proof cables. The "Guidelines for Interference-Free Construction 
of PLCs" and the "PROFIBUS network Manual" are installation references for the HMI 
device. 

 

 
Caution 
Only shielded cables are permitted for all signal connections.  
Screw or lock all plug connections.  
Do not install signal lines in the same cable ducts as power cables.  
Siemens AG refuses to accept liability for malfunctions and damage arising from use of self-
made cables or cables from other manufacturers.  

Conditions for use 
The HMI device is intended for installation in weatherproof, permanent locations. The 
conditions under which the device can be used exceed the requirements set out in DIN IEC 
60721-3-3: 
• Class 3M3 (mechanical requirements) 
• Class 3K3 (climatic requirements) 

Use with additional measures 
Examples of applications where the use of the HMI device requires additional measures are: 
• In locations with a high degree of ionizing radiation 
• In locations with extreme operating conditions, e.g.: 

� Corrosive vapors or gases 
� Strong electric or magnetic fields 

• In systems requiring special monitoring, e.g.: 
� elevator systems 
� In particularly hazardous locations 

The HMI device may be installed in a cabinet as an additional measure. 

See also 
EMC requirements (Page 12-7) 
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3.3 Installation locations and type of protection 

Installation location 
The HMI device is designed for installation in the front panels of cabinets and consoles. 
Keyboard units can also be installed in 19” cabinets and racks.  
Cut an installation cut-out in a front panel. The thickness of the front panel must not exceed 
6 mm. Additional holes for securing the HMI device are not necessary because a clamping 
mechanism is available. 

Degree of protection 
Install the HMI device Install the HMI device to meet the minimum requirements for IP54 
degree of protection. The IP65 degree of protection for the front panel can only be ensured 
when the seal on the front plate of the HMI device is fitted correctly. 

 

 Notice 
The NEMA 4, NEMA 12 and IP65 degrees of protection are only guaranteed when the 
thickness of the installation support is at least 2.5 mm. 

 

 Caution 
The system's ability to be waterproof and dustproof as per the section "Approvals" is only 
guaranteed when the following are met: 
• Material thickness of installation cut-out: 2,5 to 6 mm 
• Deviation of the installation cut-out from the horizontal based on the overall dimensions of the HMI 

device: ? 0.5 mm 
• Permissible surface roughness in the area of the seal: max. 120 µm (Rz 120) 

Ambient conditions 
 

 Caution 
If the maximum permissible ambient temperature is exceeded, do not operate the HMI 
device without external ventilation.  
Otherwise, the HMI device may be damaged, nullifying the approvals listed in the 
"Approvals" section as well as the warranty for the HMI device. 

 

See also 
Technical specifications (Page 12-5) 
Approvals (Page A-1) 
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3.4 Producing the installation cut-out 

Select position for the installation cut-out 
 

 
Caution 
To prevent the HMI device from overheating during operation:  
• The maximum angle of inclination from vertical installation may not be exceeded (see 

"Specifications" chapter).  
• Do not expose the operating unit to direct sunlight.  
• Ensure that the ventilation slits in the housing are not obstructed.  

Installation cut-out 
 

 Notice 
The following air flow requirements must be maintained following installation: 
• 100 mm above the HMI device 
• 50 mm below the HMI device 
• 15 mm at the sides of the HMI device 
• 50 mm at the bottom of the HMI device 

When using plug-in boards, ensure sufficient space is provided to insert or remove them. 

MP 370 12" Touch 
For installation in the front panel, the touch panel requires an installation cut-out (WxH) of 
310 +1 mm x 248 +1 mm. The thickness of the front panel must not exceed 6 mm.  

MP 370 15" Touch 
For installation in the front panel, the touch panel requires an installation cut-out (WxH) of 
368 +1 mm x 290 +1 mm. The thickness of the front panel must not exceed 6 mm.  

MP 370 12" Key 
For installation in the front panel, the keyboard unit requires an installation cut-out (WxH) of 
450 +1 mm x 290 +1 mm. The thickness of the front panel must not exceed 6 mm.  

See also 
Technical specifications (Page 12-5) 



 

MP 370 (WinCC flexible) 
Operating Instructions, Edition 03/2004, 6AV6691-1DE01-0AB0 4-1 

Installation and connection 4
4.1 Check shipment 

Check the packing contents for visible signs of transport damage and for completeness. 
 

 Notice 
Do not install parts damaged during shipment. In the case of damaged parts, contact your 
Siemens representative. 

 

Keep the documentation supplied. It belongs to the HMI device and may be required for 
future commissioning. 

4.2 Installation of the HMI device 

Prior to installation 
If you want to change the labels on the softkeys, change the labeling strips before installing 
the HMI device.  

Installation in 19” cabinets/racks 
Refer to the information provided by the respective cabinet or rack manufacturer to install the 
device in a 19” cabinet/rack. 
Installation dimensions of standard 19” cabinets: 
• Width: 19" (482.6 mm) 
• Height: 7 HE (310 mm) 
Secure the HMI device: to the rails using four screws 

See also 
Labeling the softkeys (Page 5-6) 
Installation locations and type of protection (Page 3-3) 
Dimensions MP 370 12" Key (Page 12-4) 
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4.2.1 Installation of the touch panel unit 

Installation in front panels 
1. Working from the front, insert the HMI device in the installation cut-out.  

 

  Note 
Take the necessary precautions to ensure the HMI device cannot drop out of the front 
panel before it has been secured. 

 

2. When installing an MP 370 with a 12" display and touch control, hang the hooks of the 
enclosed eight screw clamps into the recesses in the housing of the HMI device. 
The recesses are marked by arrows in the figure. 

MP 370 12�
Touch

 
Figure 4-1 Screw clamps on the MP 370 12" Touch 

3. When installing an MP 370 with a 12" display and key control or an MP 370 with a 15" 
display and touch control, hang the hooks of the enclosed ten screw clamps into the 
recesses in the housing of the HMI device. 
The recesses are marked by arrows in the figure. 
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MP 370 15� Touch
MP 370 12" Key

 
Figure 4-2 Screw clamps on the MP 370 12" Key and MP 370 15" Touch  

4. Secure the HMI device to the front panel from the back using an Allen wrench. 
 

  Caution 
Make sure the seal is seated correctly against the front panel. 
Over tightening the screws will damage the HMI device. 

See also 
Installation locations and type of protection (Page 3-3) 
Dimensions MP 370 12" Touch (Page 12-1) 
Dimensions MP 370 15" Touch (Page 12-3) 

4.3 Connecting the HMI device 

4.3.1 Conditions 

Requirements 
The following condition must be fulfilled before the HMI device is connected electrically:  
• The HMI device must be installed according to the information provided in these 

operating instructions. 
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Electrical connections 
Connect the HMI device in the following sequence: 
1. Potential equalization line 
2. PLC 
3. Configuration computer as necessary 
4. Peripheral equipment as necessary 
5. Power supply 

 

  Notice 
Connection sequence 
Make the HMI device connections in the order they are described. Failure to do so may 
result in damage to the HMI device. 
When disconnecting, it is essential that you follow the sequence in reverse order. 

4.3.2 Interfaces 

Interfaces 
The following figure illustrates the arrangement of the ports on the underside of the HMI 
device. 

 
Figure 4-3 Arrangement of the ports 

 
No. Name Application 
1 Ground connection For connection to rack ground 
2 Power supply Connection to power supply +24 V DC) 
3 Interface IF1A  RS232/TTY (active/passive) for controller 
4 Interface IF2 RS232 for PC, PG, printer 
5 Interface IF1B RS422/RS485 (floating) for controller 
6 Switch To configure interface IF1B 
7 Battery connection Connection for optional backup battery 
8 USB interface Connection for external keyboard, mouse, etc. 
9 Slot B For CF card 

10 Ethernet interface Connection of an RJ45 Ethernet line 
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11 Slot A For PC card 
 

 Notice 
Connecting a USB distributor (USB hub) to the HMI device's USB interface can cause a 
restriction in the functionality of the connected USB devices and the HMI device. 
Therefore, the simultaneous or alternating operation of USB devices connected via a USB 
hub on the HMI device's USB interface is not approved. 
This applies to USB hubs both with and without an internal power supply. 

 

 Notice 
The connection and operation of USB memory media (e.g. USB stick) on the HMI device's 
USB interface has not been approved. 

Communication options 
The following table lists the peripherals with which the HMI device can communicate.  

 
Device Connection Interface 

SIMATIC S5 AS511 (TTY) 
PROFIBUS DP 

IF1A 
IF1B 

SIMATIC S7 MPI 
PROFIBUS DP 
Industrial Ethernet 

IF1B 
IF1B 

Ethernet 
SIMATIC 505 RS 232 

RS 422/RS485 
IF1A 
IF1B 

Further support RS 232/TTY 
RS 422/RS485 

IF1A 
IF1B 

Configuration computer RS 232 IF2 
Printer   
Local printer 
Network printer 
UBS printer 

RS 232 
Network 
USB 

IF2 
Ethernet 

USB 
External keyboard/mouse USB 

See also 
Interface description (Page 12-8) 
Connecting the power supply (Page 4-15) 
Backup battery (Page 1-9) 
Connecting the PLC (Page 4-11) 
Technical specifications (Page 12-5) 



Installation and connection  
4.3 Connecting the HMI device 

 MP 370 (WinCC flexible) 
4-6 Operating Instructions, Edition 03/2004, 6AV6691-1DE01-0AB0 

4.3.3 Connecting the potential equalization 

Ground connection 

 
Connect the grounding connection of the HMI device to the rack ground. Use the grounding 
screw provided and a conducting cable with a diameter of at least 4 mm2. 

Potential difference 
Potential differences can occur between separate system parts which lead to high equalizing 
currents. An example would be when line shields are applied on both sides and grounding 
occurs on different system parts. 
The cause of potential differences can be different supply connections. 

General requirements for equipotential bonding 
Potential differences must be reduced by laying sufficient equipotential bonding cables to 
ensure problem-free operation of the electronic components concerned. Therefore, the 
following must be observed when setting up equipotential bonding: 
• The effectiveness of the equipotential bonding increases as the the impedance of the 

equipotential bonding cables decreases (i.e., or as the cross section of the equipotential 
bonding cable increases). 

• If two system parts are connected to each other via shielded data lines with shielding 
connected to the grounding/protective conductor on both sides, the impedance of the 
additionally laid equipotential bonding cables must not exceed 10% of the shield 
impedance. 

• The cross-section of an equipotential bonding cable must be selected to accommodate 
the maximum equalizing current flow. In practice, equipotential bonding cables between 
control cabinets with a minimum cross-section of 16 mm2 have proven sufficient. 

• Use equipotential bonding cables made of copper or galvanized steel. Connect the 
equipotential bonding cables properly to the grounding/protective conductor with the 
greatest possible surface area and protect them from corrosion. 

• Clamp the shielding of the data line on the HMI device flush and as close as possible to 
the potential equalization rail using cable clips. 

• Lay the equipotential bonding cables and data lines parallel to one another with a 
minimum gap (see figure below, Item 6). 

 

  Notice 
Equipotential bonding cable 
Cable shields are not suitable for equipotential bonding. Use only the intended potential 
cable prescribed. For example, potential cables must have a minimum cross-section of 
16 mm². When setting up MPI and PROFIBUS DP networks, make sure to use cables 
with a sufficient cross­section; otherwise, the interface modules may be damaged or even 
destroyed. 
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Connection configuration 

1

5

2

6

3

5

2
3

4

≥16

4

Data cable, shielded
Equipotential bonding

 
Figure 4-4 Setting up potential equalization in the HMI device 

 
1 Grounding connection on the HMI device 
2 Switching cabinet 
3 Voltage bus 
4 Cable clip 
5 Grounding connection 
6 Parallel laying of equipotential bonding cable and data line 

4.3.4 Connecting peripheral equipment 

4.3.4.1 Connect printer 

Connection configuration 
The figure below illustrates how to connect a printer to the HMI device. The HMI device 
supports the following printer standards:  
• compatible with ESC/P, 9-pin ESC/P or ESC/P2 (EPSON)  

 e.g., EPSON LQ 300+ 
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• compatible with PCL3 (Hewlett Packard)  
 e.g., Brother HL 1450 

USB printers can still be used for PCL and Epson9 modes.  

IF2

Local printer (serial)

ESC/P, 9-pin ESC/P, 
ESC/P2, PCL

RS 232 (cable is printer-specific)

Network printer

ESC/P, 9-pin ESC/P, 
ESC/P2, PCL

Ethernet

USB

UBS printer

ESC/P, 9-pin ESC/P, 
ESC/P2, PCL

Operating unit

 
Figure 4-5 Printer connection configuration 

 

 Notice 
Connecting a USB distributor (USB hub) to the HMI device's USB interface can cause a 
restriction in the functionality of the connected USB devices and the HMI device.  
Therefore, the simultaneous or alternating operation of USB devices connected via a USB 
hub on the HMI device's USB interface is not approved. 
This applies to USB hubs both with and without an internal power supply.  

 

 Notice 
Only use a cable with braided metal screening grounded at each end for connecting the HMI 
device and printer. 
Deactivate the "Printer" option in the "Serial Transfer Remote Control" setting in the 
Windows CE Control Panel if a serial printer is connected to the HMI device via the IF2 
interface. 
Some printers may require the ASCII character set used in the project to also be defined on 
the printer.  
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If a serial printer is connected, the following printer settings are required: 
• RS 232, whereby only the RxD, TxD and GND signals are required, 
• 8 data bits 
• 1 stop bit 
• No parity 
• Baud rate between 9600 and 57600, printer-dependent 
• XON / XOFF protocol 
The Siemens Catalog ST 80 contains the printers approved by Siemens AG. A current list of 
approved printers is available on the Internet. 

 

 Note 
Printer documentation 
Refer to the information provide by the printer manufacturer when connecting the printer. 

4.3.4.2 Connect external keyboard and mouse 

Connection configuration 
The figure below illustrates how to connect a keyboard or mouse to the HMI device's USB 
interface. A keyboard or mouse can be connected and disconnected during normal 
operation.  

USB

USB standard keyboard

USBstandard mouse

Operating unit

 
Figure 4-6 Connection configuration for external keyboard and mouse 
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 Notice 
Connecting a USB distributor (USB hub) to the HMI device's USB interface can cause a 
restriction in the functionality of the connected USB devices and the HMI device.  
Therefore, the simultaneous or alternating operation of USB devices connected via a USB 
hub on the HMI device's USB interface is not approved. 
This applies to USB hubs both with and without an internal power supply.  

 

 Notice 
Use a standard mouse and keyboard with a "USA/International" keyboard layout. 
Commercially available USB devices do not normally meet the higher industrial demands 
relating to interference resistance and can have negative effects on the HMI device. 
The power consumption must not exceed 500 mA with the USB units connected. 

See also 
Operation with external keyboard/mouse (Page 5-9) 
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4.3.5 Connecting the PLC 

Connection configuration 
The figure below illustrates the basic connection possibilities between the HMI device and 
PLC. Standard cables are available for the connections shown (refer to the ST80 catalog).  

TTY active
PU interface

SI 2

RS 232
(9/25-pin)

RS 422
(9-pin)

SIMATIC S5

TTY active

RS 232

PLCs of other
manufacturers

RS 422

RS 422/RS485

CPU

SIMATIC 505

SIMATIC S7

RS 232/TTY

IF1A

IF1B

RS 485

RS 485

Operating
unit

PROFIBUS DP  
Figure 4-7 Connection configuration for PLCs 

• SIMATIC S7 
Use only the approved cables for connection to a SIMATIC S7. 

• IF1A / IF1B 
To enable operation using the serial interface, connect either the IF1A (RS 232/TTY) or 
IF1B (RS 422/485), but not both. The 1F1B interface can be configured using a switch. 

• PROFIBUS DP 
Any PROFIBUS-DP bus terminal can be used.  

Configure interface IF1B 
The IF1B interface can be configured via the switches on the back of the HMI device. This 
switches over the RS-422 received data and the RTS signal for RS485. By default, the 
switch is set for the SIMATIC S7 PLC. 
The following table shows the permissible switch settings. 
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Communication Switch settings 

 

PLC
MPI/PPI

Standard cable

Operating
unit  

 

ON

1234

 
No RTS on connector 
This is the switch setting on 
delivery. 

 

PLCRS 422/RS 485Operating
unit  

 

ON

1234

 

 

ON

1234

 
RTS on Pin 4 (default) 
 

ON

1234

 
RTS on Pin 9 (as PU) 

 

PLC

PROFIBUS-DP/MPIOperating
unit

  

ON

1234

 
No RTS on connector 

Compressing the internal program memory with SIMATIC S5 
 

 
Warning 
In the case of the SIMATIC S5, compressing the PLC's internal program memory 
("Compress" PU function, integrated FB COMPR) is not permitted if an HMI device is 
connected. When memory is compressed, the absolute addresses of the blocks in the 
program memory change. Since the HMI device only reads the address list during startup, it 
does not recognize the address change and accesses the wrong memory areas.  
If you cannot avoid compressing memory during operation, turn off the HMI device before 
running the compress function. 
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4.3.6 Connecting the configuration computer 

Connection configuration 
The figure below illustrates how to connect a configuration computer (PG or PC) to the HMI 
device for transferring project data.  
Standard cables are available for the connections shown (refer to the Siemens catalog 
ST80). 

COMIF2

PC/PU

RS 232

IF1 B
MPI/PROFIBUS DP

RS 485

PC/PU

RJ45

PC/PU

Ethernet

USB
USB

PC/PU

Operating unit

 
Figure 4-8 Connection configuration for configuration computer 

 

 Notice 
Use a master-master cable for the USB connection between the HMI device and the 
configuration computer. Do not use the driver supplied with the cable for the transfer. Only 
install the USB driver supplied with WinCC flexible on the configuration computer. This driver
is on the WinCC flexible CD under "\Support\DeviceDriver\USB". 
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4.3.7 Connecting an uninterruptible power supply (UPS) 

Connecting a UPS 
The following options are available to connect a UPS: 
• UPS with serial interface 

A UPS with serial interface is connected directly to the HMI device.  
A serial connection is used with a "SITOP DC-USV Module A". The driver for detecting 
and configuring the UPS is contained on the WinCC flexible CD and must be installed on 
the HMI device using ProSave.  

• UPS without serial interface 
A UPS without serial interface is connected to the PLC. 
The UPS signals the power failure to the connected PLC via a digital signal. The PLC 
program must then signal the HMI device that runtime must be terminated. To do this, the 
PLC changes a tag to which the "Exit runtime" function is configured in WinCC flexible. 

 

  Note 
In order to use an uninterruptible power supply with serial interface on the HMI device, 
the "Uninterruptible Power Supply (UPS)" option must be loaded on the HMI device. 

Connection configuration 
The figure below illustrates how to connect an uninterruptible power supply UPS with serial 
interface to the HMI device.  

IF2

UPS

RS 232 

24 V

Operating unit

 
Figure 4-9 Connection configuration for an uninterruptible power supply 

See also 
UPS (Page 6-16) 
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4.3.8 Connecting the power supply 

Connecting the plug-in terminal rail 
The power supply for the HMI device is connected at the 2-pin plug connector on the 
underside of the unit. Use the 2-pin terminal block supplied for this purpose. The plug-in 
terminal block is designed for cables with a cross-section not larger than 2.5 mm2. 
The figure below illustrates the assignment of the plug-in terminal block.  

GND

+ 24 V DC 
Ensure that the lines are connected properly to the correct terminals. Also note the labeling 
for the contact pins on the back of the HMI device. 
The HMI device is equipped with reverse battery protection.  

 

 Notice 
Damage 
The force of the screwdriver on the screws may cause the socket for the terminal block in 
the HMI device to be levered up from the printed circuit board. 
Therefore, only connect the wires when the terminal block has been unplugged. 

Connecting the power supply 
Please refer to Technical Data for information on the power supply requirements. 

 

 
Caution 
Ensure safe electrical insulation of the power supply. Use only power supply units complying 
with IEC 364­-4­-41 or HD 384.04.41 (VDE 0100, Part 410). 
Only use power supply units which comply to SELV (Safety Extra Low Voltage) and PELV 
(Protective Extra Low Voltage) standards. 
The supply voltage must be within the specified range. Otherwise, HMI device failures can 
occur. 
If the power supply for the HMI device is not grounded, the communication interface could 
be destroyed by the potential difference between the HMI device and CPU.  
Therefore, connect the 24 V output of the power supply to the potential equalization. 
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See also 
Technical specifications (Page 12-5) 

4.4 Switch on and test the HMI device 

Start up 
Proceed as follows:  
1. Disconnect all connections to external units and remove any cards from the slots. 
2. Connect the HMI device to the power supply. 
3. Switch on the power supply. 

If the HMI device does not start, the connections are probably reversed. In this case, 
switch of the power supply, reverse the connections and switch the power supply on 
again. 

4. When the HMI device has started, connect the configuration computer or other peripheral 
equipment to it. 

Function test 
Initiate a function test following commissioning. The HMI device is functional when one of the 
following conditions occurs: 
• The "Transfer" dialog is displayed 
• The loader is displayed 
• A project is started 

Switch off HMI device 
Switch off the HMI device in the following ways: 
• Switch off the power supply 
• Unplug the terminal strip from the HMI device 

 

  Note 
If a project is already running on the HMI device, runtime must be terminated before 
switching the HMI device off.  
Use the operating element provided by the project engineer. 
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Operating elements and indicators 5
5.1 Front view MP 370 Touch 

Operating the touch screen 
 

 Notice 
Damaging the touch screen 
Operating the touch screen with hard, sharp or pointed items or in a heavy-handed way can 
lead to a considerable reduction in its service life and even to a complete failure. 
Only press the HMI device's touch screen with your fingers or a touch screen pen. 

MP 370 12" Touch 
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MP 370 15" Touch 

 

5.2 Front view MP 370 Key 

5.2.1 Key pads 

Operating the keyboard 
 

 Notice 
Damaging the keyboard 
Operating the keyboard with hard, sharp or pointed items or in a heavy-handed way can lead 
to a considerable reduction in its service life and even to a complete failure. 
Only use your fingers to operate the HMI device keyboard. 

Key pads 
The HMI device's keyboard is comprised of two functional keypads. Refer to the figure 
below.  
• Softkeys  

� Keys <S1> to <S16> 
� Keys <F1> to <F20> 
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• System keys:  

� Alphanumeric keys 

� Cursor keys 

� Control keys 

 
Figure 5-1 Arrangement of the keypads 

 
1 Function keys 
2 System keys 
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5.2.2 Function keys 

Function keys with global function assignment 
A softkey with global function assignment always triggers the same action on the HMI device 
or in the PLC. The action is independent of the screen currently selected. These actions 
could include:  
• Activate screen 
• Display current error alarms 
• Start screen printout (hardcopy) 
All softkeys can be configured with global assignments. 

 

 Note 
Unintentional actions can be triggered by a multiple key operation. 
No more than two function keys can be activated simultaneously.  

Function keys with local function assignment 
A softkey with local function assignment can trigger different actions on the HMI device or in 
the PLC. The actions are dependent on the currently active screen (local significance of 
current screen). A configuration engineer can configure an icon for each softkey. The icon is 
then positioned on the screen. 
All function keys can be assigned locally significant functions during configuration. 
Icons cannot be configured for the keys <F11> to <F20>. 

 

 
Caution 
If you press a function key after a screen change, the associated function in the new screen 
may be initiated before the new screen is displayed.  

LED control 
The light-emitting diodes (LED) in the function keys can be controlled from the PLC. A 
luminous or flashing LED can indicate to the operator which key to press according to 
specific situations.  
The configuration engineer must configure LED tags for the softkeys to control the LEDs.  
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5.2.3 System keys 

Control keys 
The following control keys serve higher editing and control functions:  

1

A-Z INS
DEL TAB

HELP

ESC

ACK

SHIFT FN CTRL ALT ENTER

4

3

2

7

6

5

11

10

9

8

12
 

Figure 5-2 Control keys 

The system keys <ACK>, <ESC>, <HELP> and <ENTER> can also be assigned functions 
by the project engineer. 

 
1 Toggling (numbers / letters) 
2 Delete character to the left of the current cursor position 
3 Delete character at the current cursor position. 
4 Tabulator 
5 Viewing the operator note 
6 Cancel 
7 Acknowledge 
8 Enter 
9 General control function (for key combinations) 
10 General control function (for key combinations) 
11 Shift (special character) 
12 Shift (upper/lower case) 
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Alphanumeric keys 
Use the following alphanumeric keys to enter digits, letters and special characters:  

$ &

>
;

: \

´
.

" °

`
0

? _

'
,

{ }( )
=

Y Z
+

A B
/

I J
*

Q R
-

S T

!
1

U V

~
2

W X

§
3

K L

^
4

M N

%
5

O P
6

C D

@
7

E F
8

G H

|
9

[ ]

<
#

 
Figure 5-3 Alphanumeric keys 

Cursor keys 
The cursor keys are used to move the text cursor and to navigate in screens and screen 
objects. The functions of the keys corresponds to the cursor keys on a standard PC 
keyboard.  

HOME

END

 
Figure 5-4 Cursor keys 

The <HOME> and <END> keys can also be assigned functions by the project engineer.  

5.2.4 Labeling the softkeys 

Labeling 
In the factory state, the softkeys on the keyboard unit are labeled as follows:  
• F1 to F20 and 
• S1 to S16. 
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A total of four labeling strips for the softkeys are inserted in the HMI device from the back. 
Use these strips to label the HMI device specifically for the system. 

Changing labeling strips 
 

 
Warning 
After opening the switching cabinet, certain system parts become accessible which may be 
conducting dangerously high voltage. 

 

1. Set the unit down with the front panel at the bottom.  
2. Remove the existing labeling strips. 
3. Insert the new labeling strips in the slots of the front panel with the inscription facing 

down. The individual positions are indicated in the figure by means of arrows. 
 

  Caution 
Wait for the ink to dry before inserting strips. A keyboard foil which is dirty on the inside 
cannot be cleaned and can only be replaced at the manufacturer’s factory. 

 

1
2

 
Figure 5-5 Placing the labeling strips on the MP 370 keys 

 
1 Labeling strips for ten keys 
2 Labeling strips for two keys 
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Create labeling strips 
Only use transparent foil to create your own labeling strips so that the LEDs in the softkeys 
remain visible. Label the foil either with a printer or a waterproof felt-tip pen. Cut the strips 
according to the specifications. 

17

39.4
20.65

245

6.05

17

5.
65

17

68
21

 
Figure 5-6 Labeling strip dimensions 

Printing the labeling strips 
The templates for the labeling strips are in the "Slide370.doc" file on the "WinCC flexible" 
installation CD in the "\Support\Documents" folder. The file can be edited with MS Word for 
example. 
Pay attention to the information provided in the file.  
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5.3 Operation with external keyboard/mouse 

Connection 
An external keyboard or mouse can be connected to the USB interface on the HMI device. 
Connection and disconnection are possible during normal operation of the HMI device (”hot 
plug in/out”). 
Operation of the HMI device via an external keyboard/mouse is particularly recommended 
during the commissioning and test phases. 

 

 Notice 
USB mouse: 
• Use a standard mouse. 

USB keyboard: 
• Use a standard keyboard with a USA/International keyboard layout. 
• Operation of the configured function keys is not possible via the external keyboard. 

Commercially available USB devices do not normally meet the higher industrial demands 
relating to interference resistance and can have negative effects on the HMI device. 

Operation 
Operation of the HMI device via a mouse is only slightly different from operation using the 
touch screen. After connecting a mouse, the mouse pointer  appears on the screen.  
When the mouse pointer is positioned on an operable button, the mouse pointer symbol 

changes . 
 

 
Caution 
When using a keyboard unit, do not operate the integrated membrane keyboard and 
external USB keyboard simultaneously. You may trigger an unintended action. 

See also 
Connect external keyboard and mouse (Page 4-9)
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Operating system and configuration 6
6.1 HMI device loader 

Loader 
The following figure illustrates the loader which appears briefly during the startup phase of 
the HMI device.  

 
Figure 6-1 HMI device loader 

The loader also appears when runtime has ended.  
The loader buttons have the following functions: 
• Press the "Transfer" button to switch the HMI device to transfer mode. 
• Press the "Start" button to start runtime with a project loaded on the HMI device. 
• Press the "Control Panel" button to access the Windows CE Control Panel in which 

various settings can be defined. The options for the transfer mode can be set here, for 
example. 

• Press the "Taskbar" button to display the Windows toolbar when the Windows CE Start 
menu is open. 

Protect loader with password 
It is possible to protect the Loader from unauthorized access by assigning a password.  



Operating system and configuration  
6.2 Windows CE Control Panel 

 MP 370 (WinCC flexible) 
6-2 Operating Instructions, Edition 03/2004, 6AV6691-1DE01-0AB0 

If the password is not entered, only the "Transfer" and "Start" buttons are available. This 
prevents incorrect operation and increases system or machine security since no changes 
can be made to the settings.  

 

 Notice 
If the password for the loader has been forgotten, it is only possible to access the Control 
Panel again after updating the operating system.  
All the data on the HMI device are overwritten when to operating system is updated. 

See also 
Open Control Panel (Page 6-2) 

6.2 Windows CE Control Panel 

6.2.1 Open Control Panel 

Windows CE Control Panel 
The Windows CE Control Panel can be used to modify the following system settings:  
• Date/time 
• Network 
• Device properties, e.g. brightness and calibration of touch screens 
• Regional settings 
• Screensaver 
• Screen keyboard 
• Volume (touch acknowledgement) 
• Printer 
• Backup/Recovery 
• Transfer 
• UPS (optional) 

Open Control Panel 
The following options are available to open the Control Panel: 
• During the startup phase: 

Press the "Control Panel" button in the loader to open the Windows CE Control Panel. It 
may be necessary to enter a password.  
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• During normal operation: 
� Provided one is configured, activate the operating element that is linked to the "Open 

Control Panel" system function. 
� The Control Panel can also be opened from the Windows CE Start menu by selecting 

"Settings ▶ Control Panel". 
Keyboard unit: 

The Windows CE Start menu can be opened by pressing the key combination CTRL  + 
ESC . 

Touch panel unit: 

The Windows CE Start menu can be opened by pressing the  button twice 
(locking key) on the alphanumeric screen keyboard.  

Result 
The Control Panel is opened. 

 
Figure 6-2 Windows CE Control Panel 
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Change settings 
 

 
Caution 
End Runtime before making changes to system settings; otherwise the changes will not take 
effect, e.g. for a transfer operation. 

 

Proceed as follows to change settings using the Windows CE Control Panel:  
1. Stop the runtime software before modifying any system settings. Use the relevant 

operating element provided in the project. 
2. Open the Control Panel as described above. 
3. Change the system settings in the Control Panel. 
4. Close the Control Panel: 

Touch panel unit: 

Press the  button. 
Keyboard unit: 

Press the ALT  key and use the cursor keys to select the menu command "File ▶ Close". 

Confirm the selection by pressing the ENTER  key. 
5. Start runtime via the loader. 

 

  Note 
Closing Control Panel dialogs using keyboard devices 
Proceed as follows if dialogs, which are open on the HMI device, cannot be closed: 
1. Open another dialog in the Control Panel. 

2. Press the key combination ALT  + TAB  to access another open dialog. 

3. Close the dialog by pressing ESC  or ENTER . 
4. Repeat steps 2 and 3, as necessary until all the dialogs are closed. 
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6.2.2 Communication 

"Communication" option 

 
This function is used to change the name used by the HMI device on the network.  

See also 
Open Control Panel (Page 6-2) 
Configuring the HMI device for network operation (Page 6-18) 

6.2.3 Date/Time 

"Date/Time" option 

 
This is used to set the date, time and time zone for the HMI device.  

Synchronizing date/time with the PLC 
The date and time of the HMI device can be synchronized with the PLC, if this has been 
configured in the project and the PLC program. The two PLC jobs 14 ("Set time") and 15 
("Set date") are provided for this. 
PLC jobs 40 and 41 can be used to transfer the date and time from the HMI device to the 
PLC. 

 

 Notice 
Synchronize the date and time when time-controlled responses should be triggered in the 
PLC by the HMI device. 

 

The HMI device can only buffer the date and time for a few days if no power is supplied. If 
the HMI device is not to be used for a number of days, it is recommended to synchronize the 
date and time via the PLC. 
Further information on this is available in the "WinCC flexible Communication" user manual. 
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See also 
Open Control Panel (Page 6-2) 

6.2.4 Input panel 

"InputPanel" option 

 
This function defines the position and size of the screen keyboard when it appears on the 
HMI device.  

Procedure 
1. Select the "Input Panel" option. 
2. Move the screen keyboard to the relevant position. 
3. To change the size, press the "Start Resize" button. 
4. Store the new settings by pressing the "Save" button. 

5. Close the option by pressing the  button or the ESC  key. 
 

  Note 
In order to correctly save the size and position of the on-screen keyboard in a fail-safe 
way, the alphanumeric representation must be selected prior to the Save operation. 

See also 
Open Control Panel (Page 6-2) 

6.2.5 Network 

"Network" option 

 
Network properties are configured here.  
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See also 
Configuring the HMI device for network operation (Page 6-18) 
Open Control Panel (Page 6-2) 

6.2.6 OP 

"OP" option 

 
The following setting options are provided by the "OP" option in the Control Panel: 
• Set brightness 
• Calibrate the touch screen (for touch panels) 
• Display device data 
• Backup non-resistant data 

Set brightness 
1. Open the "Display" tab in the "OP Properties" dialog.  

 
Figure 6-3 "OP Properties" dialog, "Display" tab 

2. Change the brightness setting of the screen using the "UP" and "DOWN" buttons in the 
"Brightness" group.  

3. In the case of the touch panel, close the dialog using the "OK" button. In the case of the 
keyboard unit, move the focus to the tab heading by pressing <ENTER>. 

In the case of keyboard devices, the brightness can be changed outside the Windows CE 
Control Panel with the following key combinations: 

A-Z  +  Increases the brightness.  
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A-Z  +  Reduces the brightness. 
 

 Note 
Wait at least 10 sec. after changing the setting before switching the HMI device off. 
Otherwise, the changes will not be saved. 

Calibrate touch screen 

Purpose 
Depending on the installation position and viewing angle, it is possible that a more or less 
strong parallax may occur when operating the touch panel screen. In order to prevent 
resulting operating errors, the screen can be calibrated during the start-up phase and normal 
operation.  

Procedure 
1. Open the "Touch" tab in the "OP Properties" dialog. 

 
Figure 6-4 "OP Properties" dialog, "Touch" tab 

2. Press the "Recalibrate" button to start the calibration process. 
Five calibration crosses appear in succession on the screen. Follow the instructions 
provided on the screen and touch the respective calibration cross.  

3. Apply calibration: 
Touch any point on the screen after the calibration process for the new calibration data to 
take effect. 
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4. Reject calibration: 
Wait 30 seconds (until the counter reaches zero) before rejecting the new calibration 
data. 
If calibration is not performed correctly, the new values are not accepted. 

5. Press the "OK" button to close the dialog. 

Configured function 
If the "Calibrate Touch Screen" function has been linked to an operating element in your 
project, the touch screen can be calibrated during operation. The triggering operator control 
object can be configured in such a way that a password is required to calibrate the touch 
screen.  
The calibration process is identical with steps 2, 3 and 4 described for the start-up phase. 

Persistent storage of registrations 
1. Open the "Persistent Storage" tab in the "OP Properties" dialog.  

 
Figure 6-5 "OP Properties" dialog, "Persistent Storage" tab 

2. Press the Save Registry button to start the storage process. 
The current registration settings are stored in the Flash memory.  

3. Press the Save Files button to start copying the files in the RAM file system to the Flash 
memory. 
Following a restart, these saved files will be copied back to the file system. 

4. In the case of the touch panel, close the dialog using the "OK" button. In the case of the 
keyboard unit, move the focus to the tab heading by pressing <ENTER>. 
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Display device data 
1. Open the "Device" tab in the "OP Properties" dialog. 

Various device data is displayed. 

 
Figure 6-6 "OP Properties" dialog, "Device" tab 

2. Close the dialog using the "OK" button in the case of touch panels. Press the <ENTER> 
button in the case of keyboard units. 

See also 
Open Control Panel (Page 6-2) 

6.2.7 Printer 

"Printer" option 

 
A printer can be selected and set up using the "Printer" option. Some settings are only 
relevant for printing a hardcopy of the screen contents and have no influence on the alarm 
logging, e.g. color or quality of graphics printing.  

Adjustable options 
The available settings depend on the selected printer.  



 Operating system and configuration 
 6.2 Windows CE Control Panel 

MP 370 (WinCC flexible) 
Operating Instructions, Edition 03/2004, 6AV6691-1DE01-0AB0 6-11 

Printer 
Select the printer from the printer list on the connected HMI device. 

Port 
Select the port and baud rate used by the HMI device to transfer data to the printer, e.g. IF2: 
9600.  

Net Path 
If a network has been configured, enter a path for a network printer here. Select "Network" 
as the port. 

Paper Size 
Select the paper size used in the printer, e.g. A4 or Letter.  

Draft Mode 
Define the quality of the graphics printout. If the option is activated, printout is performed in 
draft quality. If deactivated, the printout is in high quality.  

Color 
Define if a color printer will print in color or black and white. 

Print Range 
Define whether only the selected area should be printed or the entire contents.  

Orientation 
Define whether the page should be printed in Portrait or Landscape,  
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Margins 
The margin values entered here are ignored by the HMI device.  

 

 Note 
If a serial printer is connected, the following printer settings are required: 
- RS 232, whereby only the RxD, TxD and GND signals are required, 
- 8 data bits 
- 1 stop bit 
- No parity 
- Baud rate between 9600 and 57600, printer-dependent 
- XON / XOFF protocol. 

Default setting 
When the HMI device is supplied, the following default settings are defined:  
• Printer: EPSON 9 matrix printer 
• Port: IF2 
• Baud rate: 9600 bps 

See also 
Basic principles (Page 6-17) 
Interface description (Page 12-8) 
Open Control Panel (Page 6-2) 
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6.2.8 Regional Settings 

"Regional Settings" option 

 
Region-specific settings can be defined here. for example:  
• Date and time format display 
• Displaying numbers 
The factory settings on the HMI device are German format.  

 

 Note 
The settings defined in the "Regional Settings" option do not cause a change of languages in
the Windows CE dialogs, e.g. the Control Panel. English is always used. 

See also 
Open Control Panel (Page 6-2) 

6.2.9 Screen Saver 

"Screensaver" option 

 
It is possible to define a period of time (in minutes) for automatic activation of the 
screensaver on the HMI device. The screensaver settings are defined in the "Screensaver" 
option of the Windows CE Control Panels. 

 
Figure 6-7 "Screen Saver" dialog 
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The screen saver is automatically activated if the HMI device is not operated within the 
defined period of time.  
If a value of 0 is entered, the screen saver is deactivated. 

 

 Note 
When the screensaver is activated, the back-lighting is automatically dimmed. 

 

The screen saver is deactivated on pressing any key or touching the touch screen. The 
function assigned to that key/button is not triggered. 

Dim back-lighting 
For technical reasons, the brightness of the screen back-lighting is reduced with increased 
operational use. To increase the service life of the back-lighting, use the "Screensaver" 
option in the Windows CE Control Panel to set the period of time after which the back-
lighting should be dimmed.  
The back-lighting is automatically reduced if the HMI device is not operated within the 
defined period of time.  
On entering the value 0, dimming of the back-lighting is deactivated. 

 

 Notice 
The screen can still be viewed with a reduced back-lighting.  
The back-lighting is reactivated on pressing any key or touching the touch screen. The 
function assigned to that key/button is triggered. 

See also 
Open Control Panel (Page 6-2) 
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6.2.10 System 

"System" option 

 
The "System" option can be used to define the size of the memory for the DRAM file system 
(storage memory). It defines how much memory can be used by the applications. Values can 
be modified using a slider control. The standard amount of memory in the DRAM file system 
for applications is 6 Mb. 

 
Figure 6-8 "System Properties" dialog 

 

 
Caution 
If too much DRAM file memory is provided, WinCC flexible runtime has too little working 
memory available. There is no guarantee that your project will run properly if settings are 
wrong. 

 

 Note 
Operation of additional applications together with WinCC flexible 
The memory requirements of projects in WinCC flexible has changed in comparison to 
ProTool. 
If user-specific additional applications should be operated on the HMI device together with a 
WinCC flexible project, the functionality required on the HMI device must be tested and, if 
necessary, the scope of the project or additional application reduced.  
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See also 
Open Control Panel (Page 6-2) 

6.2.11 UPS 

Uninterruptible power supply (UPS) 
To prevent the loss of data in the event of a power failure, a UPS can ensure a controlled 
shutdown of the HMI device. An external UPS detects when the power supply has failed and 
signals this to the HMI device via the serial interface.  
The UPS can only be loaded as an option. 

"UPS" option 

 
The UPS driver is installed as an add-on using the ProSave tool. The associated UPS icon 
only appears in the Windows CE Control Panel after it has been installed via ProSave. 

 
Figure 6-9 "UPS Properties" dialog 

It is possible to define how long the power failure may continue without the runtime being 
shut down. The driver is suitable for the SITOP DC-UPS Module A. 

See also 
Open Control Panel (Page 6-2) 
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6.2.12 Volume & Sounds 

"Volume & Sounds" option 

 
This is used to change the settings for acoustic signals and operating acknowledgement. 
The "Volume" tab includes the following options:  
• acoustic acknowledgement for touch operation 
• volume control 
The "Sounds" tab is irrelevant for runtime settings. 

See also 
Open Control Panel (Page 6-2) 

6.3 Network operation 

6.3.1 Basic principles 

Purpose 
The standard HMI device is equipped with an on-board Ethernet interface. Implementing the 
network function enables the HMI device to be used for:  
• Logging data via the network 
• Printing via a network printer 
• Storing recipe data records in the network 
• exporting recipe data records in the network 
• importing recipe data records from the network 
• Transferring projects 
• Backing up data 

 

  Notice 
The HMI device can only be implemented in TCP/IP networks. 
The HMI device only has client functionality in the PC network. This means that users 
can access files of a subscriber with TCP/IP server functionality from the HMI device via 
the network. However, it is not possible to access files on the HMI device via the network 
from a PC. 
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  Note 
Information on communication using SIMATIC S7 via Ethernet is provided in the "WinCC 
flexible Communication" user manual. 

Requirements 
Within a TCP/IP network, computers are addressed by means of network names. These 
network names are translated from a DNS or WINS server to TCP/IP addresses. Direct 
addressing via TCP/IP addresses is not currently supported by the operating system. 
Therefore, to ensure the functionality of the HMI device in a TCP/IP network, it is useful to 
employ a DNS or WINS server. Appropriate servers are available in common TCP/IP 
networks. Please contact your network administrator.  

Printing via a network printer 
The HMI device's operating system does not support the direct alarm logging via a network 
printer. All other printer functions such as hardcopy or shift log, are possible via the network 
without restriction. 

6.3.2 Configuring the HMI device for network operation 

Overview 
The HMI device must be appropriately configured before setting into network operation. The 
configuration is basically divided into the following steps:  
• Set computer name of the HMI device 
• Configure the network address. 
• Set login information 
• Save settings 

Preparations 
Before beginning the configuration, request the specific network parameters from the 
network administrator. The following information is of particular interest:  
• Does the network use DHCP for dynamic assignment of network addresses? If not, get a 

new TCP/IP network address for the HMI device. 
• What is the TCP/IP address of the default gateway? 
• Which DNS addresses has the name server? 

(If DNS is used in the network) 
• Which WINS addresses has the name server? 

(If WINS is used in the network) 
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Procedure 
The following instructions describe how to define the general settings. Additional steps or 
procedures may be necessary depending on the network infrastructure.  
1. Open the Control Panel. 
2. Set computer name of the HMI device. 

In order to identify the HMI device within the network, it must be assigned a unique name 
(device name) within the network using the Control Panel option "Communication" 

.  
Apply the settings and close the dialog by pressing <ENTER>. 

3. Configure the network address. 

� Use the "Network" option to open the network configuration.  
� Select an appropriate network driver in the "Adapters" tab. 

Select "Onboard LAN" for HMI devices with an integrated Ethernet card. Select 
NE2000-compatible driver for other network cards. 

� Press the "Properties" button in order to configure the network characteristics of the 
network card used. 
Complete the dialog according to the network driver selected.  

� If your network uses DHCP, skip this step.  
Select the "IP Address" tab then the "Specify an IP Address" option. 
Enter the TCP/IP address of the HMI devices (e.g. 233.239.2.100), subnet mask (e.g. 
255.255.255.0) and default gateway (e.g. 223.239.2.200).  

� Enter the name server address of the network in the "Name Servers" tab. 
Close the dialog with <ENTER> or press "OK" to apply the settings. 

4. Set login information. 
In order to correctly log on to the network, enter your user permissions in the 
"Identification" tab. Enter the user name valid for the network or the network server and 
the associated password (max. 8 characters).  
If the network administrates users via domain controllers, enter the relevant domain 
controller name.  
Close the dialog with <ENTER> or press "OK" to apply the settings. 

5. Save the settings. 
� Switch off the HMI device. 
� Before switching the HMI device on, insert the network cable in the corresponding 

interface so that a unique IP address can be assigned during the start-up phase. 
� Switch the HMI device on again. 

See also 
Open Control Panel (Page 6-2) 
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6.3.3 Test network 

Procedure 
When the HMI device has been configured for network operation, connect the network 
server via Windows Explorer to test the network. Proceed as follows:  
1. Start Windows Explorer via the Windows CE Start menu. 

� Keyboard unit: 

The Windows CE Start menu can be opened by pressing the key combination CTRL  + 
ESC . 

� Touch panel unit: 

� The Windows CE Start menu can be opened by pressing the  button twice 
(locking key) on the alphanumeric screen keyboard. 

Select the "Windows Explorer" application from the "Programs" program group.  
2. Use the "Address" input field to enter the UNC name of the folder or drive provided on the 

server. 
Example: 
The server is called: mrnbg2 
The name provided is: data 
The resulting UNC name is: \\mrnbg2\data 

 

  Note 
The use of TCP/IP addresses to address PCs is not supported by the operating system. 
For example, the use of the UNC names "\\130.170.10.45\data" is not permitted. 

 

3. After entering the UNC name, press the <ENTER> key. 

Result 
When all the network settings are correct, Windows Explorer displays the files located under 
the directory provided on the TCP/IP server. 

 

 Note 
In addition, the network program "ipconfig" is available in the operating system. 
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See also 
Configuring the HMI device for network operation (Page 6-18) 

6.3.4 Configuring network access 

Requirements 
The network is set up on the HMI device. 

Procedure 
In order to use the network functions in the WinCC flexible configuration software, specify 
the relevant UNC assigned names at those points where paths have been entered for files or 
directories.  

Example 1: Logs 
If you want to perform logging on the server in the example above, replace the predefined 
archive memory location "\Storage Card\Logs" with the UNC assigned name for the server, 
e.g. "\\mrnbg2\daten\Logs".  

Example 2: Recipe data records 
In order to store recipe data records in the network, replace the predefined path name 
"\Flash\Recipes" with the UNC assigned name for the server, i.e. "\\mrnbg2\data\recipes". 
The same applies for exporting and importing recipe data records using the functions 
"ExportDataRecords" and "ImportDataRecords". In this case, replace the parameter "File 
name" with the UNC assigned name for the server. 

See also 
Configuring the HMI device for network operation (Page 6-18) 
Test network (Page 6-20) 
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Prepare and backup project 7
7.1 Transfer project to the HMI device 

7.1.1 Commissioning for the first time 

Introduction 
When commissioning for the first time, there is no configuration on the HMI device. In order 
to transfer the necessary project data and the runtime software from the configuration 
computer to the HMI device, proceed as follows, observing the sequence. 

 

 Notice 
When starting the first time, observe the safety information on reverse poling. 

 

 Caution 
Always terminate the runtime software before switching off the voltage supply in order to 
prevent loss of data. 
Press the operating element linked to the "StopRuntime" system function in the project to 
stop runtime. Wait until the HMI device displays the loader and then switch off the power 
supply. 

 

 Note 
During the commissioning phase, it is possible to connect an external USB keyboard or 
mouse via the USB interface. 

Procedure 
1. Connect the HMI device to the configuration computer using a suitable standard cable. 

Use one of the following interfaces depending on the type of transfer: 
� IF2 (serial) 
� IF1B (MPI/PROFIBUS DP) 
� USB 
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� Ethernet 
Transfer via modem is also possible. 
Default setting: Serial connection 

2. Switch on the power supply to the HMI device. 
When the HMI device is started up, the system automatically switches from the Loader to 
transfer mode. 

3. Press the "Cancel" button to switch to the Loader. 
4. Press the "Control Panel" button to switch to the Windows CE Control Panel. 
5. Adapt the interface setting (serial, MPI, USB or Ethernet) in the transfer settings. 

Default setting: Serial connection 
6. Close the Control Panel and switch to the transfer mode. 
7. Start the project transfer operation on the configuration computer. Please refer to the 

"WinCC flexible" user manual for more information on the settings required on the 
configuration computer for the transfer operation. 

Result 
The configuration computer checks the connection to the HMI device. If the connection is not 
available or defective, the configuration computer issues the corresponding error message.  
If a transfer operation from the configuration computer is terminated as a result of a 
compatibility conflict, the operating system of the HMI device must be updated. 
If the connection is correct, the new project data are transferred to the HMI device. Following 
successful transfer, the project is started and the Start screen of the transferred project 
appears.  

Set date/time 
The date and time must be updated in the following cases:  
• Initial startup 
• If the HMI device is disconnected from the power supply for an extended period without a 

backup battery 

See also 
Transfer mode options (Page 7-5) 
Connecting the power supply (Page 4-15) 
HMI device loader (Page 6-1) 
Operating touch objects (Page 9-2) 
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7.1.2 Recommissioning 

Purpose 
When recommissioning, the existing configuration on the HMI device is replaced by another. 
To this end, a new project is transferred from the configuration computer to the HMI device. 
The procedure for transferring the project required for operation from the configuration 
computer to the HMI device is described in "Transfer". 
The following options are available for switching the HMI device to transfer mode:  
• Starting transfer mode manually during the HMI device startup phase 
• Starting transfer mode manually by pressing the applicable operating element in the 

project when the HMI device is in operation 
• Starting transfer mode automatically while the HMI device is in operation 

7.2 Transfer 

7.2.1 Start transfer manually 

Procedure 
1. Connect the HMI device to the configuration computer using a suitable standard cable. 

Use one of the following interfaces depending on the type of transfer:  
� IF2 (serial) 
� IF1B (MPI/PROFIBUS DP) 
� USB 
� Ethernet 
Transfer via modem is also possible. 

2. Switch on the power supply to the HMI device. 
3. Adapt the interface setting (serial, MPI, USB or Ethernet) in the transfer settings. 
4. Close the Control Panel and switch to the transfer mode. 
5. Start project transfer on the configuration computer. 

Result 
The configuration computer checks the connection to the HMI device. If the connection is not 
available or is faulty, the configuration computer issues an error alarm to that effect.  
If downloading from the configuration computer is terminated as a result of a compatibility 
conflict, the HMI device's operating system must be updated. 
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If the connection is correct, the new project is transferred to the HMI device. Following 
successful transfer, the project is started and the Start screen of the transferred project 
appears.  

See also 
Transfer mode options (Page 7-5) 
Update operating system (Page 7-18) 

7.2.2 Start transfer automatically 

Overview 
The HMI device can automatically switch to transfer mode during normal operation when a 
transfer is started on the connected configuration computer. The transfer operation is 
completed without intervention on the HMI device. Therefore, this option is particularly suited 
for the test phase of a new project.  
To switch to transfer mode from active operation, open the "Transfer Settings" window on 
the HMI device and select the required connection and the corresponding "Remote Control" 
function.  

 

 Notice 
When the "Remote Control" option is activated, Runtime is automatically ended and the 
switch is made to transfer mode. Runtime cannot be ended if dialogs are open or a transfer 
operation has been started on the HMI device. 
Close the dialog or cancel the transfer process on the configuration computer. 
Following the start-up phase, disable the automatic transfer option to prevent inadvertently 
switching the HMI device to transfer mode in a running system, thereby ending Runtime. To 
do this, deactivate the "Remote Control" options in the transfer settings defined for the HMI 
device. 

See also 
Transfer mode options (Page 7-5) 
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7.2.3 Transfer mode options 

Transfer mode options 

 
The following options can be set for transfer mode:  
• The HMI device can be switched to transfer mode automatically when in normal operation 

as soon as a transfer is started on the connected configuration computer. 
• Select a specific connection type so that transfer can only occur either via a serial 

connection, MPI/PROFIBUS-DP, USB or Ethernet connection. 
 

  Note 
Do not make any other changes if the Runtime software is running or the HMI device is in 
transfer mode. 

Setting the communication channel 
The "Channel" tab in the Transfer Settings menu can be used to activate the required 
communication channel and the "Remote Control" checkbox. In addition to the serial 
communication channel, a second channel can also be selected for transfer of data from the 
configuration computer to the HMI device. 

 
Figure 7-1 "Transfer Settings" dialog, "Channel" tab 

Press the "Advanced" button to define the following settings:  
• For transfer MPI or PROFIBUS-DP, define the "Address" bus parameter and 

"Transmission Rate" and "Highest Station" network parameters. 
• Define the driver for transfer via Ethernet. 
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 Warning 

When the "Remote Control" checkbox is active, ensure that the HMI device is not 
inadvertently switched to transfer mode from the configuration computer. 
In the case of PROFIBUS DP, changes may only be made here for commissioning 
purposes.  
For each modification to the PROFIBUS DP settings, the HMI devices set up only one 
corresponding standard bus parameter set. Under unfavorable conditions, this can lead 
to faults on the PROFIBUS. 
In order to calculate the bus parameters exactly, the entire bus topology must be known. 
Correct definition of the bus parameters for Runtime is automatically ensured through the 
integrated operation of WinCC flexible in SIMATIC STEP 7. 

 

  Notice 
If a serial printer is connected to the HMI device, deactivate it by selecting "Remote 
Control" checkbox for the serial communication channel. Otherwise, printing is not 
possible. 
When a configuration is transferred from the configuration computer to the HMI device, 
enable a communication channel using the "Enable Channel" option. 
If an interface is occupied by other programs, transfer cannot take place via that 
interface. 

 

  Note 
The bus parameters for the MPI transfer, e.g. MPI address, baud rate, etc., are read from 
the project currently loaded on the HMI device.  
The settings for MPI transfer can be modified. To do this, you must first end Runtime, 
modify the settings, and switch to transfer mode. When Runtime is started subsequently, 
the bus parameters are overwritten with the values from the project. 
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Transfer mode directories 
The "Directories" tab can be used to specify the following paths (refer to figure below).  

 
Figure 7-2 "Transfer Settings" dialog, "Directories" tab 

Project File 
The predefined storage location for the project file can be changed here. The internal Flash 
memory or external Flash cards can be set. During the next transfer operation, the project 
will be stored in the storage location specified.  

Project Backup 
Here, you change the default storage location for the source file of your project. This file can 
be used for restoring (uploading) the configuration. External Flash cards or network 
connections can be set.  

Autostart application 
• Path 

The memory location for Runtime is defined here. This is the application used to run your 
project in Windows CE. 

• Wait 
Here, you set the amount of time (in seconds) that the Loader is to be displayed before 
Runtime is started (1 s, 3 s, 5 s, 10 s, or constantly). If Runtime is not available, the 
device automatically switches to transfer mode.  
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  Notice 
With the exception of "Wait," do not change the default settings in these fields if you are 
working with WinCC flexible. Otherwise, the HMI device can no longer start your project. 

 

Press the "OK" button or <ENTER> key to confirm the settings currently defined for the 
transfer options. Ensure that no buttons have been selected. The dialog is closed and the 
Windows CE Control Panel is displayed.  
Press the close symbol or <ESC> key to close the dialog and open the Windows CE Control 
Panel. Any modifications made to the settings are rejected.  

 

 Note 
If the HMI device is in transfer mode while changes are made to the transfer settings, the 
settings only take effect after the transfer function is restarted. This can occur when the 
Control Panel is selected via the Windows Start menu in order to modify the transfer 
properties. 

7.2.4 Testing the project 

Introduction 
There are two options on the HMI device for testing a new project: 
• Test project offline 

Testing offline means that communication between the HMI device and PLC is 
interrupted while the test is being carried out. 

• Test project online 
Testing online means that the HMI device and PLC communicate with each other during 
the test. 

It is advisable to perform both tests starting with the "Offline test" followed by the "Online 
test." 

 

 Note 
Testing on a configuration computer 
A project can also be tested on a configuration computer using the Simulator. Detailed 
information on this is available in the "WinCC flexible" user guide and in the WinCC flexible 
online help. 
You should always test the project afterwards on the HMI device where the project will be 
used. 
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Check the following: 
1. Check that configured screens are displayed correctly 
2. Check screen hierarchy. 
3. Test input objects 
4. Test softkeys. 
5. Test that tag data can be entered. 
The test increases the certainty that the project will run error-free on the HMI device.  

Conditions for the offline test 
• The project is on the HMI device.  
• The project is offline. 

Open the selected project on the configuration computer. Select "Communication > 
Connections" and switch to "Online: Off". Transfer the project to the HMI device. 
Alternatively, the operating mode can be changed by means of an operating element in 
the project. Use the operating element to switch the project offline. 

 

  Note 
During the test phase, it is recommended that the transfer operation be started during 
operation.  

Procedure 
Use "Offline" mode to test the individual project functions on the HMI device without them 
being affected by the PLC. PLC tags are, therefore, not updated.  
Test the project operating elements and displays to the extent possible without connecting to 
the PLC. Proceed as follows: 
1. Check that configured objects are displayed correctly. 
2. Check screen hierarchy. 
3. Check input fields. 
4. Test softkeys. 

Conditions for the online test 
• The project is on the HMI device.  
• The project is online. 

Open the selected project on the configuration computer. Select "Communication > 
Connections" and switch to "Online: On". Transfer the project to the HMI device. 
Alternatively, the operating mode can be changed by means of an operating element in 
the project. Use the operating element to switch the project online. 
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  Note 
During the test phase, it is recommended that the transfer operation be started during 
operation.  

Procedure 
Use "Online" mode to test the individual project functions on the HMI device with influence 
being exerted by the PLC. PLC tags are updated in this case.  
Test the project operating elements and displays. If offline testing has not yet been 
performed, proceed as follows: 
1. Check that configured objects are displayed correctly. 
2. Check screen hierarchy. 
3. Check input fields. 
4. Test softkeys. 
Test all of the objects in the loaded project for which communication with the PLC is 
necessary: 
• Alarms 
• Alarm logging 
• Recipes 
• Screen selection by PLC through PLC job 
• Print functions 

7.2.5 Uploading project 

Introduction 
During transfer, generally only the run-capable configuration (*.fwx) is transferred to the HMI 
device. If the original project file is to be used for further development of the configuration or 
for fault analysis, it must remain on the configuration computer.  
The project and associated source file (*) can be stored on the HMI device. It can be 
retrieved (transferred back) if necessary. 
After uploading a project, it can be analyzed and modified. This is of particular importance if  
• the original configuration computer cannot be accessed, or 
• the project source file is no longer available. 
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Requirements 
The following conditions must be fulfilled in order to retrieve a project: 
• The HMI device is connected to a configuration computer. 
• The associated source file is stored on the HMI device. 
• The "Enable Upload" option must be selected in order for the project file to be transferred 

from the configuration computer to the HMI device. 
This option can be activated in WinCC flexible in "Project ▶ Transfer ▶ Transfer Settings". 

• A memory card is inserted in the HMI device. 

Downloading and uploading 
In the case of transfer, including transfer of the source file, the project file is transferred to 
the HMI device. 
Following uploading onto the configuration computer, the *.pdz file is compressed by the 
WinCC flexible configuration software. The project is then available in HMI format on the 
configuration computer and can be edited. 

 

 Notice 
Version number 
The uploaded project file can only be opened with a configuration software whose version 
number is greater than or equal to that of the configuration software used to create the 
project.  
Test source file 
WinCC cannot determine if the source file on the HMI device was generated from the project 
run on it. If a transfer is performed at any time without the "Upload" option activated, only the 
project is transferred. The existing source file may be from a previously transferred project. 

Procedure 
1. Select the menu command "Project ▶ Transfer ▶ Communication Settings" on the 

configuration computer in WinCC flexible. 
The "Communication Settings" dialog box is opened. 

2. Select the required HMI device type and connection type between the HMI device and 
the configuration computer. 

3. Define the connection parameters. 
4. Select "OK". 
5. Switch the HMI device to transfer mode in the loader. 
6. On the configuration computer, use WinCC to start the back transfer using the "Project ▶ 

Transfer ▶ Back Transfer" menu command. 
The project is opened on the configuration computer. 
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Result 
The uploaded project is opened on the configuration computer. Save the project, if 
necessary. 

7.3 System settings 

7.3.1 Set language 

Language-dependent objects 
When the project is transferred from the configuration computer, up to five languages can be 
transferred to the HMI device simultaneously. The Asian language variants are also 
supported. You can switch between the individual languages online at any time and display 
language-dependent objects within Runtime, e.g., texts or formats, in another language. 
The following are language-dependent: 
• Alarms 
• Screens 
• Text lists 
• Help texts 
• Date/time 
• Decimal symbol 
• Static texts 

Requirements 
If during operation you want to change the language in which the project will appear on the 
HMI device, the following conditions must be met: 
• The language must be available for the configuration on the HMI device. 

The languages available on the HMI device are defined during configuration. 
• An operating element for switching languages must have been configured. 

Select languages 
Immediately after the operating element for switching languages is activated, all of the 
language-dependent objects are displayed in the new language. 
Two different types of language change can be configured: 
1. Each time the operating element for switching languages is activated, the HMI device 

advances cyclically by one language. 
2. Activating the operating element for switching languages causes the HMI device to switch 

to a specific language. 
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7.3.2 Set operating mode 

Conditions for changing operating modes 
In order to switch between the operating modes described below on the HMI device, the 
relevant function must be configured and linked to an operating element. 

Operating modes 
The HMI device is designed for the following operating modes: 
• Offline mode 
• Online mode 
• Transfer mode 
An operating element in the project can be used to set "Offline" and "Online" operating 
modes on both the configuration computer and the HMI device. 
Transfer mode must have been configured as an operating element. 

Offline mode 
In this mode, there is no communication connection between the HMI device and PLC. The 
HMI device can be operated but data cannot be transmitted to the PLC or received from the 
PLC. 

Online mode 
In this mode, a communication connection between the HMI device and PLC exists. When 
using this mode, processes in progress can be operated and visualized without restriction.  

Transfer mode 
In this mode, you can transfer a project from the configuration computer to the HMI device. 
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7.4 Other transfer functions 

7.4.1 Functions 

ProSave Service Tool 
The ProSave Service Tool is supplied with WinCC flexible. ProSave provides all the 
functions that are necessary to transfer data between the configuration computer and HMI 
device. These include: 
• Saving data (backup) 
• Retrieving data (restore) 
• Updating the operating system (OS update) 
• Transferring authorizations 
• Transferring options 
ProSave can be installed together with WinCC flexible or as a stand-alone tool on the 
configuration computer. Further information on ProSave is available in the "WinCC flexible" 
user's guide.  

ProSave functions in WinCC flexible 
ProSave is normally installed on the configuration computer together with WinCC flexible.  
The entire function range of ProSave is available within WinCC flexible in the "Project ▶ 
Transfer" menu. In this way, all the necessary specifications, e.g. target device and 
download settings, are assumed from the project. 

Stand-alone ProSave 
ProSave can also be installed as a stand-alone application. In this case, the settings relating 
to the HMI device and the transfer must be defined in the ProSave user interface and match 
the HMI device settings. 
The advantage of stand-alone ProSave is that data backup and restore operations can be 
performed without WinCC flexible via the following transfer channels: 
• Serial 
• MPI/PROFIBUS DP 
• USB 
• Ethernet 
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7.4.2 Backup and Restore 

Introduction 
WinCC flexible or the ProSave Service Tool can be used to back up and restore projects, 
recipes, and passwords. 
If the service tool was installed together with WinCC flexible, it can be called by selecting 
"SIMATIC ▶ ProSave" in the "Start" menu on the configuration computer. 
ProSave is an executable program which can run without WinCC flexible. ProSave can, thus, 
be run without a WinCC flexible license. 

Requirements 
• The HMI device is connected to a configuration computer. 
• WinCC flexible or ProSave is installed on the configuration computer. 

  Notice 
Close all open applications on the configuration computer before starting Backup or 
Restore. 

Backup 
During the backup process, the project is transferred from the HMI device Flash memory to 
the configuration computer.  
There are two ways to make a backup copy: 
• Backup using stand-alone ProSave 
• Backup using WinCC flexible 

 

  Notice 
Licenses on the HMI device are not included in the backup. 

 

The procedure for the backup differs in terms of the operations performed on the 
configuration computer. 

Procedure - backup using stand-alone ProSave 
1. Start ProSave on the configuration computer using the Windows Start menu. 
2. Use the "General" tab to select the required HMI device and connection type with the 

appropriate connection parameters. 
3. Use the "Backup" tab to select the data to be saved: 

� "Recipes" or 
� "Passwords" 
� "Complete backup" 
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4. Select the folder where the *.psb backup file should be saved. 
5. Configure the required transfer channel on the HMI device. 
6. Switch the HMI device to transfer mode. 
7. Start the backup operation in ProSave using the "Start Backup" button. 

A status display monitors the progress of the data transfer.  

Procedure - backup using WinCC flexible 
1. In WinCC flexible, select "Project ▶ Transfer ▶ Transfer Settings" in the "Select HMI 

devices for transfer" dialog to select the connection type with the appropriate connection 
parameters. 

2. Open the "Backup Settings" dialog in WinCC flexible using the "Project ▶ Transfer ▶ 
Backup" menu command. 

3. Select the data to be saved: 
� "Recipes" or 
� "Passwords" or 
� "Complete Backup" 

4. Select the folder where the *.psb backup file should be saved. 
5. Configure the required transfer channel on the HMI device. 
6. Switch the HMI device to transfer mode. 
7. Start the backup operation in WinCC flexible using the "OK" button. 

A status display monitors the progress of the data transfer.  

Result 
When the transfer is successfully completed, a message appears. The project is copied on 
the configuration computer. 

Restore  
In the case of a restore process, the data backup stored on the configuration computer is 
reloaded into the internal Flash memory of the HMI device. 
There are two ways to restore the data: 
• Restore using stand-alone ProSave 
• Restore using WinCC flexible 

 

  Notice 
Data loss 
The files in the user memory of the HMI device are deleted during this process. This also 
applies to the licenses on the HMI device. Therefore, save the licenses elsewhere before 
starting the restore process. 
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The restore procedure differs in terms of the operations performed on the configuration 
computer. 

Procedure - restore using stand-alone ProSave 
1. Start ProSave on the configuration computer using the Windows Start menu. 
2. Use the "General" tab to select the required HMI device and connection type with the 

appropriate connection parameters. 
3. In the "Restore" tab, select the path of the file to be restored. 

"Content" indicates the HMI device for which the backup was created and the type of 
backup data contained in the file. 

4. Configure the required transfer channel on the HMI device. 
5. Switch the HMI device to transfer mode. 
6. Start the restore operation in ProSave using the "Start Restore" button. 

A status display monitors the progress of the restore process. 

Procedure - restore using WinCC flexible 
1. In WinCC flexible, select "Project ▶ Transfer ▶ Transfer Settings" in the "Select HMI 

devices for transfer" dialog to select the connection type with the appropriate connection 
parameters. 

2. Open the "Restore Settings" dialog in WinCC flexible using the "Project ▶ Transfer ▶ 
Restore" menu command. 

3. In the "Open" field, select the path of the file to be restored. 
"Content" indicates the HMI device for which the backup was created and the type of 
backup data contained in the file. 

4. Configure the required transfer channel on the HMI device. 
5. Switch the HMI device to transfer mode. 
6. Start the restore process in WinCC flexible using the "OK" button. 

A status display monitors the progress of the restore process. 

Result 
When the transfer is successfully completed, a message appears. The project is available on 
the HMI device again. 
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7.4.3 Update operating system 

Introduction 
Conflicts may occur when using the HMI device due to the use of different versions of the 
configuration software and the HMI device image present on the HMI device. In such a case, 
transfer of the project is stopped by the configuration computer and a message indicating a 
compatibility conflict appears. The operating system on the HMI device must then be 
updated. For this purpose, a current HMI device image must be transferred to the HMI 
device. The image contains the required operating system. 
The procedure is described below. 

Requirements 
• The HMI device is connected to the configuration computer according to the selected 

connection type. 
• WinCC flexible or ProSave is installed on the configuration computer. 

 

  Notice 
Data loss 
When the operating system is updated, all of the existing data on the HMI device, such 
as project, applications, passwords, and recipes, are deleted. 

 

There are two different procedures for updating the operating system: 
• Updating the operating system using stand-alone ProSave 
• Updating the operating system using WinCC flexible 

If an operating system update should be performed using WinCC flexible, all the general 
settings, such as HMI device and transfer settings, are assumed from the project. 

Update operating system 
There are two types of operating system updates: 
• An update on an HMI device on which an operating system already exists 

In this case, the operating system update is executed without selecting the "Boot" check 
box. 

• An update on an HMI device on which there is no operating system 
In this case, the operating system update is executed with the "Boot" check box selected. 
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Procedure – update operating system without Booting 
When updating the operating system without "Booting", the configuration computer 
communicates with the HMI device via its operating system. 
Proceed as follows in order to adapt the operating system on the HMI device to the 
configuration software version used:  
1. Start WinCC flexible from the Windows Start menu on the configuration computer and 

open a project, or start ProSave from the Windows Start menu. 
2. When using WinCC flexible, select the "Project ▶ Transfer ▶ Transfer Settings" menu 

command or, using ProSave, select the existing HMI device on the "General" tab. 
3. Select the connection. 
4. Enter the connection parameters 
5. In WinCC flexible, select the "Project ▶ Transfer ▶ Update Operating System" menu 

command, or in ProSave, select the "OS Update" tab in ProSave. 
6. Clear the "Boot" check box if it is selected. 
7. In "Image path," select the directory containing the image file (file extension *.img) 

belonging to the HMI device. 
8. Select the "Open" button. 

When the image file has been opened successfully, various version information appears 
in a window. 

9. Configure the required transfer channel on the HMI device. 
10. Switch the HMI device to transfer mode. 
11. Start the operating system update on the configuration computer using the "Update OS" 

button. 
The time this process takes differs depending on the data channel selected. A status 
display will monitor the transfer's progress.  

Result 
When the operating system update is successfully completed, a message appears. 
The HMI device no longer contains a project.  

Procedure – update operating system with Booting 
When the operating system is updated with "Booting", the configuration computer 
communicates with the boot loader of the HMI device. 
Connect the HMI device to the configuration computer. 

 

 Notice 
An operating system update with booting is only possible via a serial connection. 

 

After starting the operating system update, the HMI device must be rebooted so that the HMI 
device establishes contact via the serial interface. 
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Proceed as follows in order to adapt the operating system on the HMI device to the 
configuration software version used: 
1. Switch off the power supply to the HMI device. 
2. On the configuration computer, select the "Project ▶ Transfer ▶ Transfer Settings" menu 

command in WinCC flexible, or select the existing HMI device on the "General" tab in 
ProSave. 

3. Select the connection. 
4. Enter the connection parameters 
5. In WinCC flexible, select the "Project ▶ Transfer ▶ Update Operating System" menu 

command, or in ProSave, select the "OS Update" tab in ProSave. 
6. Select the "Boot" check box if it is cleared. 
7. In the image path, select the directory containing the image file (file extension *.img) 

belonging to the HMI device. 
8. Select the "Open" button. 

When the image file has been opened successfully, various version information appears 
in a window. 

9. Start the operating system update using the "Update OS" button. 
10. Switch on the power supply to the HMI device again. 

This starts the update. The time this process takes differs depending on the data channel 
selected. A status display will monitor the transfer's progress. 

Result 
When the operating system update is successfully completed, a message appears. 
The HMI device no longer contains a project. 

7.4.4 Transferring authorizations 

Introduction 
To protect the software, licenses (authorizations) on an Authorization disk can be transferred 
to and transferred back from the HMI device. 
The authorization disk is supplied with the respective option, with ProAgent/MP for example, 
with ProAgent/MP for example. 

Requirements 
• The HMI device is connected to the configuration computer according to the selected 

connection type. 
• WinCC flexible or ProSave is installed on the configuration computer. 
• Insert the Authorization disk containing the licenses to be transferred in the disk drive of 

the configuration computer. 
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The ProSave Service Tool can be used to transfer authorizations. An advantage of this is 
that the authorization can be transferred without calling in WinCC flexible. 
There are two methods of transferring an authorization: 
• Transferring an authorization using stand-alone ProSave 
• Transferring an authorization using WinCC flexible 

If an authorization transfer should be performed using WinCC flexible, all the general 
settings, such as HMI device and transfer settings, are assumed from the project. 

Procedure - transferring an authorization to the HMI device 
Transferring an authorization to the HMI device 
1. Start WinCC flexible from the Windows Start menu on the configuration computer and 

open a project, or start ProSave from the Windows Start menu. 
2. When using WinCC flexible, select the "Project ▶ Transfer ▶ Transfer Settings" menu 

command or, using ProSave, select the existing HMI device on the "General" tab. 
3. Select the connection. 
4. Enter the connection parameters 
5. Select the menu command "Project ▶ Transfer ▶ Authorizations" in WinCC flexible or 

select the "Authorize" tab in ProSave. 
6. Select the authorization to be transferred to the HMI device from the "Choices" options. 
7. Configure the required transfer channel on the HMI device. 
8. Switch the HMI device to transfer mode. 
9. Press the ">>" button to start transferring the authorization onto the configuration 

computer. 

Result 
The authorization is transferred to the HMI device. The option as to which authorization is 
required can now be defined on the HMI device. 

Procedure - transferring authorization back from the HMI device 
Transferring an option back from the HMI device: 
1. Start WinCC flexible from the Windows Start menu on the configuration computer and 

open a project, or start ProSave from the Windows Start menu. 
2. When using WinCC flexible, select the "Project ▶ Transfer ▶ Transfer Settings" menu 

command or, using ProSave, select the existing HMI device on the "General" tab. 
3. Select the connection. 
4. Enter the connection parameters 
5. Select the menu command "Project ▶ Transfer ▶ Authorizations" in WinCC flexible or 

select the "Authorize" tab in ProSave. 
6. Configure the required transfer channel on the HMI device. 
7. Switch the HMI device to transfer mode. 
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8. Press the "Device Status" button on the configuration computer to display all the 
authorizations currently installed on the HMI device. 

9. Select the authorizations under "Installed Authorizations" to be transferred from the HMI 
device. 

10. Press the "<<" button to start transferring the authorizations back. 

Result 
The authorization is transferred back from the HMI device. The option as to which 
authorization is required can no longer be used on the HMI device. 

7.4.5 Transferring options 

Introduction 
Options specially developed for the HMI device, e.g. additional applications, can be installed 
on the HMI device.  
ProSave is supplied with the following options by default: 
• Drivers for uninterruptible power supply 
• Pocket Internet Explorer 

Requirements 
• The HMI device is connected to the configuration computer according to the selected 

connection type. 
• WinCC flexible or ProSave is installed on the configuration computer. 
The ProSave Service Tool can be used to transfer authorizations. An advantage of this is 
that the option can be transferred without calling in WinCC flexible.  
There are two methods of transferring an option: 
• Transferring an option using stand-alone ProSave 
• Transferring an option using WinCC flexible 

If an option transfer should be performed using WinCC flexible, all the general settings, 
such as HMI device and transfer settings, are assumed from the project. 

Procedure - transferring an option to the HMI device 
Transferring an option to the HMI device 
1. Start WinCC flexible via the Windows Start menu and open a project, or start ProSave via 

the Windows Start menu. 
2. When using WinCC flexible, select the "Project ▶ Transfer ▶ Transfer Settings" menu 

command or, using ProSave, select the existing HMI device on the "General" tab. 
3. Select the connection. 
4. Enter the connection parameters 
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5. Select the menu command "Project ▶ Transfer ▶ Options" in WinCC flexible or select the 
"Options" tab in ProSave. 

6. Select the options to be transferred to the HMI device from "Available options". 
7. Configure the required transfer channel on the HMI device. 
8. Switch the HMI device to transfer mode. 
9. Press the ">>" button to start transferring the option. 

Result 
The option is transferred to the HMI device.  

Procedure - transferring authorization back from the HMI device 
Transferring an option back from the HMI device: 
1. Start WinCC flexible from the Windows Start menu on the configuration computer and 

open a project, or start ProSave from the Windows Start menu. 
2. When using WinCC flexible, select the "Project ▶ Transfer ▶ Transfer Settings" menu 

command or, using ProSave, select the existing HMI device on the "General" tab. 
3. Select the connection. 
4. Enter the connection parameters 
5. Select the menu command "Project ▶ Transfer ▶ Options" in WinCC flexible or select the 

"Options" tab in ProSave. 
6. Configure the required transfer channel on the HMI device. 
7. Switch the HMI device to transfer mode. 
8. Press the "Device Status" button on the configuration computer to display all the options 

currently installed on the HMI device. 
9. Select the options under "Installed Options" to be transferred back from the HMI device 
10. Press the "<<" button to start transferring the options back. 

Result 
The option is transferred back from the HMI device.  
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Runtime functionalities of a project 8
8.1 Screen objects 

Overview 
Runtime offers the following objects for operator control and display:  
• Button 
• Switch 
• I/O field 
• Graphic I/O field 
• Symbolic I/O field 
• Alarm indicator 
• Alarm view 
• Alarm window 
• Recipe view 
• Bar 
• Trend view 
• Slider control 
• Gauge 
• Date / time field 
• Clock 
• User view 
• Status force 
• Sm@rtClient view 
• Symbol library 
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8.2 Alarms 

Alarm classes 
Alarms indicate events and states in the control process on the HMI. WinCC flexible 
distinguishes the following alarm classes:  
• Operation 

Warning alarms indicate a process status, e.g. motor is ON. Warning messages are 
configured.  

• Error 
Error alarms indicate operational errors such as excess motor temperature. Alarm 
messages are configured. These are high-priority messages and must therefore be 
acknowledged.  

• System 
System alarms are triggered by the HMI device. They are not configured. System alarms 
provide information on operator errors or communication faults, for example.  

• STEP 7 alarm classes 
The alarm classes configured in STEP 7 are also available for the HMI device.  

• Custom alarm classes 
It is possible to configure further alarm classes.  

Alarm buffer  
All incoming, outgoing and acknowledged alarm events are logged to an internal volatile 
buffer memory. The size of this alarm buffer depends on the type of HMI device.  

Alarm protocol  
When alarm logging is activated, alarm events are printed out directly on the printer.  
It is possible to individually configure each alarm to specify whether it is to be reported (sent 
to the printer). 

Alarm log 
Alarm events are stored in an alarm log, provided this log file is configured. The capacity of 
the log file is limited by the storage medium and system limits.  

Alarm view 
Events stored in the alarm buffer and the alarm log can be displayed in the alarm view in 
Runtime.  
The alarm view is used to indicate process alarm events. Whether alarm events need to be 
acknowledged or not is defined in your configuration data. 
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Alarm window 
A configured alarm window shows all queued alarms, or alarms of the relevant alarm class 
which require acknowledgement. The alarm window opens when a new alarm is received.  
You can configure the order in which the alarms are displayed. You can choose to indicate 
the alarms in ascending or descending order of their occurrence. The alarm window can also 
be set to indicate the exact location of the fault, including the date and time of the alarm 
event.  

Alarm indicator 
An alarm indicator icon is output on-screen if at least one error alarm is queued on the HMI 
device.  
The indicator flashes as long as unacknowledged alarms are pending. The displayed 
number indicates the number of pending alarms.  

8.3 Tags 

Definition 
Tags represent defined memory areas on the HMI device, to which values are written and/or 
from which values are read. This action can be initiated on the controller, or by the operator 
at the HMI device.  

8.4 Logs 

Overview 
Alarm events and process values can be saved to log files.  
Examples of alarm events are the incoming, acknowledged and outgoing events occurring 
with an alarm message.  
Process value logging is used for the following purposes, for example:  
• Early detection of danger / fault states 
• Increase of productivity 
• Enhancement of product quality 
• Optimization of maintenance cycles 
• Documentation of processes 
• Quality assurance 



Runtime functionalities of a project  
8.4 Logs 

 MP 370 (WinCC flexible) 
8-4 Operating Instructions, Edition 03/2004, 6AV6691-1DE01-0AB0 

Memory options 
Depending on the configuration, the logs are written to a file or stored in a database set up 
for this purpose.  
• Logging to a CSV file 

The project engineer must have specified a folder path for storing the CSV file containing 
your logged data. This references the storage location.  
CSV format table columns are separated by separators, the table rows are terminated by 
a line break character. This allows you to evaluate or edit your log data using an external 
text editor or spreadsheet program, for example.  

• Logging to a database 
By storing your log files in a database, you can utilize the full database functionality for 
further processing and analysis of the logged data.  
Databases tested and released for WinCC flexible:  
� MS Data Engine 97 and MS Data Engine 2000 
� MS Access 97 and MS Access 2000 
� MS SQL Server 7.0 and MS SQL Server 2000 

Logging methods used in WinCC flexible Runtime:  
• Circular log 
• Segmented circular log 
• Log with level-dependent system alarm 
• Log file with data volume-based system alarm 

Alarm logs 
Alarms in the project indicate fault states and operating states of a process. They are 
generally triggered by the controller. Alarms can be output to the HMI in the form of images. 
WinCC flexible lets you log alarms and document operational states and error states of the 
plant.  
The following data are logged to the file: 
• Date and time of alarm 
• Alarm number 
• Alarm tags (up to 8) 
• Alarm status 
• Alarm text (optional) 
• Fault location (optional) 
All alarms are assigned to a specific alarm class. All alarm classes can be logged.  
Alarms can be logged either automatically, or by operator intervention.  
The contents of log files can be output to the HMI, if a corresponding alarm view has been 
configured.  
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Data logs 
In Runtime, the process values are logged, processed and, depending on the project, written 
either to files or to the log database.  
Data logging is controlled by means of cyclic operations and events. Logging cycles are 
used to ensure continuous acquisition and storage of the data. In addition, data logging can 
also be triggered by events, e.g. when a value changes.  

8.5 Reports 

Overview 
Logs are used to document process data and completed production cycles. The log content 
and layout are specified in the project, as is the event triggering the printout of the report.  
For example, a log can be configured for output at the end of a shift, in order to record 
downtimes. A log can also be configured for the purpose of the documentation of product 
testing or quality inspections (ISO 9000).  

Edition 
Reports are printed in Runtime either automatically, e.g. by means of a scheduler, or 
manually, e.g. by means of a softkey.  

Printing reports 
Reports are output to the printer in graphic mode. The use of a serial printer is not 
recommended because of the accumulated data volume.  
For proper output, the printer must support the paper format and page layout of the report.  

 

 Note 
The value of a tag in the report is read and output at the moment of printing. A substantial 
time may elapse between printing out the first and the last page of a report consisting of 
several pages. This may lead to the same tag on the last page being output with a different 
value from that on the first page.  
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8.6 System functions and scripts 

Application 
System functions and scripts are used in Runtime for the following purposes:  
• To control the process 
• To utilize the properties of the HMI device 
• To make system settings on the HMI device online 
In WinCC flexible, each system function and each script s linked to an object, such as a 
button, field or screen, and an event. As soon as the event occurs, the system function is 
triggered.  

System functions 
System functions are predefined functions that are used to implement many tasks in 
Runtime, such as:  
• Calculations, e.g. increase of a tag value by a specific or variable amount 
• Logging function, such as starting a process value log 
• Settings, such as changing the PLC or setting a bit in the PLC. 
• Alarms, for instance after logon of a different user. 

Scripts 
Scripts may also be included in the project for specific applications which may require 
additional functions. For the creation of scripts, WinCC flexible provides an interface to 
Microsoft Visual Basic Script (VBScript). This allows you to integrate additional functions, 
such as:  
• Conversion of values, e.g. between different physical units (temperatures) 
• Automation of production sequences 

A script can control a production sequence by transferring production data to a PLC. The 
status can be checked based on the returned values, and appropriate measures can thus 
be initiated.  

Events 
The object and the selected function determine what events can be defined as triggers for 
executing a system function.  
For example, the events "Change value", "BelowLowerLimit" and "AboveUpperLimit" belong 
to the "Tag" object. The "Loaded" and "Cleared" events are associated with the "Screen" 
object.  
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8.7 Safety 

Overview 
Operation in Runtime is protected by the use of user groups, passwords and log-off times.  
After you started Runtime, type in the user name and password in the login dialog. 

 

User groups 
The security concept of WinCC flexible is organized in several layers: It is based on 
authorizations, user groups, and users.  
• User groups are created for specific projects by the project engineer. The 

"Administrators" group is included in all projects by default. User groups are assigned 
authorizations. The authorization level required for an operation is specifically defined for 
each individual object and function in the project. 

• User accounts are created by the project engineer, or in Runtime by the administrator, or 
by a user with the same rights, and are always assigned to one group only. 

Users belonging to a user group with "Administration" authorization may create further user 
accounts and assign these to a group.  

Passwords 
Only registered users may log in to Runtime by entering their user name and password. The 
passwords can be assigned by the configuring engineer, by the "Admin" user (or by users 
who have "Administration" authorization), or by the user himself.  
Which functions a user may execute after login depends on which user group he/she is 
assigned to.  
After the project is transferred, only the administrator is authorized to create user accounts, 
make user group assignments, and change passwords. Any further users assigned to the 
"Administrator" group by the administrator may also carry out these tasks. 
The list will be encrypted and saved on the HMI device to protect it from loss due to a power 
failure.  

 

 Note 
Depending on the transfer settings, changes to the password list are overwritten when the 
project is transferred again. 



Runtime functionalities of a project  
8.8 Other operating functions 

 MP 370 (WinCC flexible) 
8-8 Operating Instructions, Edition 03/2004, 6AV6691-1DE01-0AB0 

Log-off times 
A log-off time is specified in the system for each user. If the time between any two user 
actions, e.g, entering a value or pressing a key, exceeds this logoff time, the user is 
automatically logged off. The user must then log on again to continue to operate Runtime.  

User view 
Use the User view to display the users present on the HMI device. 

 

Export and import 
All users, passwords, group assignments and logoff times furnished on the HMI device can 
be exported and reimported on another HMI device, when the configuration is suitable. This 
helps to you avoid having to enter all of the data again on another HMI device.  

 

 Notice 
The currently valid passwords are overwritten during an import. The imported passwords are 
valid immediately. 

8.8 Other operating functions 

Print functions 
Print functions available in online mode: : 
• Hardcopy 

You can print the content of the currently displayed screen using the "Print screen" 
system function in your configuration.  

• Alarm protocol 
All alarm events (incoming, outgoing, acknowledgment) are also output to a printer.  

• Printing reports 
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  Note 
Special, non-European characters 
When printing alarms in languages other than Western European languages, some 
characters are not printed correctly under certain circumstances. The print result is 
dependent on the printer used. 

 

  Note 
Printing via a network printer 
Printing alarms on a network printer is not approved for Windows CE HMI devices. All 
other functions have no restrictions, even over the network. 

LED control 
The light-emitting diodes (LED) in the function keys of the SIMATIC HMI devices can be 
controlled from the PLC. A lit or flashing LED may signal, for example, the operator to press 
a specific function key on the device.  
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Operating a project 9
9.1 Basic principles of operation 

9.1.1 Basics for operation in Runtime 

Introduction 
The process control features are defined by the project configuration and the options 
available on the HMI device. This section contains general information on the settings for 
Runtime and for operation of predefined screen objects.  
Screen objects provide general system functions. Screen objects can be used and 
configured in screens in the project.  
Runtime can be controlled with the keys, using the touch screen, or via the keyboard and 
mouse, depending on the HMI device used.  

Multiple key operation 
Unintentional actions can be triggered by a multiple key operation.  
• When you use a key device, you may not press more than two function keys 

simultaneously. 
• If you are using a touch screen device, you may only operate one touch object at a time. 

Language switching  
WinCC flexible allows a multilingual project configuration. Up to five of these project 
languages can be loaded on the HMI device simultaneously.  
Runtime allows you to change the languages, provided this function is configured. 
Language-specific objects such as texts or formats are localized. The following objects may 
contain language-relevant texts, for example:  
• Alarms 
• Screens 
• Text lists 
• Help texts 
• Recipes 
• Date/time 
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• Static texts 

Objects in the template screen 
Objects that should be available on each screen are configured in the template by the 
configuring engineer, e.g., important process values or date and time.  
An operating element that is present in the template is available in every screen. In the case 
of touch screen devices, for example, a button in the template screen simulates a globally 
effective function key.  

Pictograms  
In the case of keyboard devices, pictograms can be configured along the bottom and sides 
of the screen.  
Pictograms highlight the screen-specific functions of the function keys. Activating the 
associated function key initiates the function symbolized by the pictogram.  

9.1.2 Operating the touch panel (TP) 

9.1.2.1 Operating touch objects 

Operation 
Touch objects are touch-sensitive operating objects on the HMI screen, e.g. buttons, I/O 
fields and alarm windows. The operation of these is basically no different than the operation 
of conventional keys. You operate these objects by touching them with the finger.  

 

 
Caution 
Always touch only one object on the screen. Do not touch several touch objects 
simultaneously. You may trigger an unintended action. 

 

 Caution 
Do not use any pointed or sharp objects when operating the touch screen in order to avoid 
damaging the plastic surface. 

Direct keys 
With a PROFIBUS DP connection, it is also possible to configure buttons for operation as 
direct keys in order to allow rapid operator inputs using keys. Rapid button operation is 
conditional for jog mode, for example.  
PROFIBUS-DP direct keys place bits directly from the HMI device in the I/O area of a 
SIMATIC S7.  
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 Note 
Direct keys can only be triggered by touch and not by a mouse click from an connected 
external USB mouse. 

 

 Note 
With touch operation, direct keys are triggered independent of any configured password 
protection. 

 

 Notice 
Direct keys are still active when the HMI device is in the "offline" mode. 

Button action feedback 
The HMI device outputs an acoustic and optical signal as soon as it detects the operation of 
a touch object. This feedback is always output, irrespective of communication with the PLC. 
Therefore, this feedback does not indicate whether the relevant action is actually executed or 
not.  

Acoustic acknowledgement 
The HMI device outputs a beep to signal operation of a touch object. You can disable this 
beep.  

Visual feedback 
The type of visual feedback depends on the operated touch object:  
• Buttons 

The HMI outputs different indications of the "Touched" and "Not touched" states, provided 
the programmer has configured a 3D effect: 

UntouchedTouched  
The programmer defines the layout of a selected field (line width and color of the focus.)  

• Hidden buttons 
The focus of hidden buttons is not set after marking (focus width value is 0, default.) In 
Runtime, the outline of a touched button is indicated as a line when you modify the focus 
with value in the configuration data. This outline remains visible until the focus is set on 
another operating object.  

• I/O fields 
After you touch an I/O field, a screen keyboard appears as a feedback signal. 
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Operating screen objects with buttons 
Screen objects with predefined buttons can also be operated with external buttons. The 
requires the programmer to have linked the relevant system functions to these buttons.  
In WinCC flexible, these system functions are organized in the "Keyboard actions for screen 
objects" group.  

See also 
Volume & Sounds (Page 6-17) 

9.1.2.2 Input of values 

Screen keyboard 
The HMI device automatically opens the screen keyboard when you touch an input object 
such as an I/O field. This screen keyboard also appears for the input of passwords for 
access to protected functions. The HMI automatically hides the keyboard again when input is 
complete.  
Based on the configuration of the input object, the HMI device shows a screen keyboard only 
for the input of numeric or alphanumeric values. 
The screen keyboard is activated by selecting an input object in runtime. 

See also 
Open Control Panel (Page 6-2) 
Operation with external keyboard/mouse (Page 5-9) 
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9.1.2.3 Input of numeric values 

Numeric screen keyboard 
The HMI device automatically opens the numeric screen keyboard for the input of numeric 
values when you touch an I/O field on the screen. The HMI automatically hides the keyboard 
again when input is complete.  
The <Help> button is only active if an operator note is configured for the I/O field.  

 
Figure 9-1 Screen keyboard for numeric input 

Procedure 
You enter the characters of numeric values using the screen keyboard buttons. Confirm the 
input value with <Enter>, or cancel it with <Esc>. Both functions will close the screen 
keyboard. 

 

 Note 
The numeric input fields may be assigned limits. In this case, the system accepts only the 
values which lie within the configured range. The system rejects any values which are out of 
these limits and restores the original value. In this case, the HMI outputs a system alarm. 
When you input of the first character a Quickinfo appears, showing the high and low limit 
values of the input field. 

See also 
Input of values (Page 9-4) 

9.1.2.4 Input of alphanumeric values 

Alphanumeric screen keyboard 
The HMI automatically opens an alphanumeric keyboard for the input of strings and numeric 
values in hex format when you touch an input object on the screen. The HMI automatically 
hides the keyboard again when input is complete. 
The <Help> is only active if an operator note is programmed for the input object.  
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Figure 9-2 Screen keyboard for alphanumeric input 

Keyboard layers 
The alphanumeric keyboard is organized in several layers:  
• Standard layer (see the figure) 
• <Shift> layer  
• <Alt Gr> layer 
• <Shift+Alt Gr> layer  
The <Alt Gr> and <Shift+Alt Gr> layers are used for the input of special characters. 

Procedure 
You use the screen keyboard buttons to input the characters of alphanumeric values. 
Confirm the input value with <Enter>, or cancel it with <Esc>. Both functions will close the 
screen keyboard. 

9.1.2.5 Calling the operator note 

Purpose 
The operator notes provide additional information and operating instructions with respect to 
alarms, screen and operable screen objects to the programmer. A operator note may contain 
information about the permissible range of values for an I/O field, or information on the 
causes of alarm events and their elimination.  

 
Figure 9-3 Operator note for an I/O field (Example) 
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Help on messages 

Actuate the  button on the alarm screen or in the alarm view 

Help on input objects 
Touch the <Help> button on the screen keyboard. This button is only available if you 
configured an operator note. 

Help on the current screen 
Call the operator note for the current screen  

Help on the focused screen object 
Use the <Alt+H> key combination on the screen keyboard or on the connected USB 
keyboard to display the operator notes configured for the focused screen object. 

 

 Note 
To view a new operator note, you first need to close the window showing the current 
operator note. 

9.1.3 Operating a keyboard device 

9.1.3.1 Functions of the system keys 

Overview of system key functions 
 

 Note 
The availability of system keys is is determined by the HMI device used.  
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Key Function Purpose 

A-Z
 

Toggling (numbers / letters) Toggles the assignment from numbers to letters. 
• No LED is lit: 

The number assignment is enabled. One actuation of the 
button toggles to letter assignment. 

• One LED is lit: 

The left or right letter assignment is enabled.  
Each time the key is pressed, the system toggles between the 
right letter assignment and number assignment. 

INS
DEL  

Deleting characters  • Deletes the character at the current cursor position. 

ESC

 

Cancel • Deletes the input characters of a value and restores the 
original value. 

• Closes the active window. 

ACK

 

Acknowledge Acknowledges the currently displayed alarm message, or all 
messages of an acknowledgement group (group 
acknowledgement.) 
The LED is lit as long as unacknowledged alarm messages 
are queued. 

HELP

 

Viewing the operator note Opens the configured operator note for the selected object 
(e.g. a message, I/O field.) The LED signals an that an 
operator note exists for the selected object. 

ENTER

 

Enter • Applies and closes the input 
• Opens a drop-down list for symbolic I/O fields 
• Triggers buttons 

TAB

 

Tabulator Selects the next available screen object in the configured tab 
sequence. 

 

Deleting characters Deletes the character to the left of the current cursor position. 

 

 

Moving the cursor • Selects the next operable screen object on the right or left, 
above or below of the current screen object. 

• Navigates in the screen object. 

HOME  

Scrolling back Scrolls one page down 

END  

Scrolling up Scrolls one page up. 

SHIFT

 

Shift 
(upper/lower case) 

Use in key combinations, e.g. for switching to uppercase 
letters. 
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Key Function Purpose 

FN  

Shift (special character) Use in key combinations for the input of special characters. 
Some of the keys contain a blue special character on their 
bottom left corner, e.g. the "%" character. In order to input 
these characters, press the relevant key in combination with 
the special character key shown on the left. 

CTRL
 

General control functions Used in key combinations for navigating through trend views, 
for example. 

ALT
 

General control functions Used in key combinations, for example, for the "Status force" 
screen object. 

9.1.3.2 Functions of the key combinations 

General operation 

Navigation 
 
Shortcut keys Function 

SHIFT  + TAB  
Selects the previous available screen object in the 
configured tab sequence. 

SHIFT  +  

SHIFT  +  

SHIFT  +  

SHIFT  +  

Positions the cursor within a screen object, for example, in 
an I/O field.  

FN  + HOME  

Jumps to the start of the selection list. 

FN  + END  
Jumps to the end of a selection list. 

SHIFT  + FN  + HOME  
Selects a group of entries between the current position and 
the top of the list, for example. 

SHIFT  + FN  + END  
Selects a group of entries between the current position and 
the end of the list, for example. 

ALT  +  
Opens a selection list. 
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Monitor screen settings 
 
Shortcut keys Function 

A-Z  +  
Increases the brightness of the monitor screen. 

A-Z  +  
Reduces the brightness of the monitor screen. 

In the startup phase 
 
Shortcut keys Function 

ESC

 +  

Toggles the HMI to "transfer" mode. 
You can always exit transfer mode, provided the unit is 
currently not transferring any data. 

Further functions (e.g. in the Explorer) 
 
Shortcut keys Function 

CTRL  + ENTER  
Accepts the selected entry without closing the list. 

CTRL  + TAB  
• Toggles the active window. 
• Toggles between the base area and the window. 

CTRL  + 
BA

 
Selects all (left letter assignment is active.) 

ALT
 + 

ENTER

 

Shows the properties of a selected element. 

Navigating in the operating system 

General 
 
Shortcut keys Function 

CTRL  + ESC  
Opens the Windows CE Start menu. 

ALT  + TAB  
Opens the task manager. 
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Explorer 
 
Shortcut keys Function 

 

Changes to the parent level. 

TAB  
Toggles the display range. 

ALT  
Activates the menubar. 

Dialogs 
 
Shortcut keys Function 

TAB  
Jumps to the next field. 

SHIFT  + TAB  
Jumps to the previous field. 

 
Opens the next tab, if the focus is set on the name of this 
tab.  

 
Opens the previous tab, if the focus is set on the name of 
this tab. 

ESC  
Closes the dialog without saving. 

Operating screen objects with function keys 
You may also operate screen objects with buttons, e.g. the alarm view, trend view, recipe 
view or status force using function keys. The condition is here, that the programmer has 
linked the corresponding system functions to the function keys.  
In WinCC flexible, these functions are organized in the "Keyboard actions for screen objects" 
group.  

9.1.3.3 Calling the operator note 

Purpose 
The operator notes provide additional information and operating instructions with respect to 
alarms, screen and operable screen objects to the programmer. An operator note may 
contain information about the permissible range of values for an I/O field (refer to figure 
below) or, in the case of an alarm, information on the causes of an alarm event and its 
elimination.  
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Figure 9-4 Operator note for an I/O field (Example) 

Procedure 
To call the operator note configured for an I/O field, for example:  

1. Select the I/O field, e.g. . 

The I/O field is selected. The LED signal of the HELP  key indicates that an operator note is 
available. 

2. Press HELP  to call the operator note. 
The operator note is shown in the language currently set on the HMI. Any operator note 
configured for the current screen is shown when you press the key again. 

3. Close the Help window with the ESC  key or by pressing the HELP  key again. 
 

  Note 
To view a new operator note, you first need to close the window showing the current 
operator note. 

See also 
Set language (Page 7-12) 
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9.2 Controlling graphic objects 

9.2.1 Button 

9.2.1.1 Description 

Purpose 
A button is a virtual key on the screen of the HMI device that can have one or more 
functions.  

 
You can initiate separate, independent functions with the following button operations:  
• Click 
• Press 
• Release 
• Activate the button in the tab sequence 
• Deactivate the button in the tab sequence 
• Change 

Layout 
A button can be labeled, use a graphic symbol or be hidden. 
The operation may be followed with a visual feedback. However, note that the optical 
feedback only indicates a completed operation and not whether the configured functions 
were actually executed. 

9.2.1.2 Touch control 

Procedure 
Touch the button on the touch screen of the HMI device.  

9.2.1.3 Keyboard control 

Procedure 
To operate a button with a keyboard: 
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• Use the cursor to select the button, e.g.  

• Then press ENTER  or . 

9.2.1.4 Mouse and keyboard control 

Procedure 

Mouse 
Click on the button with the mouse pointer.  

Keyboard 
Select the button with <Tab> according to the configured tab sequence, then press <Return> 
or <Space>. 

9.2.2 Switch 

9.2.2.1 Description 

Purpose 
The switch is an control object and display object with two states: "pressed" and "released." 
Switches can signal the state of a system component that cannot be seen from the HMI 
device, e.g. a motor. You can also change the status of that system components at the HMI 
device.  

 
A switch has two stable states: When you actuate the switch, it changes to the other state. 
The switch retains this status until the next operation.  

Layout 
A switch can be labeled with a descriptive name, e.g. "Motor 2" and/or the names of its two 
states, e.g. "ON" and "OFF". The switch can be positioned vertically or horizontally.  
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9.2.2.2 Touch control 

Procedure 
Touch operation of a switch differs depending on the switch type:  
• If a slider is displayed for the switch: 

Move the slider on the touch screen of the HMI device to the new position, or double-click 
the slider area.  

• If only a text or a graphic is displayed for the switch: 
Touch the switch on the touch screen of the HMI device. 

9.2.2.3 Keyboard control 

Procedure 
To operate a switch with a keyboard: 

• Select the switch with a cursor key, e.g.  

• Then press ENTER  or . 

9.2.2.4 Mouse and keyboard control 

Procedure 

Mouse 
The operation depends on the type of switch: 
• "Switch with text", "Switch with graphic": Click the switch 
• Switch with slider: Click on the slider and move the slider to the other position. 

Keyboard 
Select the switch with <Tab> according to the configured tab sequence, then press <Return> 
or <Space> 
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9.2.3 I/O field 

9.2.3.1 Description 

Purpose 
You enter numeric or alphanumeric values in an I/O field. An example of a numerical value is 
the number 80 as setpoint for a temperature. An alphanumeric value is the text "Service" as 
user name.  

 

Layout 
The layout of an I/O field depends on its configuration in WinCC flexible, e.g.:  
• Numeric I/O field 

For input of numbers in decimal, hexadecimal or binary format.  
• Alphanumeric I/O field 

For input of character chains 
• I/O field for date and time 

For input of calendar dates or time information. The format depends on the language set 
on the HMI device.  

• I/O field for password input 
For concealed input of a password. The input character string is displayed with 
placeholders (*).  

Behavior 
If limit values are configured for the tag that is linked to the I/O field, the input value is only 
applied if the value is within the configured limits.  
Any input values which are out of range are rejected. The original value is displayed on the 
I/O field instead, and a system alarm is output on the HMI device.  

9.2.3.2 Touch control 

Procedure 
Press the I/O field on the touch screen of the HMI device. The screen keyboard 
automatically appears. Enter the desired value using the screen keyboard. Confirm your 
input with <Enter> or cancel it with <Esc>. After the input has been confirmed or canceled, 
the screen keyboard is automatically closed.  
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9.2.3.3 Keyboard control 

Procedure 

Enable the I/O field, for example with one or several TAB  according to the configured tab 
sequence. The selection is signaled by the colored field content. 
You now have two options:  

• Position the cursor with SHIFT  and a cursor key. The selection of the field content is 
cancelled. Type in the relevant value. 

• Press ENTER . The object changes to the specific editing mode. Now, only one character will 
be marked in the field. 

� You can use the  /  cursor keys to scroll the character table. 

� The  /  cursor keys can be used to move to the next or previous input 
position. 

Confirm your entry with ENTER  or cancel it with ESC .  
 

 Note 
To enter the hexadecimal characters "A" to "F" for numerical values, toggle the input keys 

using A-Z  to activate the letter assignment.  

9.2.3.4 Operation with mouse and keyboard 

Procedure 

Mouse 
Click in the I/O field with the mouse pointer. Type in the relevant value. Confirm your input on 
the HMI with <Return> or cancel it with <Esc>.  

Keyboard 
Select the I/O field with <Tab> according to the configured tab sequence, for example. The 
contents of the I/O field change color to show that it is now activated. You now have two 
options:  
• Type in the relevant value. 
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• Press <Return>. The object changes to the specific editing mode. Now, only one 
character will be marked in the field. 
� Use the <Up>/<Down> cursor keys to scroll through a character table. 
� Use the <Right>/<Left> cursor keys to move the cursor to the next or previous input 

position. 
Confirm your input on the HMI with <Return> or cancel it with <Esc>. 

9.2.4 Graphic I/O field 

9.2.4.1 Description 

Purpose 
In a graphic I/O field, select a predefined image from a selection list. The graphic represents 
the value of a tag. This can be an internal tag or a tag with a connection to a PLC.  
The graphic I/O field can also be used merely to output a pure graphic depending on the 
value of a tag. In this case, you cannot then operate the graphic I/O field. 

Layout 
If the graphic I/O field shows a cactus icon, you have not defined the graphic output of a 
specific value in your project.  

 

9.2.4.2 Touch control 

Procedure 
Touch the graphic I/O field on the touch screen of the HMI device. Selection mode is 
activated.  
Select the desired graphic using the scroll bar.  
Apply the required graphic by touching it, or reject the selection by touching another screen 
object.  
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9.2.4.3 Keyboard control 

Procedure 
Operating a graphic I/O field on a keyboard device:  

 
Step Procedure 
1 Select the graphic I/O field 

e.g.  
The graphic I/O field is marked. 

2 Activate selection mode 
ENTER

The selection mode is activated. 

3 Select the entry 
 

 

Moves the cursor by lines. 

Accept the selection  
or 

ENTER  
The selected entry is now valid. 
The selection mode is closed. 

4 

Cancel the selection 
ESC  

The function restores the original 
value. 

9.2.4.4 Mouse and keyboard control 

Procedure 

Mouse 
Click on the graphic I/O field with the mouse pointer. The predefined images are displayed in 
the selection list.  
If the selection list has a scroll bar: Click on the scroll bar with the mouse pointer. Move the 
scroll bar in the desired direction while holding down the mouse button.  
Select the image and apply the corresponding tag value by clicking the entry. The selection 
list is closed and the entry is displayed. The graphic I/O field remains active.  

Keyboard 
Select the graphic I/O field with <Tab> according to the configured tab sequence, for 
example. The contents of the graphic I/O field change color to show that it is now activated.  
You can control the graphic I/O field with the following keys: 

 
Key Function 
<Return> Opens the selection list 

Confirms input. The selection list is closed. The graphic I/O field continues 
to have the focus.  

<Down> or <Right> Selects the next entry  
 



Operating a project  
9.2 Controlling graphic objects 

 MP 370 (WinCC flexible) 
9-20 Operating Instructions, Edition 03/2004, 6AV6691-1DE01-0AB0 

Key Function 
<Up> or <Left> Selects the previous entry 
<Esc> or <Tab> Discards the entry and displays the original value in the form of the 

corresponding graphic. 

9.2.5 Symbolic I/O field 

9.2.5.1 Description 

Purpose 
In a symbolic I/O field select a predefined entry from a selection list. The entry represents the 
value of a tag. This can be an internal tag or a tag with a connection to a PLC.  

 
The symbolic I/O field can also be used to merely output an entry depending on the value of 
a tag. In this case, the symbolic I/O field can no longer be operated. 
The display options of the symbolic I/O fields depend on the WinCC flexible edition.  

Layout 
If the symbolic I/O field contains a blank text line in the drop-down list, you have not defined 
a relevant entry in the project.  

9.2.5.2 Touch control 

Procedure 
Touch the symbolic I/O field on the touch screen of the HMI device. The predefined entries 
are displayed in the selection list.  
If the selection list has a scroll bar: Touch the scroll bar on the touch screen of the HMI 
device. Touch the touch screen continuously to move the scroll bar in the desired direction.  
Select the desired entry and apply the associated tag value by touching the entry on the 
touch screen. The selection list is closed and the entry is displayed. The symbolic I/O field 
continues to have the focus.  
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9.2.5.3 Keyboard control 

Procedure 
To operate a symbolic I/O field with a keyboard: 

 
Step Procedure 
1 Select the symbolic I/O field 

e.g.  
The symbolic I/O field is marked. 

2 Opens the selection list 
ENTER

The drop-down list opens. 

3 Select the entry 
 

 

Moves the cursor by lines. 

Accept the selection  
Or 

ENTER  
The selected entry is now valid. 
The drop-down list is closed. 

4 

Cancel the selection 
ESC  

The function restores the original 
value. The drop-down list is 
closed. 

9.2.5.4 Mouse and keyboard control 

Procedure 

Mouse 
Click on the symbolic I/O field with the mouse pointer. The predefined entries are displayed 
in the selection list.  
If the selection list has a scroll bar: Click on the scroll bar with the mouse pointer. Move the 
scroll bar in the desired direction while holding down the mouse button.  
Select the entry, then apply the corresponding tag value by clicking the entry. The selection 
list is closed and the entry is displayed. The symbolic I/O field continues to have the focus.  

Keyboard 
Activate the symbolic I/O field by pressing the <Tab> key one or more times, corresponding 
to the configured tab order. The contents of the symbolic I/O field change color to show that 
it is now activated.  
You can control the symbolic I/O field with the following keys: 

 
Key Function 
<Enter> Opens the selection list 

Confirms input. The selection list is closed. The symbolic I/O field continues 
to have the focus.  
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Key Function 
<Down> or <Right> Selects the next entry  
<Up> or <Left> Selects the previous entry 
<Esc> or <Tab> Discards the entry and displays the original value in the form of the 

corresponding graphic. 

9.2.6 Alarm indicator 

9.2.6.1 Description 

Purpose 
The alarm indicator is a configurable graphic icon that is displayed on the screen as long as 
at least one alarm belonging to the specified alarm classes is pending on the HMI device.  

 

Behavior 
The alarm indicator flashes as long as unacknowledged alarms are pending. The displayed 
number indicates the number of pending alarms.  

 

 Note 
The icons from the symbol library can only be operated with a mouse or touch screen. 

 

9.2.6.2 Touch control 

Procedure 
Touch the alarm indicator. An alarm window opens depending on the configuration.  
Use the Close icon to close the Alarm window and be able to operate the screens. The alarm 
window can be opened again by touching the alarm indicator.  
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9.2.6.3 Mouse control 

Procedure 
Click on the alarm indicator with the mouse pointer. An alarm window opens depending on 
the configuration.  
Use the Close icon to close the Alarm window and be able to operate the screens. The alarm 
window can be opened again by clicking on the alarm indicator.  

9.2.7 Alarm view 

9.2.7.1 Description 

Purpose 
The Alarm view shows alarms or alarm events selected by the planner from the alarm buffer 
or, if supported by the HMI device, from the alarm log.  

 

Layout 
To be able to distinguish between different alarms classes, they are identified in the first 
column of the Alarm view:  

 
Icon Alarm class 
! Error 
(empty) Operation 
(depending on configuration) Custom alarm classes 
$ System 

In Runtime you can configure the column order and the sorting order of each column. 
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Operator controls 
The buttons have the following functions:  

 
Button Function 

 
Use this button to call the configured operator note for the selected alarm.  

 
This button triggers the function assigned to the "Edit" event for the selected 
alarm. 

 
This button is used to acknowledge an unacknowledged alarm. 

 

9.2.7.2 Touch control 

Procedure 
Touch the desired operating element in the Alarm view on the touch screen of the HMI 
device. 

Changing column sequence and sorting sequence 
In Runtime you can configure the column order and the sorting order of each column. 
• Change column sequence 

To reverse the "Time" and "Date" columns, for example, touch the "Date" header on the 
HMI device touchscreen. Continue to press the touchscreen and drag the column 
heading to the "Time" heading.  

• Change sorting order 
To change the chronological order of the alarms, touch the column heading, "Time" or 
"Date" on the HMI device's touchscreen. 

9.2.7.3 Keyboard control 

Procedure 
There is also a tab order in the alarm view for the list showing displayed alarms and all 
configured buttons. 
Proceed as follows to acknowledge an alarm using the keys. 

1. Activate the alarm view using TAB , according to the tab order. 

2. Select the alarm to be acknowledged. The HOME , END ,  and  keys can be used 
for this. 
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3. Press and hold the TAB  key until the button to be acknowledged is selected. 

4. Press the ENTER  key. 

9.2.7.4 Mouse and keyboard control 

Procedure 

Mouse 
Click on the desired control object or list entry. 

Changing column sequence and sorting sequence 
In Runtime you can configure the column order and the sorting order of each column. 
• Change column sequence 

For example, to reverse the "Time" and "Date" columns, drag the "Date" header to the 
"Time" header with the mouse.  

• Change sorting order 
To change the chronological sorting order of the alarms, click on the header of one of the 
two "Time" or "Date" columns. 

Keyboard 
There is also a tab sequence also for the list with displayed alarms and all configured 
buttons within the alarm display. 
For example, do the following to acknowledge an alarm using the keyboard. 
1. Activate the screen display, for example with <Tab> according to the tab sequence. 
2. Select the alarm to be acknowledged. You can use the keys <Home>, <End>, <Page 

Up>, <Page Down>, <Up> and <Down> for this. 
3. Hold the <Tab> key pressed until the button to be acknowledged is selected. 
4. Press the <Return> button. 

9.2.8 Simple alarm view 

9.2.8.1 Description 

Purpose 
On an HMI device with a small display, the simple alarm view is used to display and edit 
alarms.  
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Layout 
The display of the simple alarm view depends on the configuration. 
• The display shows all current, departed or acknowledged alarms of the selected alarm 

classes. 
• The number of lines per alarm and number of visible lines are specified in the 

configuration. 
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Operator controls 
The buttons have the following functions: 

 
Button Function 

 
This button is used to acknowledge an unacknowledged alarm. 

 
This button triggers the function assigned to the "Edit" event for the selected alarm. 

 
Use this button to call the configured operator note for the selected alarm.  

 
Use this button to browse upwards alarm by alarm. 

 
Use this button to browse upwards through the alarm display page by page. 

 
Use this button to browse downwards through the alarm display page by page. 

 
Use this button to browse downwards alarm by alarm. 

 

9.2.8.2 Touch control 

Procedure 
Touch the desired control object in the alarm view on the touch screen of the HMI device. 

9.2.8.3 Keyboard control 

Procedure 
The simple alarm view also has a tab order for the list showing displayed alarms and all 
configured buttons. 
Proceed as follows to acknowledge an alarm using the keys. 

1. Activate the simple alarm view using TAB , according to the tab order. 

2. Select the alarm to be acknowledged. The HOME , END ,  and  keys can be used 
for this. 

3. Press and hold the TAB  key until the button to be acknowledged is selected. 
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4. Press the ENTER  key. 

9.2.8.4 Mouse and keyboard control 

Procedure 

Mouse 
Click the relevant button.  

Keyboard 
There is also a tab sequence also for the list with displayed alarms and all configured 
buttons within the alarm display. 
For example, do the following to acknowledge an alarm using the keyboard. 
1. Activate the screen display, for example with <Tab> according to the tab sequence. 
2. Select the alarm to be acknowledged. You can use the keys <Home>, <End>, <Page 

Up>, <Page Down>, <Up> and <Down> for this. 
3. Hold the <Tab> key pressed until the button to be acknowledged is selected. 
4. Press the <Return> button. 

9.2.9 Recipe view 

9.2.9.1 Description 

Purpose 
The recipe view is a screen object that is used in runtime to display and edit recipe records. 

Layout 
The functions of the recipe view can be configured. To use the Recipe view on small panels, 
a simple view is also available, for example.  
Different settings are also possible for whether the recipes available in the recipe view can 
only be selected or can also be changed.  

Behavior 
If you change to another screen and have not yet saved changes to the recipe data in the 
recipe view, you will be prompted to save the recipe data. The recipe name and the name of 
the recipe record are displayed to show which recipe data have not been saved yet.  
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When you change to a screen that contains a recipe view loaded with recipe data, the recipe 
data is automatically updated. 

Operator controls 
The following operator controls can be configured in the recipe view: 

 
Operator control 
element 

Function 

 

Displays the configured operator notes of the given recipe view. 

 

Creates a new recipe record in the recipe that is displayed in the specified recipe view. The recipe 
record values are preset with the values that were specified as "Default value" when the recipe was 
configured.  

 

Saves the recipe data record which is currently displayed in the recipe view. The storage location is 
determined during configuration in the properties view for the recipe.  

 

Saves the recipe record currently being displayed in the recipe view under a new name. The storage 
location is determined during configuration in the properties view for the recipe. 

 

Deletes the recipe record that is displayed in the recipe view from the data medium of the HMI device. 

 

Synchronizes the values of the recipe record that is currently displayed in the recipe view with the 
associated tags.  
During synchronization, all values of the recipe record are written to the associated tags. Then the 
values are read from the tags and used to update the values in the recipe view. 

 

Transfers the recipe record, which is currently displayed in the recipe view, to the connected PLC. 

 

Transfers the recipe record, which is currently loaded in the PLC, to the HMI device and displays it in 
the recipe view. 

 

9.2.9.2 Touch control 

Procedure 
Touch the desired operating element in the Recipe view on the touchscreen of the HMI 
device. 
Use the screen keyboard to enter values.  
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9.2.9.3 Keyboard control 

Procedure 

Activate the recipe view using TAB , according to the configured Tab order. 
The table below shows the shortcut keys used to control the recipe view: 

 
Shortcut keys Function 

CTRL  +  
Creates a new recipe record in the recipe that is displayed in the 
specified recipe view. The recipe record values are preset with the 
values that were specified as "Default value" when the recipe was 
configured.  

CTRL  + ENTER  
Saves the recipe data record which is currently displayed in the recipe 
view. The storage location is determined during configuration in the 
properties view for the recipe.  

CTRL  + *  
Saves the recipe record currently being displayed in the recipe view 
under a new name. The storage location is determined during 
configuration in the properties view for the recipe. 

CTRL  + 
INS
DEL  

Deletes the recipe record that is displayed in the recipe view from the 
data medium of the HMI device.  

CTRL  + =  
Synchronizes the values of the recipe record that is currently displayed 
in the recipe view with the associated tags.  
During synchronization, all values of the recipe record are written to the 
associated tags. Then the values are read from the tags and used to 
update the values in the recipe view. 

CTRL  +  
Transfers the recipe record, which is currently displayed in the recipe 
view, to the connected PLC. 

CTRL  +  
Transfers the recipe record, which is currently loaded in the PLC, to the 
HMI device and displays it in the recipe view. 

 

9.2.9.4 Mouse and keyboard control 

Procedure 

Mouse 
Click the desired control object or list entry.  
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Keyboard 
Activate the recipe view, for example with <Tab> according to the tab sequence. 
The table below shows the shortcut keys used to control the recipe view: 

 
Shortcut keys Function 
 <Ctrl+Space> Creates a new recipe record in the recipe that is displayed in the specified 

recipe view. The recipe record values are preset with the values that were 
specified as "Basic value" when the recipe was configured.  

 <Ctrl+Return> Saves the recipe data record which is currently displayed in the recipe view. 
The storage location is determined during configuration in the properties 
view for the recipe.  

 <Ctrl+*> Saves the recipe record currently being displayed in the recipe view under a 
new name. The storage location is determined during configuration in the 
properties view for the recipe. 

 <Ctrl+Del> Deletes the recipe record that is displayed in the recipe view from the data 
medium of the HMI device.  

 <Ctrl+=> Synchronizes the values of the recipe record that is currently displayed in 
the recipe view with the associated tags.  
During synchronization, all values of the recipe record are written to the 
associated tags. Then the values are read from the tags and used to update 
the values in the recipe view. 

 <Ctrl+Down> Transfers the recipe record, which is currently displayed in the recipe view, 
to the connected PLC. 

 <Ctrl+Up> Transfers the recipe record, which is currently loaded in the PLC, to the HMI 
device and displays it in the recipe view. 

9.2.10 Simple recipe view 

9.2.10.1 Description 

Purpose 
On an HMI device with a small display, the simple recipe view is used to display and edit 
recipes.  

Layout 
The simple recipe view consists of three areas: 
• Recipe selection 
• Recipe data record selection 
• Recipe entries 
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In the simple recipe view, each area is shown separately on the HMI device. The simple 
recipe view always begins with the recipe selection.  

Behavior 

A command option selection can be called in for each display area by pressing the  
button. The command selection lists those commands that are available in the current 
display area. Each command is assigned a number which you can use to select it directly 
from the list (without using the <Enter> key). 

Operator controls 
The buttons have the following functions: 

 
Button Function 

 

Returns to the previous selection 

 

Calls up the shortcut menu commands. 

 

9.2.10.2 Touch control 

Procedure 
Touch the desired control object or list entry in the simple recipe view on the touch screen of 
the HMI device. 

9.2.10.3 Keyboard control 

Procedure 
Each command for processing recipes and recipe records is assigned a number that is 
shown in the command selection. You can select the command directly by pressing the 
corresponding number key on the HMI device.  
The following table lists the key combinations for controlling the simple recipe view: 
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Shortcut keys Function 

 

Calls the shortcut menu commands. 

 +  

Selects the previous/next entry 

HOME  

END  

Scrolls one page up or down and selects the corresponding entry 

SHIFT  + HOME  

SHIFT  + END  

Selects the first/last entry 

ESC

 

Returns to the previous selection 

ENTER

 

Displays the recipe data records or recipe elements according to the 
selection 

 

9.2.10.4 Mouse and keyboard control 

Procedure 

Mouse 
Click the desired control object or list entry. 

Keyboard 
Each command for processing recipes and recipe records is assigned a number that is 
shown in the command selection. You can select the command directly by pressing the 
corresponding number key on the HMI device.  
The following table lists the key combinations for controlling the simple recipe view: 

 
Key Function 
<Right> Calls the shortcut menu commands. 
<Up>/<Down>: Selects the previous/next entry 
<Pg Up>/<Pg Down> Scrolls one page up or down and selects the corresponding entry 
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Key Function 
<Home>/<End> Selects the first/last entry 
<Esc> Returns to the previous selection 
<Enter> Displays the recipe data records or recipe elements according to the 

selection 

9.2.11 Bar 

Purpose 
The bar is a dynamic display object. The bar displays a value from the PLC as a rectangular 
area. The operator at the HMI device can thus see immediately how far the current value is 
from the configured limit value or whether a setpoint value has been reached. The bar can 
display values such as fill levels or batch counts.  

 

Layout 
The layout of the bar is set in the user program. In the bar, for example, lines can identify the 
configured limit values. Color changes can signal when a limit value has been exceeded or 
not been met.  

Operation 
The bar is for display only and cannot be controlled by the operator.  
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9.2.12 Trend view 

9.2.12.1 Description 

Purpose 
The trend view is a dynamic display object. The Trend view can display actual process data 
and process data from a log continuously when it is supported by the HMI device.  

 

Layout 
The layout of the trend view is based on the configuration. A trend view can show multiple 
curves simultaneously to allow the user, for example, to compare different process 
sequences. If the displayed process value exceeds or falls below the configured limit values, 
the violation of the limit can be displayed by a change of color in the curve.  
A ruler can also simplify the reading of the process values from the trend view. The ruler 
displays the Y-value that belongs to an X-value.  

Operator controls 
The trend view is operated by the configured trend display buttons. If no buttons have been 
configured for the trend view, you can operate the trend view using the keyboard or the 
function keys of the HMI device. Prerequisite is that the project engineer has configured and 
documented this type of operation.  
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Operator control 
element 

Function 

 
Scrolls back to the beginning of the trend recording. The start values of the trend recording are 
displayed there.  

 
Zooms the displayed time section 

 
Zooms out of the displayed time section 

 
Moves the ruler backward (to the left). 

 
Moves the ruler forward (to the right). 

 
Scrolls one display width backward (to the left). 

 
Scrolls one display width forward (to the right). 

 
Shows or hides the ruler. The ruler displays the X-value associated with a Y-value. 

 
Stops or continues trend recording 

 

9.2.12.2 Touch control 

Procedure 
Touch the desired control object in the trend view on the touch screen of the HMI device.  

9.2.12.3 Keyboard control 

Procedure 

Activate the trend view with TAB  using the tab order configured.  
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The table below shows the available shortcut keys:  
 

Keys Function 

CTRL
 + 

ENTER

 

Scrolls back to the beginning of the trend recording. The start values of 
the trend recording are displayed there.  

CTRL  + +
ZY

 
Zooms the displayed time section. 

CTRL  + �
RQ

 
Zooms out of the displayed time section. 

CTRL  + ALT  +  
Moves the ruler backward (to the left). 

CTRL  + ALT  +  
Moves the ruler forward (to the right). 

SHIFT  +  
Scrolls one display width backward (to the left). 

SHIFT  +  
Scrolls one display width forward (to the right). 

 

9.2.12.4 Mouse and keyboard control 

Procedure 

Mouse 
Click the desired button.  

Keyboard 
Activate the trend view with <Tab>, using the tab order configured.  
The table below shows the available shortcut keys: 

 
Key Key (Panel PC) Function 
<Ctrl+Return> <Ctrl+Return> Scrolls back to the beginning of the trend recording. The 

start values of the trend recording are displayed there.  
<Ctrl+Plus> <Ctrl+Plus> Zooms the displayed time section 
<Ctrl+Minus> <Ctrl+Minus> Zooms out of the displayed time section 
-- <Ctrl+Alt+Left> Moves the ruler backward (to the left). 
-- <Ctrl+Alt+Right> Moves the ruler forward (to the right). 
<Left> <Shift+Left> Scrolls one display width backward (to the left). 
<Right> <Shift+Right> Scrolls one display width forward (to the right). 
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9.2.13 Slider control 

9.2.13.1 Description 

Purpose 
The slider is used to transfer a numerical value to the PLC by moving the slide to the desired 
position. Each change in the position of a slider element results in the immediate change of 
the corresponding value at the associated tag. 

 
 

 

 Note 
The displayed value on the slider control may deviate from the actual value in the following 
circumstances: 
• The value range (minimum and maximum value) configured for the slider control does not 

correspond to the configured limits for the slider control tag. 
• An invalid password has been entered for a password-protected slider control. 

Layout 
If the slider control is used as a display object, the value represented is determined by the 
position and configuration of the movable slider. 

9.2.13.2 Touch control 

Procedure 
Touch the slider on the touch screen of the HMI device. Move the slider in the desired 
direction while keeping contact with the screen.  
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9.2.13.3 Keyboard control 

Procedure 
One way to operate the slider control with a keyboard is to use the cursor keys  
The following table lists the key combinations for controlling the slider control: 

 
Keys Meaning 

SHIFT +  

SHIFT +  

Increase value 

SHIFT +  

SHIFT +  

Reduce value 

HOME  

END  

Increase value in 5% increments 

FN + HOME  

FN + END  

Move to maximum/minimum value 

 

9.2.13.4 Mouse and keyboard control 

Procedure 

Mouse 
Click the slider control. Move the slider control in the desired direction while holding down 
the mouse button.  

Keyboard 
Activate the trend view with <Tab>, using the tab order configured.  
You can operate the slider with the following keys: 

 
Key Key (Panel PC) Function 
<Up> or <Right> <Shift+Up> or <Shift+Right> Increase value 
<Down> or <Left> <Shift+Down> or <Shift+Left> Reduce value 
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Key Key (Panel PC) Function 
<Page up> -- Increase value in 5% increments  
<Page down> -- Reduce value in 5% increments 
<Home> -- Set maximum value 
<End> -- Set minimum value 

9.2.14 Gauge 

Purpose 
The gauge is a dynamic display object. The gauge displays numeric values in analog form 
by means of a pointer. The operator at the HMI device can thus see at a glance, for 
example, that the boiler pressure is in the normal range.  

 

Layout 
The layout of the gauge depends on the configuration. Up to three differently colored areas 
can be set up on the scale to visualize different operating states, such as normal operation, 
warning range and danger range.  
A trailing pointer can display the maximum value reached so far on the scale. The trailing 
pointer is reset when the screen is reloaded.  
The label on the scale can show the measured variable, e.g. boiler pressure, and the 
physical unit, e.g. bar.  

Operation 
The gauge is for display only and cannot be controlled by the operator. 
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9.2.15 Date / time field 

9.2.15.1 Description 

Purpose 
The date / time field indicates the system time and data. In Runtime, you may change the 
system time and data in accordance with the configuration.  

 

Layout 
The layout in the date/time field depends on the language set in the HMI device.  

Behavior 
An input values other than the date and system time are rejected. Instead, the original values 
(plus the time that has elapsed in the meantime) will appear in the date/time field and a 
system alarm will be displayed on the HMI device.  

9.2.15.2 Touch control 

Procedure 
Touch the date/time field on the touch screen of the HMI device. The screen keyboard 
automatically appears. Enter the desired value using the screen keyboard. Confirm your 
input with <Enter> or cancel it with <Esc>. After the input has been confirmed or canceled, 
the screen keyboard is automatically closed. 

9.2.15.3 Keyboard control 

Procedure 

Enable the date / time field with one or several TAB , according to the configured tab 
sequence. The selection is signaled by the colored field content. 
You now have two options:  
• Use the cursor keys to position the cursor and then enter your value. 

• Press ENTER . The object changes to the specific editing mode. Now, only one character will 
be marked in the field. 

� You can use the  /  cursor keys to scroll the character table. 
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� The  /  cursor keys can be used to move to the next or previous input 
position. 

Confirm your entry with ENTER  or cancel it with ESC .  

9.2.15.4 Mouse and keyboard control 

Procedure 

Mouse 
Click in the date/time field. Type in the relevant value. Confirm your input on the HMI with 
<Return> or cancel it with <Esc>.  

Keyboard 
Select the date / time field using the <Tab> key according to the configured tab sequence, 
for example. The contents of the I/O field will change color to show that it is now activated. 
You now have two options:  
• Type in the relevant value. 
• Press <Return>. The object changes to the specific editing mode. Now, only one 

character will be marked in the field. 
� Use the <Up>/<Down> cursor keys to scroll through a character table. 
� Use the <Right>/<Left> cursor keys to move the cursor to the next or previous input 

position. 
Confirm your input on the HMI with <Return> or cancel it with <Esc>. 
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9.2.16 Clock 

Purpose 
The clock displays the system time of the HMI device.  

 

Layout 
The time is displayed in analog or digital form, depending on the configuration. The current 
date is also displayed in the digital view. The display format depends on the language set on 
the HMI device. 

Operation 
The clock is for display only and cannot be operated. You can use the Date/Time field, for 
example, to set the date and time.  
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9.2.17 User view 

9.2.17.1 Description 

Purpose 
The user view is used by the administrator to manage user accounts, group assignments 
and user passwords.  
Users can change their passwords and logoff times. 

 

Layout 
The user view contains four columns for the user, password, group and log-off time. The 
passwords are encrypted by means of asterisks.  
• The users in the "Administrators" group can view all existing users in the user view, 

change all entries and create new user accounts. 
• Other users only see a single line in the user view showing their own user name. 
If the name or password of a logged on user is entered, a system alarm is output.  

Export and import 
A user view contains all users, passwords, group assignments and logoff times set up on the 
HMI device. To eliminate the necessity of reentering all data again on another HMI device, 
you can export the user view, and then import it to another device. However, this is only 
possible if this function has been configured.  

 

 Note 
Do not export the password list immediately after changing it. Exit the "User view" object 
after making changes and wait until the changes have been written to the internal Flash 
memory before performing the export. 

 

 Notice 
The currently valid passwords are overwritten during an import. The imported passwords are 
valid immediately. 
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9.2.17.2 Touch control 

Procedure 
To create a new user, touch an empty line. Then use the screen keyboard to type in the user 
name and confirm your entry with <Enter>. Assign a password and a logoff time in the same 
way and then select the group.  
To change user data, touch the relevant field and make the change.  

9.2.17.3 Keyboard control 

Procedure 

Select the user view, for example with TAB  according to the configured tab sequence.  

• To create a new user, select an empty line using the cursor keys and then press ENTER . 

Enter the user name and press ENTER . Use  to go to the next field and repeat the 
procedure.  

• To change the user data, select the desired line using the cursor keys and then press 
ENTER . 

Make the desired changes and then complete the action by pressing ENTER . 

9.2.17.4 Mouse and keyboard control 

Procedure 

Mouse 
To create a new user account, click an empty line. Type in the user name, then confirm your 
entry with <Return>. Assign a password and a logoff time in the same way and then select 
the group.  
To change user data, click the relevant field and make the change.  

Keyboard 
Select the user view, for example, using the <Tab> key according to the configured tab 
sequence.  
To create a new user account, select an empty line using the cursor keys and then press 
<Return>. Type in the user name, then confirm your entry with <Return>. Use <Right> to go 
to the next field and repeat the procedure.  
To change the user data, select the desired line using the cursor keys and then press 
<Return>. Then make the relevant changes.  
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9.2.18 Simple user view 

9.2.18.1 Description 

Purpose 
On HMI devices with a small display, the simple user view is used to display users on the 
HMI device.  

Layout 
Users in the "Administrators" group see all existing users in the user view. 

 
Other users only see a single line in the user view showing their own user name. 

9.2.18.2 Touch control 

Procedure 
Touch the relevant entry in the simple user view on the touch screen of the HMI device. 
Use the screen keyboard to input data. 

9.2.18.3 Keyboard control 

Entering custom user data 
Custom user data (name, password, group, log-off time) is entered sequentially in several 
dialogs. 

Procedure 

Select the simple user view with TAB , using the tab order configured. Select one of the 

users displayed using the cursor keys and press ENTER .  
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The following table shows the available key operations for entering custom user data in the 
dialogs: 

 
Key Function 

 

 

Selects the previous/next user 

TAB

 

Selects the next element in the dialog 

ENTER

 

Opens the next dialog 

 

9.2.18.4 Mouse and keyboard control 

Entering custom user data 
Custom user data (name, password, group, log-off time) is entered sequentially in several 
dialogs. 

Procedure 

Mouse 
Start the input mode by clicking on the desired user name. 

Keyboard 
Start the input mode by activating the simple user view, for example, using the <Tab> 
sequence and then select the user with <Enter>.  
The following table shows the available key operations for entering custom user data in the 
dialogs: 

 
Key Function 
<Up>/<Down>: Selects the previous/next user 
<Tab> Selects the next element in the dialog 
<Enter> Opens the next dialog 
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9.2.19 Status force 

9.2.19.1 Description 

Purpose 
You read or write access values of the connected PLC directly in the status / control view. 
The status / control view allows you to carry out operations such as monitoring or modifying 
the addresses of the PLC program, without the need of an online connection via PC or PG.  

 
 

 Note 
The status force view can only be used in combination with SIMATIC S5 or SIMATIC S7 
PLCs.  

Layout 
The screen shows the general layout of the status / control screen object. Every row 
represents an address.  
If your HMI device has a mouse or a touch screen, you can change the column sequence on 
the HMI device. For example, to interchange the format and control value columns, drag the 
control value header to the format header.  
The table shows the meaning of the individual columns.  

 
Column Function 
Connection The PLC of which the address ranges are to be displayed 
Type, DB number, offset, bit The address range of the operand 
Data type, format The data type of the operand 
Status value The value that was read from the given address of the operand 
Control value The value to be written to the given address of the operand 
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Operator controls 
The buttons have the following functions: 

 
Button Function 

 

This button refreshes the display in the status value column.  
The button engages when it is pressed. You cannot operate any input fields 
until the button is actuated again and the refresh is stopped. 

 

Use this button to accept the new value in the control value column. The 
control value is then written to the PLC.  

 

9.2.19.2 Touch control 

Procedure 
To enter or edit values, touch the respective field. A screen keyboard or a selection list 
appears.  
Touch the relevant buttons to write or read the values.  

9.2.19.3 Keyboard control 

Procedure 
The following table lists the key combinations for controlling the status force: 

 
Keys Meaning 

CTRL  + ENTER  
Operates the "Write" button 

CTRL +  
Operates the "Read" button. 

CTRL +  

CTRL +  

Selects the first/last field in the current row. 

CTRL +  

CTRL +  

Selects the first/last field in the current column. 

CTRL + ALT +  
Increases the width of the current column. 

CTRL + ALT +  
Decreases the width of the current column. 
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Keys Meaning 

CTRL + 
INS
DEL  

Deletes the current row 
Otherwise: 
Select "Internal tag" in the "Link" column. 

CTRL + +
ZY

 
Optimize column width. 

ENTER  
Opens selection field 

9.2.19.4 Mouse and keyboard control 

Procedure 

Mouse 
To enter or edit values, click the relevant field. Enter the value using the keyboard, or select 
a value from the selection list.  
Click the desired buttons to write or read the values. 

Keyboard 
The following keys can be used on the keyboard to operate Status Force.  

 
Key Key (Panel PC) Function 
<Ctrl+Return> <Ctrl+Enter> Operating the "Write" button  
<Ctrl+Space> <Ctrl+Space> Operating the "Read" button  
<Ctrl+Left> <Ctrl+Shift+Left> Selects first field in current row  
<Ctrl+Right> <Ctrl+Shift+Right> Selects last field in current row  
<Ctrl+Up> <Ctrl+Shift+Up> Selects first field in current column  
<Ctrl+Down> <Ctrl+Shift+Down> Selects last field in current column  
<Ctrl+Del> <Ctrl+INS/DEL> Deletes current row  
<Return> <Enter> Opens selection list  
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9.2.20 Sm@rtClient view 

9.2.20.1 Description 

Purpose 
The Sm@rtClient view may be used to start remote monitoring and control of another HMI 
device.  

 
With an appropriate configuration, the Sm@rtClient view can be used to monitor and control 
a system process from multiple HMI devices with the same authorizations. 

Layout 
The Sm@rtClient view displays the current Runtime screen of the remote device on your 
HMI device. You can now monitor and control this screens according to your configuration. 
Scroll bars are displayed if the screen of the remote HMI device is larger than that of your 
HMI device.  

Behavior 

Start  
The call for starting remote monitoring or control can be configured in different ways. 
Depending on the project, you can view the Runtime of the remote HMI device by taking the 
following steps:  
• Automatically when the device is started (and selection of the screen with the 

Sm@rtClient view, if this is not the start screen) 
• By activating the Sm@rtClient view with the <Tab> key or (on a touch screen device) 

through a touch 
• By entering the IP address of the remote HMI device and, if required, entering a 

password in the appropriate field in the Sm@rtClient view 
 

  Note 
If you enter an incorrect password five time in succession, all attempts to establish a 
connection are rejected for the next ten seconds.  



Operating a project  
9.2 Controlling graphic objects 

 MP 370 (WinCC flexible) 
9-52 Operating Instructions, Edition 03/2004, 6AV6691-1DE01-0AB0 

Stop  
The screen showing the display of the remote HMI device can be configured to be closed in 
different ways. Depending on the configuration, you can terminate the remote monitoring or 
remote operation and open the next object of your own project by taking one of the following 
steps:  
• Press the appropriate key. 
• Click "Exit". 
• Exit the screen. 
• Press <Shift+Ctrl> or (with touch devices) press a clear spot for an extended period. The 

menu opens with the corresponding menu item. 

Monitoring mode 
On a Sm@rtClient view which is configured for monitoring mode, you can only monitor the 
remote HMI device. You cannot control its operation.  
In this case, the keys retain their standard functions. Press <Tab> to open the next object in 
the current screen of your project according to the configured tab sequence.  

Control mode 
The Sm@rtClient view can be run in two different control modes:  
• If the "shared" check box is not set in the "Display" area of the "General" property view, 

only one HMI device can use the remote control function at any time. The others can be 
used to monitor the activities. Depending on the setting, a further HMI device logon will 
either be rejected, or the existing connection will be shut down so that the new HMI 
device can connect. 

• If the "shared" check box is set in the "Display" area in the property view "General", every 
HMI device on which remote operation is activated can access the remote HMI device 
and assume control of the process. Only one HMI device can be active at a time in this 
case. A different HMI device can first assume control when there has been no activity on 
the active HMI device for a specified period of time. 
The appearance of the mouse pointer indicates when operator control is possible.  
In both operation modes, the operator at the remote device is not permitted to initiate any 
further actions. 

 

  Note 
In the event of emergency, you can override the operation block on the remotely 
controlled or currently inactive HMI device by clicking on the user interface five times in 
succession or pressing the <Shift> key five times in succession. Then you may have to 
enter a specific (configured) password.  
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Keys 
In operation mode, all keys have the same function as those on the remote HMI device. You 
can therefore use the <Tab> key to move from one object to another on the remote screen, 
in the order of the tab configuration.  

Function keys 
When you press a function key that has been configured with a function, this function will be 
executed in your project.  
If you press a function that has not been configured with a function in your project, it will 
actuate the function key on the remote HMI device.  

9.2.20.2 Touch control 

Procedure 
Touch the desired operating element on the touch screen of the HMI device.  

9.2.20.3 Keyboard control 

Procedure 
How do I operate the Sm@rtClient view with touch? 

• Activate the desired control object with TAB  according to the configured tab sequence on 
the remote HMI device. 

• Move the scroll bars in the desired direction with CTRL  +  or CTRL  + . 

• To exit the Sm@rtClient view, display a menu line with SHIFT  + CTRL . Use ALT  to make a 
selection and the correponding shortcut key for the desired menu command. 

9.2.20.4 Mouse and keyboard control 

Procedure 

Mouse 
Click on the desired control object with the mouse pointer.  
To operate a scroll bar, click on it with the mouse pointer and move it in the desire direction 
while holding down the mouse button. 
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Keyboard 
• Activate the desired control object with <Tab> according to the configured tab sequence 

on the remote HMI device 
• You can move the scroll bars in the desired direction with <Ctrl+Up/Down>. 
• To exit the Sm@rtClient view, display a menu line with <Shift+Ctrl>. Select the desired 

menu command with <Alt+Shortcut key>. 

9.2.21 Symbol library 

9.2.21.1 Description 

Purpose 
The symbol library is a comprehensive library with images from the areas of technology and 
production.  

 

Behavior 
The following events can trigger functions when the project engineer has configured this for 
the symbols: 
• Click 
• Double-click 
• Press 
• Release 
• Enable 
• Disabling 

 

  Note 
The icons from the symbol library can only be operated with a mouse or touch screen. 
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9.2.21.2 Touch control 

Procedure 
Touch the symbol on the touch screen of your HMI device.  
There is no operator feedback, for example with color changes.  

9.2.21.3 Mouse control 

Procedure 
Click on the symbol with the mouse pointer. The active mouse function is signaled in 
Runtime by a changing cursor icon according to your configuration.  
There is no operator feedback, for example with color changes. 
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Operating recipes 10
10.1 Recipes 

Overview 
Recipes are a collection of associated data, e.g. machine configuration or production data. 
You can transfer these data, for example, from the HMI device to the controller in a single 
step in order to change the production variant. If you have programmed directly at the 
machine, for example, you can transfer the data to your HMI device and write these to the 
recipe. 

Operating recipes in Runtime 
WinCC flexible offers two options of viewing and editing recipes and the corresponding 
recipe data records in Runtime on the HMI device:  
• Recipe view 
• Recipe screen 



Operating recipes  
10.1 Recipes 

 MP 370 (WinCC flexible) 
10-2 Operating Instructions, Edition 03/2004, 6AV6691-1DE01-0AB0 

Recipe view 
The recipe view is a screen object that is configured in the "Screens" editor. For example, 
you can specify what operating function the recipe view will have in Runtime:  

 
The recipe view shows recipe data records in tabular form. The Recipe view is particularly 
useful if data records are small in size or only a few values are to be modified. 

Recipe screen 
A recipe screen represents a process screen which you configured as individual input screen 
form by means of an individual layout of I/O fields and other screen objects in the "Screens" 
editor. This makes it possible for you to input parameter data in the context of machine 
visualization. The I/O fields for a recipe can be distributed over multiple recipe screens, with 
topical organization of recipe elements, for example. The operating functions for the recipe 
screens must be configured explicitly in the process screens. 
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10.2 Structure of recipes 

Introduction 
A product often has several variants. For example, product variants can differ with respect to 
size or quality. This condition is accurately reflected in a recipe.  

Principle 
A recipe consists of recipe data records containing values. The structure of a recipe is 
explained using the example of a filing cabinet.  

 
Each recipe represents a drawer of the file cabinet shown, and thus precisely one product. If 
the fruit juice mixing plant is producing orange, apple, and tropical fruit flavors, you would 
then configure one recipe for each flavor.  
You define the recipe elements in the recipe. A recipe element consists of the display name 
and a tag. The display names are indicated in the recipe data records and on the HMI device 
in the recipe view. In Runtime, the appropriate tag value is read from the controller or 
transferred to the controller. 
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10.3 Structure of recipe data records 

Introduction 
A recipe data record corresponds to a file card in an individual drawer and thus to a single 
product variant. If the fruit juice mixing plant is producing juice, nectar, and fruit drinks, you 
would then create a recipe data record in the recipe for each product variant. In this case, 
the product variants consist of the different mixing ratios for the ingrediants.  

 
A recipe data record is a set of values for the tags defined in the recipe. You enter the values 
in the input fields. You can enter the values either during configuration or during runtime on 
the HMI device or the machine. 

 
To produce a product, you transfer the appropriate recipe data record from the HMI device to 
the connected controller. The values in the recipe data record cannot be changed on the 
HMI device unless the configuring engineer has provided for this. 
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Editing recipe data records 
You can edit recipe data records during configuration or in runtime on the HMI device.  
• During configuration, you can define recipes in the "Recipes" editor in the "Elements" tab. 

You can enter values in the recipe data records in the "Data records" tab. 
• During runtime, you have the option of entering recipe data record values directly on the 

HMI device or importing them via a CSV file. You can also export the recipe data records 
to a CSV file. 

10.4 Recipe application 

10.4.1 Transfer of recipe data records 

Introduction 
Recipe data records can be transferred in Runtime between external data storage media, 
e.g. a flash memory, an HMI device and a controller. 

Principle 
The figure below shows how recipe data records can be transferred. You configure the 
appropriate functionality for transferring data records in the recipe view. In a recipe screen, 
you use the system functions provided for this purpose. 

 
The HMI device stores recipe data records on a storage medium such as a flash memory 
device or hard disk. You can edit a recipe data record in a recipe view or recipe screen on 
the HMI device display.  
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(1) Save: Values you change on the recipe view or recipe screen are written to the recipe 
data record on the storage medium by executing the "Save" function.  
(2) Load: The "Load" function is used to update the values of recipe tags shown on the 
recipe screen with the values of the recipe data record of the storage medium. The function 
overwrites any values changed on the recipe screen. The "Load" function is executed for the 
Recipe view when the data record is selected again. 
(3) Write to controller: The values deltas of the recipe view and recipe screen are 
downloaded to the PLC by calling the "Write to controller" function. 
(4) Read from controller: Call the "Read from controller" function to update the indicated 
values of the recipe view and recipe screen with the controller values. The function 
overwrites any data changed on the recipe view or screen. 
(5) Synchronization with controller: In your configuration, you can decide to synchronize the 
values in the recipe view with the values of the recipe tags by setting the "Synchronization 
with controller" function. After this synchronization, both the recipe tags and the recipe view 
contain the current updated values. When the "Variables offline" setting is disabled for the 
recipe, the current values are also applied in the controller. 
(6) Import, Export: A data record can be exported to an external data carrier in order to 
process it in MS Excel, for example. The data record is there stored in *.csv format. 

10.4.2 Configuration of recipes 

Introduction 
You configure recipes according to your intended application. To write a value to a recipe 
data record on your HMI device without disturbing the current process, you need 
configuration settings other than those required for assigning parameters to a machine.  

Principle 
In the configuration settings of a recipe, you specify the behavior of the tags you are using in 
the recipe. The figure below shows the basic differences when working with recipe data 
records.  
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These configuration settings are made under "Settings" in the property view: 

 

Configuration 1: Recipe without "Synchronize tags" 
Data of a data record that has been read are only displayed and can only be edited in the 
recipe view. Using these same tags outside of the recipe view does not affect their values. 

Configuration 2: Recipe with "Synchronize tags" and with "Tags offline" 
The "Synchronize tags" option is used to specify that the data of a data record read from the 
controller or storage medium are to be written to or read from the tags you have configured 
for the recipe.  
The "Offline" option ensures that the input data are written to the tags without being 
transferred directly to the controller. 

Configuration 3: Recipe with "Synchronize tags" and without "Tags offline" 
The "Synchronize tags" option is used to specify that the data of a data record read from the 
controller or storage medium are to be written to or read from the tags you have configured 
for the recipe. 
The input or read data are transferred immediately to the controller: 
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Synchronization with the controller 
In the case of synchronous transfer, both the controller and the HMI device set status bits in 
the shared data compartment. You can use this mechanism to prevent uncontrolled 
overwriting of data in either direction in your control program. You define the address range 
of the data compartment separately for each controller on the "Range pointer" tab in the 
"Connections" editor. 
Applications for synchronous transfer of recipe data records: 
• The controller is the "active partner" for the transfer of recipe data records. 
• The controller evaluates the data containing the recipe number and name, as well as the 

recipe data record number and name. 
• Triggering the transfer of data records by means of system function or PLC job, e.g. with 

the system functions "SetDataRecordToPLC" and "GetDataRecordFromPLC", or with the 
PLC jobs "Set_Data_Record_To_PLC" and "Get_Data_Record_From_PLC." 

In order to synchronize transfer of data records between the HMI device and the controller, 
the following requirements must be met during configuration: 
• The "Data mailbox" range pointer is located under "Range pointers" in the project view. 
• The controller with which the HMI device synchronizes the data record transfer is 

specified in the recipe properties. 
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10.4.3 Scenario: Entering recipe data records in Runtime 

Objective 
You want to enter production data on the HMI device without disturbing the process that is 
currently underway. Therefore, the production data should not be transferred to the PLC.  

Sequence 

 
You enter the production data in the recipe view or the recipe screen, assign a recipe data 
record name, and save the new recipe data record on the storage medium of the HMI 
device. 

Configuration in WinCC flexible 
You configure the recipe along with the associated tags. 
Synchronization with the recipe tags is not necessary, because production data (tags) are 
not intended to be transferred to the PLC. Make the following settings for the recipe in the 
property view: 

 
Depending on the extent of the recipe, you either configure a recipe view or create a recipe 
screen. 
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10.4.4 Scenario: Manual production sequence 

Objective 
The production data are to be requested by the PLC according to the work piece to be 
processed and displayed on the HMI device for inspection. You want to be able to correct 
the transferred production data online, if necessary. 

Sequence 

 
A reading device connected to the PLC reads a bar code on the work piece to be processed. 
The recipe data record names correspond to the respective bar code names. This will enable 
the PLC to load the necessary recipe data record from the storage medium of the HMI 
device. The recipe data record is displayed for inspection. Changes are transferred 
immediately to the PLC.  

Configuration in WinCC flexible 
You configure the recipe along with the associated tags. 
Production data are to be transferred to the PLC, so it is necessary to synchronize with the 
PLC to prevent the data from accidentally overwriting each other. The tags are to be 
transferred to the PLC. Make the following settings for the recipe in the property view: 



 Operating recipes 
 10.4 Recipe application 

MP 370 (WinCC flexible) 
Operating Instructions, Edition 03/2004, 6AV6691-1DE01-0AB0 10-11 

 
 

 
Depending on the extent of the recipe, you either configure a recipe view or create a recipe 
screen. 

10.4.5 Scenario: Automatic production sequence 

Objective 
You want production to be executed automatically. The production data should be 
transferred directly to the PLC either from the data storage medium in the HMI device or 
from an external data storage medium. The production data do not have to be displayed. 
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Sequence 

 
Production can be controlled using one or more "Scripts", which transfer production data 
records automatically to the PLC. The sequence can be checked using the return values of 
the utilized functions.  

Configuration in WinCC flexible 
You can implement the automatic production sequence with available system functions. The 
"ImportDataRecords" system function loads data records from a CSV file to the data 
medium. The "SetDataRecordTagsToPLC" system function transfers a data record from the 
data storage medium to the PLC. 

10.5 Displaying recipes 

10.5.1 Viewing and editing recipes in Runtime 

Introduction 
The WinCC flexible ES offers you two configuration options of viewing and editing recipes 
and their corresponding data records in Runtime on the HMI device:  
• Recipe view 
• Recipe screen 

Recipe view 
The recipe view is a screen object that is configured in the "Screens" editor. For example, 
you can specify what operating function the recipe view will have in Runtime:  
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The recipe view shows recipe data records in tabular form. The Recipe view is particularly 
useful if data records are small in size or only a few values are to be modified. 

Simple recipe view 
On HMI devices which have a display smaller than 6" (e.g. OP 77B), the simple Recipe view 
is used to display and edit recipes.  

 
The simple recipe view consists of three areas: 
• Recipe selection 
• Recipe data record selection 
• Recipe entries 
In the simple recipe view, each area is shown separately on the HMI device. The simple 
recipe view always begins with the recipe selection. 

Recipe screen 
A recipe screen is a process screen with a customized input screen form that you create by 
setting up input/output fields and other screen objects in the "Screens" editor. This makes it 
possible for you to input parameter data in the context of machine visualization. The I/O 
fields for a recipe can be distributed over multiple recipe screens, which allows you a topical 
organization of recipe elements. The operating functions for the recipe screens must be 
configured explicitly in the process screens. 
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10.5.2 Behavior of the recipe view in Runtime 

Screen change 
If you change to another screen and have not yet saved changes to the recipe data in the 
recipe view, you will be prompted to save the recipe data. The recipe name and the name of 
the recipe record are displayed to show which recipe data have not been saved yet.  
If you change to a process screen that contains a recipe view with loaded recipe data, the 
recipe data will be automatically updated.  

Operating the recipe view with softkeys 
The Recipe view can be operated with function keys, e.g. when the HMI device does not 
have touch functionality. System functions allow you to assign functions such as "Save data 
record" to the function keys of the HMI device.  

10.6 Recipe data record administration 

10.6.1 Recipe data record administration 

Recipe data record administration 
In Runtime you can, based on the configuration 
• Create new recipe data records 
• Copy recipe data records 
• Edit recipe data records 
• Delete recipe data records 
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That is, you can either edit recipe data records in the recipe view or screen, or import recipe 
data records from a CSV file. 

Creating new recipe records 
1. Select the recipe on the HMI device in which you want to create a new recipe data 

record. 
2. Use the "Add data record" button in the recipe view or the corresponding button on the 

HMI device that has this function. 
A new data record with the next available number will be created. If you change the new 
data record number of an existing data record number, the data record is overwritten. 

3. Enter a name for the recipe data records. 
4. Enter the values for the recipe data records. 

The configuration data may already contain default values for the recipe data record.  
5. Use the "Save" button in the recipe view or the corresponding button on the HMI device 

that has this function. 

Result 
The new recipe data records will be saved to the selected recipe. If the recipe data records 
already exists, a system alarm will be output to the screen.  

Copying a recipe data record 
You copy a recipe record by saving it under a new name.  
1. Select the recipe on the HMI device in which you want to edit an existing recipe data 

record. 
2. Select the recipe data record that you want to edit on the HMI device. 
3. Assign a new name to the recipe data record. 

As soon as you close the "Recipe data record" input field, the next free recipe data record 
number will be automatically assigned to the recipe data record. You may change the 
recipe data record number. 

4. Use the "Save" button in the recipe view or the corresponding button on the HMI device 
that has this function. 

Result 
The recipe data record is stored under the new name. 

Modify recipe record 
1. Select the recipe on the HMI device in which you want to edit an existing recipe data 

record. 
2. Select the recipe data record that you want to edit on the HMI device. 
3. Replace the old values with new ones. 
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4. Use the "Save" button in the recipe view or the corresponding button on the HMI device 
that has this function. 

Result 
The modified values are applied to the recipe data record. 

Delete recipe data record 
1. Select the recipe on the HMI device in which you want to delete an existing recipe data 

record. 
2. Select the recipe data record that you want to delete on the HMI device. 
3. On the recipe view, select "Delete data record", or use the relevant HMI device button 

which is assigned this function. 

Result 
The recipe data record is deleted from the data medium of the HMI device. 

10.6.2 Synchronizing a recipe data record 

Introduction 
In Runtime, differences between the indicated values and the actual values of the recipe 
tags may arise as a result of data input in recipe views or modification of recipe tags. 
Depending on the configuration, you can synchronize the values displayed in the recipe view 
with the recipe tags and values of the PLC. This synchronization is performed for each one 
of the recipe tags contained in the recipe data record. 

Requirements 
A recipe data record is displayed in the recipe view. The value of recipe tags can be 
changed, for example by teach-ins. 

Procedure 
1. Use the "Synchronization with controller" button in the recipe view or the corresponding 

button that has this function. 

Result 
• The system always updates the current value of the recipe view with the up-to-date 

recipe tag value. 
• When the value shown in the recipe view is more recent than the current recipe tag value, 

the system writes this value to the recipe tag. 
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10.6.3 Read recipe data record from PLC 

Introduction 
You can read values from the PLC and write them to a recipe data record. For example, you 
can do this in machine teach-in mode in order to save the positioning data of axes as a 
recipe data record. 
The read values are written to the recipe record that is currently displayed on the HMI 
device. 

Procedure 
1. Select the recipe on the HMI device. 
2. On the HMI device, select the recipe data record of which you want to fetch the values 

from the PLC. 
3. Use the "Read from PLC" button in the recipe view or the corresponding button on the 

HMI device that has this function. 
4. Use the "Save" button in the recipe view or the corresponding button on the HMI device 

that has this function. 

Result 
The values are read from the PLC, visualized on the HMI device and saved to the recipe 
data record. 

10.6.4 Transfer recipe record to PLC 

Introduction 
You can edit recipes offline or online.  
• Offline: The data are transferred to the PLC after the relevant command is executed. 
• Online: The data are transferred immediately to the PLC 
In the recipe view, data are always edited offline. The configuration of the recipe screen 
determines whether the recipe data are edited offline or online. 
When you edit data offline, you have to transfer the changed data to the PLC. 

Procedure 
1. Select the recipe on the HMI device. 
2. On the HMI device, select the recipe data record of which you want to transfer the values 

to PLC. 
3. Use the "Write to PLC" button in the recipe view or the corresponding button on the HMI 

device that has this function. 
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Result 
The values of the recipe record are transferred to the PLC.  

10.6.5 Exporting and importing recipe data records 

Introduction 
Based on your configuration, you can either export recipe data records to a CSV file for 
editing in MS Excel, for example, or import these from a CSV file. The extent to which you 
can influence these processes is determined by the project configuration.  Various input 
boxes may be configured on the user interface: 
• Input of the path to the CSV file 
• Selection of the recipe data records for export 
• Overwriting an existing CSV file 

Export recipe data record 

Requirements 
Export functions are configured. 

Procedure 
1. Customize the export settings on the user interface of the HMI device, for example, by 

setting the path to the CSV file. 
2. Press the button or the key on the HMI device configured with the "Export recipe records" 

function. 

Result 
The recipe data record are exported to a CSV file.  

 

 Note 
New data records created in Runtime can be exported to an external file. 

Importing recipe records 

Requirements 
Import functions are configured. 
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Procedure 
1. Customize the import settings on the user interface of the HMI device, for example, by 

setting the path to the CSV file. 
2. Use the button or the key on the HMI device which is assigned the "Import recipe 

records" function. 

Result 
The recipe data record are imported. If the structure of the CSV file is different from the 
recipe structure, deviations are treated as follows: 
• Any additional values in the CSV file will be rejected. 
• If the CSV file contains values of the wrong data type, the configured default value is set 

in the recipe record. 
Example: 
The CSV file contains values that show the tank contents and were input as floating point 
numbers. However, the corresponding recipe tag expects an integer value. In this case, 
the system discards the imported value and uses the configured default.  

• The system also applies the configured default value to the recipe data record if the CSV 
file contains an insufficient number of values. 

10.6.6 Reactions to modifications of the recipe structure 

Introduction 
Engineering for the purpose of machine retrofitting may also influence the recipe structure. 
Previously created recipe data records can nevertheless continue to be used. 

Effects 
If the structure of the recipe record is different from the defined address ranges in the PLC, 
deviations are handled as follows: 
• Any additional values in the recipe record will be rejected. 
• If the recipe record contains values of the incorrect data type, the default will be used in 

the recipe record. 
Example: The recipe record contains values that show the tank contents and were input 
as floating point numbers. However, the corresponding recipe tag expects an integer 
value. In this case, the transferred value is rejected and the default value is used.  
The system also applies the default value to the recipe data record, if the recipe data 
record contains an insufficient number of values. 

 

  Caution 
When a tag is renamed, the assignment is lost.  
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10.7 Example 

10.7.1 Example: Creating a recipe 

Task 
In this example, you create three recipes for a fruit juice mixing machine. The fruit juice 
mixing machine is to be used to produce orange, apple, and tropical fruit flavors, based on 
mixing ratios for fruit drinks, nectar, and juice.  

Settings 
The settings relate to an HMI device which is connected to a SIMATIC S7-300 or SIMATIC 
S7-400 via MPI.  
In this example, you need the following tags, flags, recipes, and recipe data record values: 
Tags: 

 
Name PLC connection Address Type 
Liter water Yes DB 120, DBW 0 Integer 
Liter concentrate Yes DB 120, DBW 4 Integer 
Kilo sugar Yes DB 120, DBW 8 Integer 
Gram flavoring Yes DB 120, DBW 12 Integer 

Flag: 
 

Name Address 
Data record DB 100, DBW 0 

Recipe (basic settings): 
 

Recipe element Associated tag 
Liter water Liter water 
Liter concentrate Liter concentrate 
Kilo sugar Kilo sugar 
Gram flavoring Gram flavoring 

Recipe data record values: 
 

Data record name Liter water Liter concentrate Kilo sugar Gram flavoring 
Fruit drink 30 70 45 600 
Nectar 50 50 10 300 
Juice 5 95 3 100 
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Procedure 
1. Create the following tags with the settings indicated earlier: Liter water, Liter concentrate, 

Kilo sugar and Gram flavoring. 
2. Create the orange, apple, and tropical fruit recipes with the settings indicated above. 

 
Figure 10-1 Recipe with recipe elements 

3. Configure each recipe in such a way that you can edit the recipe data records on a recipe 
screen. The values of the recipe tags should not be transferred automatically to the PLC. 

4. Create the data records indicated above in each recipe. Enter the values indicated above 
in each of the data records. 

 
Figure 10-2 Recipe with recipe data record values 

Result 
The orange, apple, and tropical fruit flavor recipes have been created. In the "Configure 
recipe screen" example, you create a recipe screen in which you create an individual input 
screen form.  

10.7.2 Example: Configuring a recipe screen 

Task 
In this example, you create a recipe screen for the visualization of values of the fruit juice 
mixing machine. You use a recipe view to select the recipes and their associated recipe data 
records. You should be able to load and save the values of the recipe data records, and 
transfer them to and read them from the PLC. 
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Requirements 
The "Creating a recipe" sample application has been carried out. 
The "Fruit juice mixing machine" process screen has been created and is opened. 

Settings 
In this example, you need the following tags and buttons with the indicated settings: 
Tags: 

 
Name PLC connection Type 
RecipeNumber No Integer 
Data record number No Integer 

Buttons: 
 

Labeling Configured event System function 
Load Press LoadDataRecord 
Save Press SaveDataRecord 
Data to PLC Press Write data record tags to PLC 
Data from the PLC Press GetDataRecordTagsFromPLC 

 

Procedure 
1. Drag-and-drop the "Liter water", "Liter concentrate", "Kilo sugar", and "Gram flavoring" 

tags from the object view to the "Fruit juice mixing machine" process screen. 
Four I/O fields are created and linked by the specified tags.  

2. Configure a recipe view containing only the drop-down lists for the recipe name and data 
record name. Link the recipe view to the "Recipe number" and "Data record number" 
(recipe data record number) tags in the "General" group in the property view. 
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3. Assign the settings described above to each one of the four buttons. Transfer each 
"Recipe number" and "Data record number" tag as a parameter for the recipe number 
and recipe data record number. 

Result 
In Runtime, you can select the recipe and the associated recipe data record from the recipe 
view. Click "Load" to load the recipe data record values and display these in the configured 
I/O fields. Click "To PLC" to write the recipe data record values to the associated tags and to 
transfer the recipe data record values to the PLC.  



Operating recipes  
10.7 Example 

 MP 370 (WinCC flexible) 
10-24 Operating Instructions, Edition 03/2004, 6AV6691-1DE01-0AB0 



 

MP 370 (WinCC flexible) 
Operating Instructions, Edition 03/2004, 6AV6691-1DE01-0AB0 11-1 

Maintenance/Service 11
11.1 Clean screen/keyboard foil 

11.1.1 General information 

Introduction 
Clean the HMI device screen or keyboard foil at regular intervals. Use a damp cloth.  

 

 
Caution 
Cleaning the keyboard foil of key devices 
Clean the HMI device after it has been switched off. This ensures that functions are not 
inadvertently triggered by touching the keys or the touch screen. 

Cleaning agents 
Use only water with liquid soap or a screen cleaning foam. Never spray the cleaning agent 
directly onto the screen. Apply it to a cloth. Never use aggressive solvents or scouring 
powder.  

11.1.2 Notes on the touch panel 

Clean screen 
Only applies to HMI devices with a touch screen:  
The HMI device touch screen can be cleaned when switched on and when operating 
normally if touch screen input has been suppressed by means of an appropriately configured 
operating element (Clean Screen). After the Clean Screen function has been activated, all 
input via the touch screen operating elements is deactivated for a defined period of time. The 
time remaining until the end of operating suppression is indicated by a progress bar. 

 



Maintenance/Service  
11.2 Replacing the optional backup battery 

 MP 370 (WinCC flexible) 
11-2 Operating Instructions, Edition 03/2004, 6AV6691-1DE01-0AB0 

 Notice 
Suppressing operating elements 
Only clean the screen during operation when Clean Screen is activated. Pay attention to the 
end of operating suppression by the Clean Screen.  
Otherwise, incorrect operations may be initiated. 

Protective foil 
A protective foil is available for the touch screens on HMI devices. The necessary ordering 
information is provided in the Siemens Catalog ST 80. The protective foil is not part of the 
material supplied with the HMI device. 
The self-adhesive foil prevents the screen being scratched and soiled. In addition, the matt 
surface of the foil reduces reflections in disadvantageous lighting conditions.  
The protective foil can be removed as necessary without leaving any adhesive residue on 
the screen. 

 

 Caution 
Remove protective foil  
Never use sharp or pointed tools, such as a knife, to remove the protective foil. This may 
damage the touch screen.  

11.2 Replacing the optional backup battery 

Function of the backup battery 
An optional backup battery is available for the HMI device. The battery ensures that in the 
event of a power failure, the HMI device's internal hardware clock continues to run.  
Under normal operating conditions, the battery has a service life of approx. four years. It is 
not supplied with the HMI device.  

Supply source 
The battery can be ordered from the Siemens spare parts service. It is shipped ready for 
installation with a cable and connector. Please refer to the Siemens Catalog ST80 for the 
order number.  
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Requirements 
 

 
Caution 
Change the battery while power is still being supplied to ensure the internal hardware clock 
continues to run. 
The battery must be changed by a properly qualified person. 
Before replacing the battery, refer to the ESD Guidelines. 

Procedure 
1. Unplug the battery cable connector from the two-pin socket in the HMI device. 
2. The battery is normally secured to the back of the HMI device by two cable ties. Cut the 

cable ties, using pliers for instance, and remove the empty battery. 
3. Secure the new battery with two cable ties to the back of the HMI device. 
4. Insert the battery lead connector back into the socket. The plug is coded to prevent 

reversed poling. 

General information 
Please observe the following safety notes to ensure correct handling and disposal of lithium 
batteries: 

 

 
Warning 
The lithium battery can explode if not handled properly. The lithium battery should:.  
- never be charged 
- not be opened 
- not be short-circuited  
- be safeguarded against reversed poling 
- of 100 °C 
- be protected against direct sunlight 
Do not allow condensation to form on batteries. 
If you have to ship a battery, ensure compliance with the Dangerous Goods Ordinance for 
the shipping agent concerned (coding obligation). 
Treat used lithium batteries as special waste. Pack them separately in leakproof plastic bags 
for disposal. 
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See also 
Backup battery (Page 1-9) 
ESD guidelines (Page A-2) 
Interfaces (Page 4-4) 
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Technical Specifications 12
12.1 Dimension drawings 

12.1.1 Dimensions MP 370 12" Touch 

Unit dimensions 
Dimensions of the MP 370 12" Touch: 
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Figure 12-1 Dimensions of the MP 370 12" Touch 
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12.1.2 Dimensions MP 370 15" Touch 

Unit dimensions 
Dimensions of the MP 370 15" Touch: 

400 69 10

366

31
0

28
8

Side viewFront view

Plan view

 
Figure 12-2 Dimensions of the MP 370 15" Touch 
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12.1.3 Dimensions MP 370 12" Key 

Unit dimensions 
Dimensions of the MP 370 12" Touch:  
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Figure 12-3 Dimensions of the MP 370 12" Key 
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12.2 Technical specifications 

Technical specifications 
 
Housing MP 370 12" Key MP 370 12" Touch MP 370 15" Touch 
External dimensions (W x H) 483 mm x 310 mm 335 mm x 275 mm 400 mm x 310 mm 
Installation cutout (W x H)  450+1 mm x 290+1 mm 310+1 mm x 248+1 mm 368+1 mm x 290+1 mm 
Installation depth 59 mm 59 mm 69 mm 
Degree of protection 
Front 
Rear panel 

 
IP65/NEMA 4x INDOOR USE ONLY 

IP20 
Weight Approx. 5,1 kg Approx. 4,5 kg Approx. 5.7 kg 

 
 
Processor  
Type 64 bit RISC CPU 

 
 
Memory  
Memory Free for user data: 12 MB flash memory (max. 7 MB of which is for WinCC flexible 

configurations) 
Bulk storage  
• Slot for CF card e.g. ATA Flash card 
• Slot for PC card E.g. 

• ATA Flash card 
• SRAM card 
• NE2000-compatible Ethernet card 

 
 
Software  
Operating system Microsoft Windows CE 

 
 
Color display MP 370 12" Key MP 370 12" Touch MP 370 15" Touch 
Type TFT LCD TFT LCD with touch panel (analog resistive) 
Active screen diagonal 12,1 " 12,1 " 15,1 " 
Resolution (pixels) 800 x 600 (Super VGA) 1024 x 768 (XGA) 
Possible colors 256 
Back-lighting CCFL tubes 
Half brightness life 1) approx. 50,000 hours 
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1) Time period the brightness of the lighting tube only achieves 50% of its original value. The 
specified value depends on the operating temperature. 

 
 
Keyboard MP 370 12" Key 
Type Membrane keyboard 
System keys with dedicated functions 38 (3 with LEDs) 
Configurable function keys  
Number 
for local assignment 
Labeling 

36 (with LEDs) 
36 
System-specific with labeling strips 

 
 
Acoustic acknowledgement MP 370 12" Touch / MP 370 15" Touch 
In the case of touch control × (can be disabled)  

 
 
Power supply MP 370 12" Key MP 370 12" Touch MP 370 15" Touch 
Rated voltage +24 V DC 
Permissible range +24 V DC -15%, +20% 
Max. permissible transients 35 V (500 msec) 
Time between two transients Min. 50 s 
Power consumption 
Typical: 
Max. constant current: 
Power on current surge I2t: 

 
Approx. 0,6 A  
Approx. 0,9 A  

Approx. 0.5 A2s 

 
Approx. 0,6 A  
Approx. 0,9 A  

Approx. 0.5 A2s 

 
Approx. 1,4 A  
Approx. 1.8 A  

Approx. 0.5 A2s 
Fuse, internal Electronic 

 
 
Backup battery (option)  
Type Lithium battery 
Voltage/Capacity 2)  3.6 V / approx. 1.5 Ah 
Service life Approx. 4 years 

 
 

2) All rights reserved 
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Network connection   
Type 1 x Ethernet (10/100 Mbit) 

 
 
Ambient conditions MP 370 12" Key MP 370 12" Touch / MP 370 15" Touch
Installation position 
Max. permissible angle of inclination 
without external ventilation 

Vertical 
±35° 

Max. permissible ambient temperature  
Operation  
• Vertical installation 0 ... +50 °C 
• Installation angled from the 

perpendicular to max. 35° 
0 ... +35 °C 

• Shipping, storage -20 ... +60 °C 
Relative humidity  
Operation, transport, storage Max. 85%, no condensation 
Shock loading  
Operation 
Shipping, storage 

15 g / 11 ms 
25 g / 6 ms 

Vibration  
Operation 
Shipping, storage 

0,075 mm (10 - 58 Hz) 1 g (58 - 500 Hz) 
3.5 mm (5 - 8.5 Hz) 1 g (8.5 - 500 Hz) 

Barometric pressure  
Operation 
Shipping, storage 

706...1030 hPa 
581...1030 hPa 

 

12.3 EMC requirements 

EMC requirements 
Compliance of the named products with the regulations of Directive 89/336 EEC is verified 
by conformance with the following standards: 

 
Noise immunity Norms  
Static discharge (contact discharge/air 
discharge) 

EN 61000-4-2 6 kV/8 kV 

RF irradiation EN 61000-4-3 10 V/m, 80% AM,  
1 kHz 

Pulse modulation ENV 50204 900 MHz ±5 MHz 
10 V/meff., 50% ED, 200 Hz 
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Noise immunity Norms  
RF conduction EN 61000-4-6 150 kHz - 80 MHz 

10 V, 80% AM, 1 kHz 
Burst interference EN 61000-4-4  
Supply lines 
Process data lines 
Signal lines 

 2 kV 
2 kV 
1 kV 

Surge coupling 
Power supply cable 

EN 61000-4-5 1 kV with choke,  
Type DEHNrail (Order No. 901 104)  
2 kV with choke, 
Type DEHNrail (Order No. 901 104) 

Magnetic fields EN 61000-4-8 30A/m 50/60 Hz 

 
 
Radio interference  
Radio interference level complying to 
EN 55011  

Class A 

12.4 Interface description 

IF1A 

8 1

15 9  

Table 12-1 15-pin Cannon connector 

Pin RS 232 TTY General 
 1 Screening 
 2 - RXD- RXD- 
 3 RXD - - 
 4 TXD - - 
 5 CTS - - 
 6 - TXD+ - 
 7 - TXD- RTS 
 8 Screening 
 9 - RXD+ - 

 10 RTS - - 
 11 - +20 mA - 
 12 GND 
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Pin RS 232 TTY General 
 13 - +20 mA - 
 14 +5 V/100 mA 
 15 GND 

IF1B 

5 1

9 6  

Table 12-2 9-pin Sub-D socket (configuration via switch) 

Pin RS-422 RS 485 / PROFIBUS-DP / MPI 
 1 N.C. 
 2 N.C. 
 3 TXD+ Data B 
 4 RXD+ RTS-AS 
 5 GND (floating) 
 6 +5 V (floating) 
 7 N.C. 
 8 TXD- Data A 
 9 RXD- - 

IF2 

5 1

9 6  

Table 12-3 9-pin Sub-D plug (pin) 

Pin RS 232 
 1 DCD 
 2 RXD 
 3 TXD 
 4 DTR 
 5 GND 
 6 DSR 
 7 RTS 
 8 CTS 
 9 RI 
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Ethernet interface 

1  

Table 12-4 RJ45 plug connection 

Pin RJ45 
 1 10BaseT: TX+ 
 2 10BaseT: TX- 
 3 10BaseT: RX+ 
 4 - 
 5 - 
 6 10BaseT: RX- 
 7 - 
 8 - 

USB interface 

1  

Table 12-5 USB standard plug 

Pin USB 
 1 +5V 
 2 +5V 
 3 USB-DM 
 4 USB-DP 
 5 0V 
 6 0V 

 

See also 
Connecting the PLC (Page 4-11) 
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Appendix A
A.1 Certificates and Directives 

A.1.1 Approvals 

Approvals 
As of the date of delivery, the following approvals have been granted or their application is 
pending. Please refer to the rating plate on the back of the HMI device for identification. 

 

 
Warning 
Personal injury and equipment damage can occur. 
Personal injury and equipment damage can occur in hazardous areas if a plug connection is 
disconnected from the HMI device while the system is running. 
In hazardous areas, turn off the power to the HMI device when disconnecting the 
connectors.  
DO NOT DISCONNECT WHILE CIRCUIT IS LIVE UNLESS LOCATION IS KNOWN TO BE 
NON HAZARDOUS. 

 

 
 

Approvals  
CE approval EMC Directives 
C-Tick EMC radio interference, Australia 
UL approval UL Recognition Mark 1) 

Underwriters Laboratories (UL) complying with 
Standard UL 508,  

File E 116536 
UL approval In accordance with the UL/CSA Approval 

Agreement 
Ex Zone 2/22 Ex zone, Europe 

EN 50021, EN 50281-1-1 
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Approvals  
FM approval FM approval 

Complying with Factory Mutual Approval 
Standard Class Number 3611 Hazardous 

(classified) Locations Class I, Division 2, Group 
A, B, C, D 

 
 

1) The UL and CSA file numbers are dependent on the production site. The numbers specified 
here changes according to the change of production site. 

A.1.2 ESD guidelines 

What does ESD mean?  
Virtually all present-day, electronic modules incorporate highly integrated MOS devices or 
components. For technological reasons, these electronic components are very sensitive to 
overvoltage and, consequently, to electrostatic discharge. Therefore, they are identified as 
follows: 
• ESD – Electrostatically Sensitive Devices  
• ESD – Electrostatic Sensitive Devices 
The following symbol on cabinet plates, mounting racks and packages draws attention to the 
use of ESD and, thus, to the contact sensitivity of the assemblies concerned: 

 
Figure A-1 Symbol for ESD 

ESDs may be destroyed by voltages and energies that are undetectable to a human. 
Voltages of this kind occur as soon as a device or an assembly is touched by a person who 
is not grounded against static electricity. ESDs exposed to such over voltages may not 
immediately be detected as defective. In the majority of cases, faulty behavior may occur 
only after a long period of operation. 

Precautions against electrostatic discharge 
Most plastics are capable of carrying high charges. It is therefore imperative that they be 
kept away from ESDs. 
When working with electrostatically sensitive components, make sure that the person, the 
workstation and the packaging are properly grounded. 
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Handling ESD assemblies 
A general rule is that ESDs should be touched only when necessary, for example, when 
maintenance is required.  
Only touch devices if 
• you are grounded by permanently wearing an ESD wrist strap or 
• you are wearing ESD shoes or ESD shoe-grounding protection straps in conjunction with 

an ESD floor. 
Before you touch an electronic assembly, your body must be discharged. The simplest way 
of doing this is to touch a conductive, grounded object immediately beforehand, e.g. bare 
metal parts of a cabinet, water pipe etc. 
ESDs should not be brought into contact with charge-susceptible and highly insulating 
materials such as plastic films, insulating tabletops and items of clothing containing synthetic 
fibers. 
Assemblies should be deposited only on conductive surfaces, e.g. tables with an ESD 
coating, conductive ESD cellular material, ESD bags or ESD shipping containers. 
Do not place ESDs near visual display units, monitors or television sets (minimum distance 
to screen > 10 cm). 
Never touch ESDs so that contact is made with module connections or conductor rails. 

Measuring ESD assemblies 
Perform measurements on ESD assemblies only when 
• the measuring instrument is grounded, e.g. by means of a grounded conductor or 
• the measuring head has been briefly discharged before measurements are made with a 

potential-free measuring instrument, e.g. by touching a bare metal control cabinet. 
When soldering, use only grounded soldering irons. 

Shipping ESD assemblies 
Always store and ship ESD assemblies and devices in conductive packing, e.g. metallized 
plastic boxes, metal boxes. 
• Packing ESD 

If packing is not conductive, ESDs must be conductively wrapped before they are packed. 
Use conductive foam rubber, ESD bags, domestic aluminum foil or paper, for example; 
never use plastic bags or foils. 

• ESD with fitted battery 
With assemblies containing fitted batteries, make sure that the conductive packing does 
not come into contact with batteries or short-circuit them. If necessary, cover the battery 
terminals beforehand with suitable insulating material. 
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A.2 System alarms 

Introduction 
System alarms on the HMI device provide information about internal conditions of the HMI 
device and PLC. 
The following is an overview of when system alarms occur, their causes and the remedies 
available. 

 

 Note 
System alarms are only displayed when an alarm window has been configured. System 
alarms are issued in the language currently set on the HMI device. 

System alarm parameters 
The system alarms may contain parameters which are not decoded for the user but which 
are relevant with respect to the cause of an error. They provide a reference to the source 
code from the runtime software. These parameters are issued after the text "Error code:". 

System alarm parameters 
 
Number Effect/cause Remedy 

10000 The print job cannot be started or was canceled 
due to an unknown cause. The printer is not 
correctly configured. or There is no authorization for 
a network printer. 
The power supply failed during data transfer. 

Check the printer settings, cable connections and the 
power supply. 
Set up the printer once again. Obtain a network printer 
authorization. 
If the error persists, contact the Hotline! 

10001 No printer is installed or a default printer has not 
been selected. 

Install a printer and/or select it as the default printer. 

10002 The graphics buffer for printing is full. Up to two 
graphics are buffered. 

Wait before triggering print jobs. 

10003 Graphics can be buffered again. - 
10004 The buffer for printing lines in text mode (e.g. 

alarms) is full. Up to 1000 lines are buffered. 
Wait before triggering print jobs. 

10005 Text lines can be buffered again. - 
10006 The Windows printing system reports an error. 

Refer to the printed text and the error number to 
determine the possible causes. Nothing is printed 
or the printout is incorrect.  

Repeat the action if necessary.  

20010 An error has occurred in the specified script line. 
The execution of the script was therefore aborted. 
Note the system alarms that may have occurred 
prior to this.  

Select the specified script line in the configuration. 
Ensure that the tags used are the allowed types. Check 
system functions for the correct number and types of 
parameters. 
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Number Effect/cause Remedy 
20011 An error has occurred in a script that was called by 

the specified script.  
The execution of the script was therefore aborted in 
the called script.  
Note the system alarms that may have occurred 
prior to this.  

In the configuration select the script that has been called 
directly or indirectly by the specified script.  
Ensure that the tags used are the allowed types.  
Check system functions for the correct number and types 
of parameters. 

20012 The configuration data is inconsistent. The script 
could therefore not be generated. 

Recompile the configuration. 

20013 The script components from WinCC flexible runtime 
are not correctly installed. Therefore, no scripts can 
be executed. 

Reinstall WinCC flexible runtime. 

20014 The system function returns a value that is not 
written in any return tag. 

Select the specified script in the configuration. 
Check whether the script name has been assigned a 
value. 

20015 Too many scripts have been triggered in quick 
succession. When more than 20 scripts are queued 
for processing, any subsequent scripts are rejected. 
In this case, the script indicated in the alarm is not 
executed. 

Find what is triggering the scripts. Extend the times, e.g. 
the polling time of the tags which trigger the scripts.  

30010 The tag could not accept the function result, e.g. 
when it has exceeded the value range. 

Check the tag type of the system function parameter. 

30011 A system function could not be executed because 
the function was assigned an invalid value or type 
in the parameter. 

Check the parameter value and tag type of the invalid 
parameter. If a tag is used as a parameter, check its 
value. 

40010 The system function could not be executed since 
the parameters could not be converted to a 
common tag type. 

Check the parameter types in the configuration. 

40011 The system function could not be executed since 
the parameters could not be converted to a 
common tag type. 

Check the parameter types in the configuration. 

50000 The HMI device is receiving data faster than it is 
capable of processing. Therefore, no further data is 
received until the data currently available has been 
processed. Data exchange then resumes. 

- 

50001 Data exchange resumes. - 
60000 This alarm is generated by the function 

“DisplaySystemEvents”. The text to be displayed is 
transferred to the function as a parameter.  

- 

60010 The file could not be copied to the defined path 
because one of the two files is currently open or the 
source/target path is not available. 
It is possible that the Windows user has no access 
rights to one of the two files. 

Restart the system function or check the paths of the 
source/target files. Using Windows NT/2000/XP: The user 
executing WinCC flexible Runtime must be granted 
access rights for the files. 

60011 An attempt was made to copy a file to itself. 
It is possible that the Windows user has no access 
rights to one of the two files. 

Check the path of the source/target file. 
Using Windows NT/2000/XP with NTFS: The user 
executing WinCC flexible Runtime must be granted 
access rights for the files. 

70010 The application could not be started because it 
could not be found in the path specified or there is 
insufficient memory. 

Check whether the application exists in the specified path 
or close other applications. 

70011 The system time could not be modified. Check the time which is to be set. 
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Number Effect/cause Remedy 
The error message only appears in connection with 
area pointer "Date/time PLC". Possible causes: 
• An invalid time was transferred in the job 

mailbox. 
• The Windows user does not have the right to 

modify the system time. 
If the first parameter in the system alarm is 
displayed with the value 13, the second parameter 
indicates the byte containing the incorrect value. 

Using Windows NT/2000/XP: The user executing WinCC 
flexible Runtime must be granted the right to change the 
system time of the operating system. 

70012 An error occurred when executing the function 
"StopRuntime" with the option "Runtime and 
operating system". 
Windows and WinCC flexible Runtime are not 
closed. 
One possible cause is that other programs cannot 
be closed. 

Close all programs currently running. 
Then close Windows. 

70013 The system time could not be modified because an 
invalid value was entered. Incorrect separators may 
have been used. 

Check the time which is to be set.  

70014 The system time could not be modified. Possible 
causes: 
• An invalid time was transferred. 
• The Windows user does not have the right to 

modify the system time. 
• Windows rejects the setting request. 

Check the time which is to be set. 
Using Windows NT/2000/XP: The user executing WinCC 
flexible Runtime must be granted the right to change the 
system time of the operating system. 

70015 The system time could not be read because 
Windows rejects the reading function.  

- 

70016 An attempt was made to select a screen by means 
of a system function or job. This is not possible 
because the screen number specified does not 
exist. 
or: a screen could not be generated due to 
insufficient system memory. 

Check the screen number in the function or job with the 
screen numbers configured. 
Assign the numbers to a screen, if necessary. 

70017 Date/time is not read from the area pointer because 
the address set in the PLC is either not available or 
has not been set up.  

Change the address or set up the address in the PLC. 

70018 Acknowledgment that the password list has been 
successfully imported.  

- 

70019 Acknowledgment that the password list has been 
successfully exported.  

- 

70020 Acknowledgment for activation of alarm reporting. - 
70021 Acknowledgment for deactivation of alarm 

reporting. 
- 

70022 Acknowledgment to starting the Import Password 
List action. 

- 

70023 Acknowledgment to starting the Export Password 
List action. 

- 

70024 The value range of the tag has been exceeded in 
the system function. 
The calculation of the system function will not be 
performed. 

Check the desired calculation and correct it if necessary.  
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Number Effect/cause Remedy 
70025 The value range of the tag has been exceeded in 

the system function. 
The calculation of the system function will not be 
performed. 

Check the desired calculation and correct it if necessary.  

70026 No other screens are stored in the internal screen 
memory. 
No other screens can be selected. 

- 

70027 The backup of the RAM file system has been 
started. 

- 

70028 The files from the RAM have been copied in the 
Flash memory. 
The files from the RAM have been copied in the 
Flash memory. Following a restart, these saved 
files will be copied back to the RAM file system. 

- 

70029 Backup of the RAM file system has failed. 
No backup copy of the RAM file system has been 
made. 

Check the settings in the "Control Panel > OP" dialog and 
save the RAM file system using the "Save Files" button in 
the "Persistent Storage" tab. 

70030 The parameters configured for the system function 
are faulty. 
The connection to the new PLC was not 
established. 

Compare the parameters configured for the system 
function with the parameters configured for the PLC and 
correct them as necessary. 

70031 The PLC configured in the system function is not an 
S7 PLC. 
The connection to the new PLC was not 
established. 

Compare the S7 PLC name parameter configured for the 
system function with the parameters configured for the 
PLC and correct them as necessary. 

70032 The object configured with this number in the tab 
order is not available in the selected screen. 
The screen changes but the focus is set to the first 
object. 

Check the number of the tab order and correct it if 
necessary. 

70033 An e-mail cannot be sent because a TCP/IP 
connection to the SMTP server no longer exists. 
This system alarm is generated only at the first 
attempt. All subsequent unsuccessful attempts to 
send an e-mail will no longer generate a system 
alarm. The event is regenerated when an e-mail 
has been successfully sent in the meantime. 
The central e-mail component in WinCC flexible 
Runtime attempts, in regular intervals (1 minute), to 
establish the connection to the SMTP server and to 
send the remaining e-mails. 

Check the network connection to the SMTP server and 
re-establish it if necessary. 

70034 Following a disruption, the TCP/IP connection to 
the SMTP server could be re-established. 
The queued e-mails are then sent. 

- 

70035 The e-mail queue of the central component in 
WinCC flexible Runtime responsible for sending e-
mails is full. The e-mail could therefore not be 
entered into the queue and therefore not sent. 
The cause may be a broken connection to the 
SMTP server or an overload resulting from too 
much e-mail traffic. 
This system alarm is generated only at the first 
attempt. The next system alarm is only generated 
when at least one e-mail has been successfully 

Check if 
• the network connection still exists or 
• the connection is overloaded (for example, due to 

reoccurring system alarms resulting from disruptions). 
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Number Effect/cause Remedy 
sent to the queue. 

70036 No SMTP server for sending e-mails is configured. 
A connection to an SMTP server can therefore not 
be established and no e-mails can be sent. 
The system alarm is generated by WinCC flexible 
Runtime the first time an attempt is made to send 
an e-mail. 

Configure an SMTP server: 
In WinCC flexible Engineering System 
using "Device settings > Device settings" 
In the Windows CE operating system 
using "Control Panel > Internet Settings > Email > SMTP 
Server" 

70037 An e-mail could not be sent for unknown reasons. 
The contents of the e-mail will be discarded. 

Check the e-mail parameters (recipient, etc.). 

70038 The SMTP server has rejected sending or 
forwarding an e-mail because the domain of the 
recipient is unknown to the server or because the 
SMTP server requires authentication. 
The contents of the e-mail are lost. 

Check the domain of the recipient address or deactivate 
the authentication on the SMTP server if possible. SMTP 
authentication is currently not used in WinCC flexible 
Runtime. 

70039 The syntax of the e-mail address is incorrect or 
contains illegal characters. 
The contents of the e-mail are discarded. 

Check the e-mail address of the recipient. 

70040 The syntax of the e-mail address is incorrect or 
contains illegal characters. 

- 

80001 The log specified is filled to the maximum (in 
percent) and must be stored elsewhere.  

Store the file or table by executing a ‘move’ or ‘copy’ 
function. 

80002 A line is missing in the specified log. - 
80003 The copying process for logging was not 

successful. 
In this case, it is also advisable to check any 
subsequent system alarms. 

- 

80006 Logging is not possible, resulting in a permanent 
loss of the functionality. 

In the case of databases, check whether the 
corresponding data source exists and restart the system. 

80009 A copying action has been completed successfully. - 
80010 The storage location was incorrectly entered in 

WinCC flexible, resulting in a permanent loss of the 
functionality. 

Configure the storage location for the respective log 
again and restart the system when full functionality is 
required. 

80012 Log entries are stored in a buffer. If the values are 
read to the buffer faster than they can be physically 
written (using a hard disk, for example), 
overloading may occur and recording is then 
stopped. 

Archive fewer values. 
or: 
Increase the logging cycle. 

80013 The overload status no longer applies. Archiving 
resumes the recording of all values. 

- 

80014 The same action was triggered twice in quick 
succession. Since the process is already in 
operation, the action is only carried out once. 

- 

80015 This system alarm is used to report DOS or 
database errors to the user. 

- 

80016 The logs are separated by the system function 
"CloseAllLogs" and the incoming entries exceed the 
defined buffer size. 
All entries in the buffer will be deleted.  

Reconnect the logs.  

80017 The incoming entries exceed the defined buffer 
size. This can be caused, for example, by several 

Stop the copy action.  
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Number Effect/cause Remedy 
copying actions being activated at the same time. 
All copy jobs will be deleted.  

80018 After executing the system function "OpenAllLogs", 
all connections between WinCC flexible and the 
logs have been reestablished. 
Entries will be rewritten into the logs.  

- 

80019 After executing the system function "CloseAllLogs" 
all connections between WinCC flexible and all logs 
have been severed. 
Entries will be written to the buffer and written into 
the logs when a connection is re-established. 
There is no connection to the storage location and 
the data medium may be in the process of being 
exchanged.  

- 

80020 The maximum number of simultaneously activated 
copy actions has been exceeded. Copying is not 
executed.  

Wait until the current copying actions have been 
completed and restart the last copy action.  

80021 An attempt was made to delete a log which is still 
involved with a copy action. Deletion has not been 
executed.  

Wait until the current copying actions have been 
completed and restart the last action  

80022 Using the system function "StartSequenceLog", an 
attempt was made to start a sequential log for a log 
not configured as such. No sequential log is 
created.  

Check the project for the following: 
• The system function "StartSequenceLog" is 

configured correctly. 
• The tag parameters are being correctly provided on 

the HMI device. 
80023 An attempt was made to copy a log to itself. 

The log is not copied.  
Check the project for the following: 
• The system function "CopyLog" is configured 

correctly. 
• The tag parameters are being correctly provided on 

the HMI device. 
80024 The system function "CopyLog" is configured not to 

permit copying when the target log already contains 
data (Parameter: "Mode"). The log is not copied.  

If necessary, modify the system function "CopyLog" in the 
project. Before initiating the system function, delete the 
target log.  

80025 You have interrupted the copy process. 
Data written up to this point is retained. Deletion of 
the target log (if configured) is not executed. 
The cancellation is documented by a $RT_ERR$ 
error entry at the end of the target log.  

- 

80026 This notification is issued after all the logs have 
been successfully initialized. Values are written to 
the logs from this moment on. Prior to this, no 
entries are written to the logs even though WinCC 
flexible Runtime is running. 

- 

80027 The internal Flash memory has been specified as 
the storage location for a log. This is not 
permissible. 
No values will be logged for this log and the log will 
not be created.  

Configure "Storage Card" or a network path as the 
storage location. 

80028 The event serves as a status acknowledgment that 
initialization of the logs is currently running. No 
values are logged until system alarm 80026 is 
issued. 

- 
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80029 The number of logs specified in the event could not 

be initialized. Initialization of the logs has been 
completed. 
The faulty logs are not available for logging jobs.  

Evaluate the additional system alarms generated for this 
alarm. 
Check the configuration, the ODBC (Open Database 
Connectivity) and the specified drive.  

80030 The structure of existing log does not match the 
expected log structure. 
The logging process is stopped for this log. 

Delete the existing log data manually in advance. 

80031 The log in CSV format is corrupted. 
The log cannot be used. 

Delete the corrupt file. 

80032 Logs can be configured with events. These are 
triggered as soon as the log is full. If WinCC flexible 
Runtime is started and the log is already full, the 
event will not be triggered. 
The log specified no longer logs data because it is 
full. 

Stop the WinCC flexible Runtime, delete the log and 
restart the WinCC flexible Runtime. 
or: 
Configure a button which contains the same actions as 
the event and press it. 

80033 "System Defined" is selected in the data log as the 
data source name. This results in an error. No 
logging is made to the database log whereas the 
logging to the CSV logs works. 

Install MSDE again. 

80034 An error has occurred in the initialization of the 
logs. An attempt has been made to create tables as 
a backup. This did not work. A backup has been 
made of the tables of the corrupt log and the log 
has been newly started (empty). 

No action is necessary. However, it is recommended to 
save the backups or delete them to free up memory. 

80035 An error has occurred in the initialization of the 
logs. An attempt has been made to create backups 
of the tables and this has failed. No logging or 
backup has been performed. 

It is recommended to save the backups or delete them to 
free up memory. 

110000 The operating mode has been changed. The 
operating mode is now 'offline'. 

- 

110001 The operating mode has been changed. The 
operating mode is now "online". 

- 

110002 The operating mode cannot be changed. Check the connection to the PLCs. 
Check whether the address area for the area pointer 88 
“Coordination" in the PLC is available. 

110003 The operating mode of the specified controller has 
been changed by the system function 
"SetConnectionMode". 
The operating mode is now "offline".  

- 

110004 The operating mode of the specified controller has 
been changed by the system function 
"SetConnectionMode". 
The operating mode is now "online".  

- 

110005 An attempt was made to use the system function 
SetConnectionMode to switch the specified PLC to 
the online operating mode although the entire 
system is in the offline mode. This switchover is not 
permissible. The PLC remains in operating mode 
"offline".  

Switch the complete system to operating mode "online" 
and execute the system function again.  

110006 The content of the area pointer "User version" does 
not match the user version configured WinCC 
flexible. WinCC flexible Runtime is therefore 

Check: 
• The user version entered on the controller 
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closed. • The user version entered in WinCC flexible 

120000 The trend is not displayed because an incorrect 
axis to the trend or incorrect trend has been 
configured. 

Change the configuration. 

120001 The trend is not displayed because an incorrect 
axis to the trend or incorrect trend has been 
configured. 

Change the configuration. 

120002 The trend is not displayed because the tag 
assigned tries to access an invalid PLC address. 

Check if the data area for the tag exists in the PLC, the 
configured address is correct and the value range for the 
tag is correct. 

130000 The action was not executed. Close the other programs. 
Delete files no longer required from the hard disk. 

130001 The action was not executed. Delete files no longer required from the hard disk. 
130002 The action was not executed. Close the other programs. 

Delete files no longer required from the hard disk. 
130003 No data medium is inserted. The process is 

stopped. 
For example, check if 
• The correct data medium is being accessed 
• The data medium is inserted 

130004 The data medium is write-protected. The process is 
stopped. 

Check whether access has been made to the correct 
storage medium. Remove any write protection.  

130005 The file is write-protected. The process is stopped. Check whether access has been made to the correct file. 
Modify the file attributes, if necessary.  

130006 No access to file is possible. The process is 
stopped. 

For example, check if 
• The correct file is being accessed 
• The file exists 
• Another action is preventing simultaneous access to 

the file 
130007 The network connection is interrupted. 

Data mailboxes cannot be saved or read over the 
network connection. 

Check the network connection and correct the reason for 
the disruption. 

130008 The storage card is not available. 
Data mailboxes cannot be saved or read to the 
storage card. 

Insert the storage card. 

130009 The specified directory is not on the storage card. 
The files that are saved in this directory are not 
saved when the HMI device is switched off. 

Insert the storage card. 

130010 The maximum nesting depth can be exhausted, for 
example, when a value change in a script results in 
the initiation of another script. The second script in 
turn has a value change resulting in the initiation of 
another script and so on.  
The configured functionality is not provided. 

Check the configuration. 

140000 Online connection to the PLC has been 
successfully established. 

- 

140001 Online connection to the PLC has been 
disconnected. 

- 

140003 No tag updating or writing is executed. Check the connection and whether the PLC is switched 
on. 
Check the parameter definitions in the Control Panel 
using "Set PU/PC interface". 
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Restart the system. 

140004 No tag updating or writing is executed because the 
access point or the subrack configuration is 
incorrect. 

Verify the connection and check whether the PLC is 
switched on. 
Check the access point or the subrack configuration 
(MPI, PPI, PROFIBUS) in the Control Panel with "Set 
PU/PC interface". 
Restart the system. 

140005 No tag updating or writing is executed because the 
address of the HMI device is incorrect (possibly too 
high). 

Use a different HMI device address. 
Verify the connection and check whether the PLC is 
switched on. 
Check the parameter definitions in the Control Panel 
using "Set PU/PC interface". 
Restart the system. 

140006 No tag updating or writing is executed because the 
baud rate is incorrect. 

Select a different baud rate in WinCC flexible (according 
to module, profile, communication peer, etc.). 

140007 Tags are not updated or written because the bus 
profile is incorrect (see %1). 
The following parameters cannot be entered in the 
registry: 
1:  Tslot 
2:  Tqui 
3:  Tset 
4:  MinTsdr 
5:  MaxTsdr 
6:  Trdy 
7:  Tid1 
8:  Tid2 
9:  Gap Factor 
10: Retry Limit 

Check the user-defined bus profile. 
Check the connection and whether the PLC is switched 
on. 
Check the parameter definitions in the Control Panel 
using "Set PU/PC interface". 
Restart the system. 

140008 No tag updating or writing is executed because 
baud rate is incorrect. The following parameters 
cannot be entered in the registry: 
0:  General error 
1:  Incorrect version 
2:  Profile cannot be entered in the registry. 
3:  Subnet type cannot be entered in the registry. 
4:  Target rotation time cannot be entered in the 
registry.  
5:  Highest address (HSA) incorrect. 

Check the connection and whether the PLC is switched 
on. 
Check the parameter definitions in the Control Panel 
using "Set PU/PC interface". 
Restart the system. 

140009 No tag updating or writing is executed because the 
module for the S7 communication was not found. 

Reinstall the module in the Control Panel using "Set 
PU/PC interface". 

140010 No S7 communication peer could be found 
because the PLC is switched off. 
DP/T: 
The option “Is not active as the only master” is set 
in the Control Panel under “Set PU/PC interface”.. 

Switch the PLC on. 
DP/T: 
If only one master is connected to the network, deactivate 
the option "Is not active as the only master" in "Set 
PU/PC interface". 
If there is more than one master connected to the 
network, activate them. Do not change any settings 
otherwise the bus will be disrupted. 

140011 No tag updating or writing is executed because the 
communication is interrupted. 

Check the connection and that the communication peer is 
switched on. 

140012 There is an initialization problem (e.g. when WinCC 
flexible Runtime has been terminated in the Task 

Restart the HMI device. 
or: 
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Manager). 
or: 
Another application (e.g. STEP7) is active with 
different bus parameters and the driver cannot be 
started with the new bus parameters (e.g.baud 
rate). 

Start WinCC flexible Runtime first and then the other 
applications. 

140013 The MPI cable is not plugged in; there is no power 
supply. 

Check the connections. 

140014 "Configured bus address already assigned." Modify the HMI device address in the configuration in 
PLC. 

140015 Incorrect baud rate 
or:  
Incorrect bus parameter (e.g. HSA) 
or: 
OP address > HSA or: incorrect interrupt vector 
(interrupt does not arrive at the driver) 

Correct the incorrect parameters. 

140016 Configured interrupt is not supported by the 
hardware. 

Change the interrupt number. 

140017 Configured interrupt in use by another driver. Change the interrupt number. 
140018 The consistency check was deactivated by 

SIMOTION Scout. Only one appropriate note 
appears. 

Activate the consistency check with SIMOTION Scout 
again and reload the configuration in the project. 

140019 SIMOTION Scout loads a new project to the PLC. 
Connection to the PLC is interrupted. 

Wait until the end of the reconfiguration. 

140020 The version in the PLC and that in the configuration 
(FWX file) do not match. 
Connection to the PLC is interrupted. 

The following remedies are available: 
Load the current version in the PLC using SIMOTION 
Scout. 
Regenerate the project using WinCC flexible ES, close 
WinCC flexible Runtime and restart with a new 
configuration. 

150000 No additional data is read or written. Possible 
causes: 
• The cable is defective. 
• The PLC does not respond, is defective, etc. 
• The connection is established via the wrong 

interface. 
• The system is overloaded. 

Check that the cable is plugged in, the PLC is operational 
and the correct interface is used. 
Reboot the system if the system alarm is displayed 
continuously. 

150001 Connection is reestablished because the cause of 
the interruption has been eliminated. 

- 

160000 No additional data is read or written. Possible 
causes: 
• The cable is defective. 
• The PLC does not respond, is defective, etc. 
• Connection has been established via the wrong 

interface. 
• The system is overloaded. 

Check that the cable is plugged in, the PLC is operational 
and the correct interface is used. 
Reboot the system if the system alarm is displayed 
continuously. 

160001 Connection is reestablished because the cause of 
the interruption has been eliminated. 

- 

160010 There is no connection to the server because the 
server identification (CLS-ID) cannot be 

Check the access rights.  
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established. 
Values cannot be read or written.  

160011 There is no connection to the server because the 
server identification (CLS-ID) cannot be 
established. 
Values cannot be read or written.  

For example, check if 
• The server name is correct 
• The computer name is correct 
• The server is registered 

160012 There is no connection to the server because the 
server identification (CLS-ID) cannot be 
established. 
Values cannot be read or written.  

For example, check if 
• The server name is correct 
• The computer name is correct 
• The server is registered 
Note for experienced users: 
Interpret the value from HRESULT.  

160013 The specified server was started as InProc Server. 
This has not been released and may possibly lead 
to incorrect behavior because the server is running 
in the same process area as the WinCC flexible 
Runtime software. 

Configure the server as OutProc Server or Local Server. 

160014 Only one OPC server project can be started on a 
PC/MP. An error message appears when an 
attempt is made to start a second project. 
The second project has no OPC server functionality 
and cannot be located as an OPC server from 
external sources. 

Do not start a second project with OPC server 
functionality on the computer. 

170000 S7 diagnostic alarms are not displayed because it 
is not possible to log on to the S7 diagnostics with 
this unit. The service program is not supported. 

- 

170001 The S7 diagnostics buffer cannot be displayed 
because communication with the PLC has been 
switched off. 

Switch the PLC online. 

170002 The S7 diagnostics buffer cannot be displayed 
because reading in the diagnostics buffer (SZL) 
was terminated due to an error. 

- 

170003 The display of an S7 diagnostic alarm is not 
possible. An internal error %2 has been reported. 

- 

170004 The display of an S7 diagnostic alarm is not 
possible. An internal error with error class %2 and 
error number %3 has been reported. 

- 

170007 It is not possible to read in the S7 diagnostics buffer 
(SZL) because it was terminated with an internal 
error class %2 and error code %3. 

- 

180000 A component/OCX receives configuration data with 
a version identification which is not supported. 

Install a newer component. 

180001 The system is overloaded because too many 
actions have been activated simultaneously. Not all 
the actions can be executed; some are rejected.  

Several remedies are available: 
• Increase the configured cycle times or basic clock. 
• Generate the alarms slower (polling). 
• Trigger the scripts and functions at greater intervals. 
If the alarm appears more frequently: 
Restart the HMI device.  

180002 The screen keyboard could not be activated. 
Possible cause: 

Reinstall WinCC flexible runtime. 
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The file “TouchInputPC.exe” was not registered due 
to an incorrectly executed Setup. 

190000 It is possible that the tag will not be updated. - 
190001 The tag is updated following an error status after 

the cause of the last error state has been 
eliminated (return to normal operation). 

- 

190002 The tag is not updated because communication to 
the PLC has been interrupted. 

Switch on communication via the system function 
"SetOnline". 

190004 The tag is not updated because the configured 
address is not available for this tag. 

Check the configuration. 

190005 The tag is not updated because the configured PLC 
type does not exist for this tag. 

Check the configuration. 

190006 The tag is not updated because it is not possible to 
map the PLC type in the data type for the tag. 

Check the configuration. 

190007 The tag values are not modified because the 
connection to the PLC has been interrupted or the 
tag is offline. 

Switch to online mode or reestablish connection to the 
PLC. 

190008 The threshold values configured for the tag have 
been violated possibly due to: 
• an entered value 
• a system function 
• a script 

Observe the configured or current threshold value of the 
tag. 

190009 An attempt has been made to assign a value to a 
tag which is outside the value range permitted for 
this data type. 
E.g., a value of 260 entered for a byte tag or a 
value of -3 for a word tag without a sign. 

Observe the value range for the data type of the tags. 

190010 Too many values are being used to describe a tag 
(i.e. in a loop triggered by a script). 
Values are lost because the maximum of 100 
actions have been stored in the buffer. 

Increase the time interval between the multi-writing tasks. 

190011 Possible cause 1: 
The value entered could not be written to the 
configured PLC tag because it was either above or 
below the value range. 
The input is rejected and the original value is reset. 
Possible cause 2: 
The connection to the PLC has been interrupted. 

 
Ensure that the value entered is within the value range of 
the PLC tags. 
 
 
 
 
Check the connection to the PLC. 

190012 It is not possible to convert a value from a source 
format to a target format. For example: 
A value should be assigned to a counter which is 
outside the valid, PLC-dependent value range. 
A tag of the type Integer should be assigned a 
value of the type String. 

Check the value range or the data type of the tags. 

190100 The area pointer is not updated because the 
configured address for this area pointer is not 
available. 
Type 
1  Warning alarms 

Check the configuration. 
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2  Alarms 
3  PLC acknowledgment 
4  HMI device acknowledgment 
5  LED mapping 
6  Trend request 
7  Trend transfer 1 
8  Trend transfer 2 
No.: 
is the consecutive number displayed in WinCC 
flexible ES. 

190101 The area pointer is not updated because it is not 
possible to map the PLC type in the area pointer 
type. 
Parameter type and no.: 
see alarm 190100 

- 

190102 The area pointer is updated following an error 
status after the cause of the last error state has 
been eliminated (return to normal operation). 
Parameter type and no.: See alarm 190100. 

- 

200000 Coordination is not executed because the address 
configured in the PLC does not exist/has not been 
set up. 

Change the address or set up the address in the PLC. 

200001 Coordination is not executed because the address 
configured in the PLC does not exist/has not been 
written. 

Change the address or set up the address in the PLC in 
an area which can be written to. 

200002 Coordination is currently not being performed 
because the address format of the area pointer 
does not match the internal storage format. 

Internal error 

200003 Coordination can be executed again because the 
last error status has been eliminated (return to 
normal operation). 

- 

200004 The coordination may not be executed. - 
200005 No additional data is read or written. Possible 

causes: 
• The cable is defective. 
• The PLC does not respond, is defective, etc. 
• The system is overloaded. 

Check that the cable is plugged in and the PLC is 
operational. 
Reboot the system if the system alarm is displayed 
continuously. 

200100 Coordination is not executed because the address 
configured in the PLC does not exist/has not been 
set up. 

Change the address or set up the address in the PLC. 

200101 Coordination is not executed because the address 
configured in the PLC does not exist/has not been 
written. 

Change the address or set up the address in the PLC in 
an area which can be written to. 

200102 Coordination is currently not being performed 
because the address format of the area pointer 
does not match the internal storage format. 

Internal error 

200103 Coordination can be executed again because the 
last error status has been eliminated (return to 
normal operation). 

- 

200104 The coordination may not be executed. - 
200105 No additional data is read or written. Possible Check that the cable is plugged in and the PLC is 
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causes: 
• The cable is defective. 
• The PLC does not respond, is defective, etc. 
• The system is overloaded. 

operational. 
Reboot the system if the system alarm is displayed 
continuously. 

210000 Jobs are not processed because the address 
configured in the PLC does not exist/has not been 
set up. 

Change the address or set up the address in the PLC. 

210001 Jobs are not processed because the address 
configured in the PLC cannot be written to/read 
from. 

Change the address or set up the address in the PLC in 
an area which can be written to/read from. 

210002 Commands are not executed because the address 
format of the area pointer does not match the 
internal storage format. 

Internal error 

210003 The job mailbox is processed again because the 
last error status has been eliminated (return to 
normal operation). 

- 

210004 It is possible that the job mailbox is not processed. - 
210005 A job mailbox with an illegal number was triggered.  Check the PLC program. 
210006 An error occurred while attempting to execute the 

job mailbox. As a result, the job mailbox will not be 
executed. Observe the subsequent/previous 
system alarm, if appropriate. 

Check the parameters in the job mailbox. Recompile the 
configuration. 

220001 The tag is not downloaded because the associated 
communication driver / HMI device does not 
support downloading the data type bool/bit. 

Change the configuration. 

220002 The tag is not downloaded because the associated 
communication driver / HMI device does not 
support the data type byte when writing. 

Change the configuration. 

220003 The communication driver cannot be loaded. The 
driver may not be installed. 

Install the driver by reinstalling WinCC flexible Runtime. 

220004 Communication is terminated and no update is 
executed because the cable is not connected or is 
defective, etc. 

Check the connection. 

220005 Communication is running. - 
220006 The connection is established to the specified PLC 

at the specified interface.  
- 

220007 The connection to the specified PLC at the 
specified interface is disrupted.  

Check if 
• The cable is plugged in 
• The PLC is OK 
• The correct interface is used 
• The configuration is OK (interface parameters, 

protocol settings, controller address). 
Reboot the system if the system alarm is displayed 
continuously. 

220008 The communication driver cannot access the 
specified interface or open it. It is possible that 
another program is using this interface or an 
interface is being used which is not available on the 
target device. 
There is no communication to the PLC.  

Close all the programs which access the interface and 
restart the computer. 
Use another interface available in the system.  
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230000 The value entered could not be accepted. The 

entered value is rejected and the previous value is 
restored.  
Either the value range has been exceeded or 
impermissible characters were entered. 

Enter a permissible value. 

230002 Since the user currently logged on does not have 
the proper authorization, the input is rejected and 
the previous value is restored. 

Log on as a user with sufficient rights. 

230003 Changeover to the specified screen is not executed 
because the screen is not available/configured. The 
current screen remains selected. 

Configure the screen and check the selection function. 

230005 The value range of the tag has been exceeded in 
the I/O field. 
The original value of the tag is retained. 

Take the value range of the tag into consideration when 
entering value. 

230100 During navigation in the web browser, a message 
which may be of interest to the user is issued. 
The web browser continues to run, but may not 
(fully) display the new page. 

Navigate to another page. 

230200 The connection to the HTTP channel was 
interrupted due to an error. This error is explained 
by another system alarm. 
Data is no longer exchanged. 

Check the network connection. 
Check the configuration of the server. 

230201 The connection to HTTP channel has been 
reestablished. 
Data is exchanged. 

- 

230202 WININET.DLL has detected an error. This error 
usually occurs when it is not possible to make a 
connection to the server or the server rejects the 
attempt to make a connection because the client 
lacks the authorization. 
An unknown server certificate can also be the 
cause when the connection is encoded through 
SSL. 
The text of the error message provides more 
information. 
This text is always in the language of the Windows 
installation since it originates from Windows. 
Process values are no longer exchanged. 

Depending on the cause: 
When a connection cannot be made or a timeout occurs: 
• Check the network connection and the network. 
• Check the server address. 
• Check if the web server is actually running on the 

target computer. 
In the absence of an authorization: 
• Configured user name and/or password do not match 

those on the server. Match them. 
When the server certificate is rejected: 
Certificate signed by an unknown CA ( ): 
• Either set the configuration to ignore this point, or 
• Install a certificate that has been signed with a root 

certificate known to the client computer. 
If the date of the certificate is invalid: 
• Either set the configuration to ignore this point, or 
• Install a certificate with a valid date on the server. 
If there is an invalid CN (Common Name or Computer 
Name): 
• Either set the configuration to ignore this point, or 
• Install a certificate with a name that corresponds to 

that of the server address. 
230203 Although a connection can be made to the server, 

the HTTP server rejects the connection because 
• WinCC flexible Runtime is not running on the 

server or

For error 503 Service unavailable: Check if: 
WinCC flexible Runtime is running on a server. 
The HTTP channel is supported. 
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server, or 

• The HTTP channel is not supported (503 
Service unavailable). 

Other errors may occur if the web server does not 
support the HTTP channel. The language of the 
error text depends on the web server. 
Data is not exchanged. 

230301 An internal error has occurred. An English text 
explains the error somewhat more specific. One 
possible cause is insufficient memory, for example.
OCX does not work. 

- 

230302 The name of the remote server cannot be 
determined. 
No connection can be established. 

Check the configured server address. 
Check if the DNS service of the network is activated. 

230303 The remote server is not running on the addressed 
computer. 
The server address is incorrect. 
No connection can be established. 

Check the configured server address. 
Check if the remote server is running on the target 
computer. 

230304 The remote server on the addressed computer is 
incompatible to VNCOCX. 
No connection can be established. 

Use a compatible remote server. 

230305 The authentication has failed because the 
password is incorrect. 
No connection can be established. 

Configure the correct password. 

230306 The connection to the remote server has been 
interrupted. This may occur during network 
problems. 
No connection can be established. 

Check if 
• The cable is plugged in 
• there are network problems. 

230307 The connection to the remote server was ended 
because 
• The remote server was shut down, or 
• The user instructed the server to close all 

connections. 
The connection is closed. 

- 

230308 This notification informs you about the 
establishment of the connection. 
A connection has just been established. 

- 

240000 WinCC flexible Runtime is operating in demo mode.
You have no authorization or your authorization is 
corrupt. 

Load the authorization. 

240001 WinCC flexible Runtime is operating in demo mode.
Too many tags are configured for the installed 
version. 

Load an adequate authorization / powerpack. 

240002 WinCC flexible Runtime is operating with a time-
limited standby authorization. 

Restore the full authorization. 

240003 Authorization cannot be executed. 
Without authorization, WinCC will run in demo 
mode. 

Restart WinCC flexible Runtime or reinstall it. 

240004 Error while reading the standby authorization. 
WinCC flexible Runtime is operating in demo mode.

Restart WinCC flexible Runtime, install the authorization 
or repair the authorization (see Commissioning 
Instructions Software Protection). 
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250000 The tag in the specified line in "Status force" is not 

updated because the address configured for this 
tag is not available. 

Check the set address and then check that the address 
has been set up in the PLC. 

250001 The tag in the specified line in "Status force" is not 
updated because the PLC type configured for this 
tag is not available. 

Check the set address. 

250002 The tag in the specified line in "Status force" is not 
updated because it is not possible to map the PLC 
type in the tag type. 

Check the set address. 

250003 No connection could be established to the PLC. 
The tags will not be updated. 

Check the connection to the PLC. Check that the PLC is 
switched on and online.  

260000 An unknown user or an unknown password has 
been entered in the system. 
The current user is logged off the system. 

Log on to the system as a user with a valid password. 

260001 The logged on user does not have sufficient 
authorization to perform the protected functions on 
the system. 

Log on to the system as a user with sufficient 
authorization. 

260002 This notification is triggered by the system function 
"TrackUserChange". 

- 

260003 The user has logged off the system.  - 
260004 The user name entered into the user display 

already exists in the user administration. 
Select another user name because user names have to 
be unique in the user administration. 

260005 The entry is rejected.  Use a shorter user name.  
260006 The entry is rejected.  Use a shorter or longer password. 
260007 The log-off time you entered is outside the valid 

range of 0 to 60 minutes. 
The entered value will be discarded and the original 
value is retained. 

Enter a value between 0 and 60 minutes for the logoff 
time. 

260008 An attempt was made to read a PTProRun.pwl file 
created with ProTool V 6.0 in WinCC flexible. 
Reading the file was interrupted due to 
incompatibility of the format. 

- 

270000 A tag is not displayed in the alarm because it 
attempts to access an invalid address in the PLC. 

Check if the data area for the tag in the controller exists, 
whether the configured address is correct and whether 
the value range for the tag is correct. 

270001 There is a unit-dependent limit as to how many 
alarms may be queued simultaneously in order to 
be displayed (see GHB). This limit has been 
exceeded. 
The display no longer contains all the alarms. 
However, all the alarms are recorded in the alarm 
buffer. 

- 

270002 Alarms are displayed from a log for which there is 
no data in the current project. 
Placeholders are issued for the alarms.  

Delete older log data, if necessary.  

270003 The service cannot be set up because too many 
devices want to set up this service. 
A maximum of four devices may execute this 
action. 

Connect fewer HMI devices which want to use the 
service. 

280000 Connection is reestablished because the cause of 
the interruption has been eliminated. 

- 
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280001 No additional data is read or written. Possible 

causes: 
• The cable is defective. 
• The PLC does not respond, is defective, etc. 
• Connection has been established via the wrong 

interface. 
• The system is overloaded. 

Check if 
• The cable is plugged in 
• The PLC is OK 
• The correct interface is used. 
Reboot the system if the system alarm is displayed 
continuously. 

280002 A connection is used which requires a function 
module in the PLC.  
The function block has replied. Communication can 
now proceed. 

- 

280003 A connection is used which requires a function 
module in the PLC.  
The function block has not replied. 

Check if: 
• The cable is plugged in 
• The PLC is OK 
• The correct interface is used. 
Reboot the system if the system alarm is displayed 
continuously. 
The remedy depends on the error code: 
1:  The function block must set the COM bit in the 
response container. 
2:  The function block must not set the ERROR bit in the 
response container. 
3:  The function block must respond within the specified 
time (timeout). 
4:  Establish an online connection to the controller. 

280004 Connection to the PLC is interrupted. There is no 
data exchange at present. 

Check the connection parameters in WinCC flexible. 
Check that the cable is plugged in, the PLC is operational 
and the correct interface is used. 
Reboot the system if the system alarm is displayed 
continuously. 

290000 The recipe tag could not be read or written to. It is 
assigned the start value. 
The alarm can be entered in the alarm buffer for up 
to four more failed tags, if necessary. After that, the 
alarm number 290003 is issued.  

Check in the configuration that the address has been set 
up in the PLC.  

290001 An attempt has been made to assign a value to a 
recipe tag which is outside the value range 
permitted for this type. 
The alarm can be entered in the alarm buffer for up 
to four more failed tags, if necessary. After that, the 
alarm number 290004 is issued.  

Observe the value range for the tag type.  

290002 It is not possible to convert a value from a source 
format to a target format. 
The alarm can be entered in the alarm buffer for up 
to four more failed recipe tags, if necessary. After 
that, the alarm number 290005 is issued.  

Check the value range or type of the tag.  

290003 This alarm is issued when alarm number 290000 is 
triggered more than five times. 
In this case, no further individual alarms are 
generated.  

Check in the configuration that the tag addresses have 
been set up in the PLC.  

290004 This alarm is issued when alarm number 290001 is 
triggered more than five times. 

Observe the value range for the tag type.  
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In this case, no further individual alarms are 
generated.  

290005 This alarm is issued when alarm number 290002 is 
triggered more than five times. 
In this case, no further individual alarms are 
generated.  

Check the value range or type of the tag.  

290006 The threshold values configured for the tag have 
been violated by values entered.  

Observe the configured or current threshold value of the 
tag.  

290007 There is a difference between the source and target 
structure of the recipe currently being processed. 
The target structure contains an additional data 
recipe tag which is not available in the source 
structure. 
The data recipe tag specified is assigned its start 
value.  

Insert the specified data recipe tag in the source 
structure.  

290008 There is a difference between the source and target 
structure of the recipe currently being processed. 
The source structure contains an additional data 
recipe tag which is not available in the target 
structure and therefore cannot be assigned. 
The value is rejected. 

Remove the specified data recipe tag in the specified 
recipe from the project.  

290010 The storage location configured for the recipe is not 
permitted. 
Possible causes: 
Impermissible characters, write protected, data 
medium full or does not exist.  

Check the configured storage location.  

290011 The data mailbox with the specified number does 
not exist.  

Check the source for the number (constant or tag value).  

290012 The recipe with the specified number does not 
exist.  

Check the source for the number (constant or tag value).  

290013 An attempt was made to save a data mailbox under 
a data mailbox number which already exists. 
The action is not executed.  

The following remedies are available: 
• Check the source for the number (constant or tag 

value). 
• First, delete the data mailbox. 
• Change the "Overwrite" function parameter. 

290014 The file specified to be imported could not be 
found.  

Check the following: 
• Check the file name. 
• Ensure that the file is in the specified directory. 

290020 Acknowledgment that downloading of data 
mailboxes from HMI device to controller has 
started.  

- 

290021 Acknowledgment that downloading of data 
mailboxes from HMI device to controller was 
completed without errors.  

- 

290022 Acknowledgment that downloading of data 
mailboxes from HMI device to controller was 
aborted due to an error.  

Check the configuration: 
• Are the tag addresses configured in the PLC? 
• Does the recipe number exist? 
• Does the data record number exist? 
• The "Overwrite" function parameter set? 

290023 Acknowledgment that downloading of data - 
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mailboxes from the controller to the HMI device has 
started.  

290024 Acknowledgment that downloading data mailboxes 
from the controller to the HMI device was 
completed without errors.  

- 

290025 Acknowledgment that downloading of data 
mailboxes from the controller to the HMI device 
was aborted due to an error.  

Check the configuration: 
• Are the tag addresses configured in the PLC? 
• Does the recipe number exist? 
• Does the data record number exist? 
• The "Overwrite" function parameter set? 

290026 An attempt has been made to read/write a data 
mailbox although the data mailbox is not free at 
present. 
This error may occur in the case of recipes for 
which downloading with synchronization has been 
configured.  

Set the data mailbox status to zero.  

290027 No connection to the PLC can be established at 
present. As a result, the data mailbox can neither 
be read nor written to. 
Possible causes: 
No physical connection to the controller (no cable 
plugged in, cable is defect) or the controller is 
switched off. 

Check the connection to the PLC. 

290030 This alarm is issued after reselecting a screen that 
contains a recipe display in which a data mailbox is 
already selected.  

Reload the data mailbox from the storage location or 
retain the current values.  

290031 While saving, it was detected that a data mailbox 
with the specified number already exists.  

Overwrite the data mailbox or cancel the action.  

290032 While exporting data mailboxes, it was detected 
that a file with the specified name already exists.  

Overwrite the file or cancel the process.  

290033 Confirmation request before deleting data 
mailboxes.  

- 

290040 A data mailbox error with error code %1 that cannot 
be described in more detail occurred. 
The action is canceled. 
It is possible that the data mailbox was not installed 
correctly on the controller. 

Check the storage location, the data mailbox, the "Data 
mailbox" area pointer and, if necessary, the connection to 
the controller. 
Wait a short period of time and then trigger the action 
again. 
If the error persists, contact Customer Support. Provide 
them with the error code. 

290041 A data mailbox or file cannot be saved because the 
storage location is full.  

Delete files no longer required.  

290042 An attempt was made to execute several recipe 
actions simultaneously. The last action was not 
executed.  

Wait a short period of time and then trigger the action 
again.  

290043 Confirmation request before storing data 
mailboxes. 

- 

290044 The data store for the recipe has been destroyed 
and will be deleted.  

- 

290050 Acknowledgment that the export of data mailboxes 
has started.  

- 

290051 Acknowledgment that the export of data mailboxes - 
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was completed successfully.  

290052 Acknowledgment that the export of data mailboxes 
was aborted due to errors.  

Ensure that the structure of the data mailboxes at the 
storage location and the current recipe structure on the 
HMI device are identical.  

290053 Acknowledgment that the import of data mailboxes 
has started.  

- 

290054 Acknowledgment that the import of data mailboxes 
was completed successfully.  

- 

290055 Acknowledgment that the import of data mailboxes 
was aborted due to errors.  

Ensure that the structure of the data mailboxes at the 
storage location and the current recipe structure on the 
HMI device are identical.  

290056 The value in the specified line/column could not be 
read/written without errors. 
The action was canceled.  

Check the specified line/column.  

290057 The tags of the specified recipe were switched from 
operating mode "offline" to "online". 
Each modification of a tag in this recipe is now 
immediately transferred to the PLC.  

- 

290058 The tags of the specified recipe were switched from 
operating mode "online" to "offline". 
Modifications to tags in this recipe are no longer 
immediately transferred to the PLC but must be 
transferred there specifically if necessary by 
downloading a data mailbox.  

- 

290059 Acknowledgment that the specified data mailbox 
was stored successfully.  

- 

290060 Acknowledgment that the data mailbox memory 
was cleared successfully. 

- 

290061 Acknowledgment that clearing the data mailbox 
memory was aborted due to errors. 

- 

290062 The data mailbox number is above the maximum of 
65536. 
This data mailbox cannot be created. 

Select another number. 

290063 This occurs with the system function 
"ExportDataRecords" when the parameter 
"Overwrite" is set to No.  
An attempt has been made to save a recipe with a 
file name that already exists. 
The export is canceled. 

Check the system function "ExportDataRecords". 

290068 Request to confirm whether all data mailboxes in 
the recipe should be deleted. 

- 

290069 Request to confirm whether all data mailboxes of all 
recipes should really be deleted. 

- 

290070 The data mailbox specified is not in the import file. Check the source of the data mailbox number or data 
mailbox name (constant or tag value). 

290071 During the editing of data mailbox values, a value 
was entered that was below the lower limit of the 
recipe tag. 
The entry is rejected. 

Enter a value within the limits of the recipe tag. 

290072 During the editing of data mailbox values, a value 
was entered that was above the upper limit of the 

Enter a value within the limits of the recipe tag. 
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recipe tag. 
The entry is rejected. 

290073 An action (e.g. saving a data mailbox) was not 
possible due to an unknown reason. 
The error corresponds to the status alarm 
IDS_OUT_CMD_EXE_ERR in the large recipe 
view. 

- 

290074 While saving, it was detected that a data mailbox 
with the specified number already exists but under 
another name.  

Overwrite the data mailbox, change the data mailbox 
number, or cancel the action. 

290075 A data record with this name already exists. 
Saving the data record is stopped. 

Select a different data record name. 

300000 Process monitoring (e.g. using PDiag or S7-Graph) 
has been incorrectly programmed. More alarms are 
queued than allowed by the specifications of the 
CPU. No further ALARM_S alarms can be 
managed by the PLC and reported to HMI devices.  

Change the PLC configuration.  

300001 Logon cannot be performed for ALARM_S on this 
PLC. 

Select a PLC that supports the ALARM_S service. 

310000 An attempt is being made to print too many reports 
simultaneously. 
Since only one report can be printed at a time, the 
print job is rejected.  

Wait until the printout of the previous active report has 
finished. 
Repeat the print job if necessary.  

310001 An error occurred on triggering the printer. The 
report is either not printed or printed with errors.  

Evaluate the additional system alarms generated for this 
alarm. 
Repeat the print job if necessary.  

320000 The movements have already been indicated by 
another device. 
The movements can no longer be controlled. 

Select the movements on the other display units and 
select the movement screen on the required display unit. 

320001 The network is too complex. 
The defective operands cannot be displayed. 

Display the network in STL.  

320002 No diagnostics-capable alarm have been selected.
The units related to the alarm could not be 
selected. 

Select a diagnostics-capable alarm in the screen 
ZP_ALARM. 

320003 No alarms exist in respect to the selected unit. No 
network can be displayed in the detail display. 

Select the defective unit in the general view screen. 

320004 The required signal statuses could not be read by 
the PLC. The defective operands cannot be 
determined. 

Check the consistency between the configuration on the 
display unit and the PLC program loaded. 

320005 The project contains ProAgent partitions which are 
not installed. No ProAgent diagnostics can be 
performed. 

In order to run the project, install the ProAgent option 
packet. 

320006 You have attempted to execute a function that is 
not possible with the current configuration. 

Check the type of the selected unit. 

320007 No operands causing a fault have been found in the 
networks. 
ProAgent cannot display any blocked operands. 

Switch the Detail Screen to STL display mode and check 
the status of the operands and exclusion operands. 

320008 The diagnostic data saved in the configuration is 
not synchronized with that in the PLC. 
ProAgent can only display the diagnostic units. 

Recompile the project and download it to the HMI device 
again. 

320009 The diagnostic data saved in the configuration is Recompile the project and download it to the HMI device 
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not fully synchronized with that in the PLC. The 
diagnostic screens can be operated normally. 
ProAgent may be unable to display all diagnostic 
texts. 

again. 

320010 The diagnostic texts saved in the configuration are 
not synchronized with that in the STEP7. 
The ProAgent diagnostics data is not up-to-date.  

Recompile the project and download it to the HMI device 
again. 

320011 There is no unit with the referenced DB number 
and FB number. 
The function cannot be executed.  

Check the parameters of function "SelectUnit" and the 
units selected in the project. 

320012 The "Step sequence mode" dialog box is no longer 
supported. 

Use Step Sequence Screen ZP_STEP from the 
appropriate standard project for your project. Instead of 
calling function Overview_Step_Sequence_Mode, call the 
function "FixedScreenSelection" using ZP_STEP as the 
screen name. 

320014 The selected PLC cannot be evaluated for 
ProAgent. 
The alarm view configured with the system function 
"EvaluateAlarmDisplayFault" could not be found. 

Check the parameters of the system function 
"EvaluateAlarmDisplayFault". 
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CPU Central Processing Unit 
CSV Comma Separated Values 
CTS Clear To Send 
DC Direct Current 
DCD Data Carrier Detect 
DIL Dual-in-Line (electronic chip housing design) 
DP Decentralized Periphery 
DSN Data Source Name 
DSR Data Set Ready 
DTR Data Terminal Ready 
ESD Electrostatically Sensitive Devices 
EMC Electromagnetic Compatibility 
EN European Norm 
ES Engineering System 
ESD Electrostatic Sensitive Device 
GND Ground 
RF High Frequency 
HMI Human Machine Interface 
IEC International Electronic Commission 
IF Interface 
LED Light Emitting Diode 
MMC Multi Media Card 
MOS Metal Oxide Semiconductor 
MPI Multipoint Interface (SIMATIC S7) 
MS Microsoft 
MTBF Mean Time Between Failures 
N.C. Not connected 
OP Operator Panel 
PC Personal Computer 
PG Programming Unit 
PPI Point to Point Interface (SIMATIC S7) 
RAM Random Access Memory 
RTS Request To Send 
RxD Receive Data 
SELV Safety Extra Low Voltage 
SP Service Pack 
PLC Programmable Logic Controller 
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STN Super Twisted Nematic 
Sub-D Subminiature D (plug connector)  
TAB Tabulator 
TCP/IP Transmission Control Protocol/Internet Protocol 
TFT Thin Film Transistor 
TxD Transmit Data 
UL Underwriter’s Laboratory 
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Display duration 

Defines whether and how long a system alarm is displayed on the HMI device. 

AG 
A PLC in the SIMATIC S5 series, e.g. the AG S5-115U 

AS 
A PLC in the SIMATIC S7 series, the SIMATIC S7-300 for example 

AS 511 
The protocol of the programming unit interface to the PLC SIMATIC S5 

Operating element 
Is a component part of a project to enter values and trigger functions. A button, for example, 
is an operating element.  

Screen 
A screen displays all the logically related process data on the HMI device. The display of the 
process data can be supported by graphic objects. 

Screen object 
Is a configured object for displaying or operating the system being monitored, e.g. a 
rectangle, an I/O field or Recipe View. 

Bootloader 
Used to start up the operating systems and is automatically started when the HMI device is 
switched on. A start graphic is displayed during startup. Once the operating system is 
loaded, the loader or the Control Panel is displayed, depending on the HMI device.  

Booting 
Also refer to Starting 
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I/O field 
The I/O field enables values to be entered or output on the HMI device which are then 
transferred to the PLC. 

Event 
Functions are triggered by the arrival of defined events. Events can be configured. Events 
which can be configured for a button include 'press button' and 'release button'. 

Field 
An area reserved in configured screens for entering input and output values. 

Flash memory 
Is a memory with non-volatile memory chips which is used as a mobile storage medium in 
the form of a memory card or installed permanently on the main board. The mobile storage 
medium market is determined by Flash memories; Compact Flash and Smart Media are 
predominant. 
Compact Flash and Smart Media differ in their basic, inner design. In the case of CF cards, 
the control electronics is in the card whereby, with SM cards, the control electronics is 
installed in the associated device. 

Function 
A function is linked to an icon in the Control Panel or an operating element in the project. 

Softkey 
Is a key on the HMI device which can be configured as required. A function is assigned to 
the key during the configuration. The assignment of the function keys may be dependent on 
the screen being displayed or independent of the screen displayed. 

Half brightness life 
Time period after which the brightness of the lighting tube only achieves 50% of its original 
value, for example. The specified value depends on the operating temperature. 

Hardcopy 
Represents a printout of the current screen content on a connected printer. 

Help text 
Configurable information on objects in a project. The help text for an alarm can, for example, 
contain information on the cause of the fault and methods of elimination. 
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Image 
A file which can be transferred from the configuration computer to the HMI device. The 
Image contains the operating system for the HMI device and parts of WinCC flexible runtime 
required to run a project. 

Alarm logging 
Is the printout of user-defined alarms parallel to output on the HMI device screen. 

Alarm, user-defined 
A user defined alarm can be assigned to one of the following alarm classes: 
• Error 
• Operation 
• User-defined alarm classes 
A user-defined alarm makes reference to a certain operating status of the system being 
monitors which is connected to the HMI device via the PLC. 

Alarm, departing 
Moment at which the triggering of an alarm by the PLC is reset. 

Alarm, arriving 
Moment at which an alarm is triggered by the PLC or HMI device. 

Alarm, acknowledging 
Acknowledgement of an alarm confirms that it has been noted. 

Conventions 
A system of characters, symbols and rules governing language syntax; in data processing 
they define the syntax of the programming language. 

Object 
Is a component part of a project, e.g. a screen or alarm. Objects serve to display or enter 
texts and values on the HMI device.  

Project 
The result of a configuration using a configuration software. The project contains system-
specific objects, basic settings and alarms in the form of screens. The project is saved in the 
project file with the file name extension *.hmi if it has been configured with WinCC flexible. 
It is necessary to distinguish between the project on the configuration computer and that on 
an HMI device. A project on the configuration computer can be available in several 
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languages than can be managed on the HMI device. The project on the configuration 
computer can be set up for different HMI devices. Only the project set up for a particular HMI 
device can be transferred to that HMI device. 

Project file 
Is the compiled file which is created after the configuration from a source file for a specific 
HMI device. The project file is transferred to the associated HMI device and serves for 
operating and monitoring the system to be monitored. Refer to Source file. 

Configuration computer 
The general term for programming units and PCs on which projects are created, using a 
configuration software, for use monitoring a system. 

Configuration software 
Is a software to create projects which serves for process visualization – also refer to project, 
process visualization and runtime software. 

Process visualization 
Is the representation of processes from the areas of production, logistics and services using 
texts and graphics. Configured elements enable the data to be read from and written to 
processes running on systems being monitored and, thus, to actively intervene in them. 

Source file 
Is the file from which various project files can be created, depending on the configuration. 
The source file is not transferred and remains on the configuration computer.  
The file extension of a source file is *.hmi. Refer to Source file, compressed and Project file. 

Source file, compressed 
Is the compressed form of the source file. It can be transferred, in addition to the project file, 
to the associated HMI device. "Enable BackTransfer" must be activated in the project on the 
configuration computer. The file extension of a compressed source file is *.pdz. The standard 
memory location for a compressed source file is the external memory card. Refer to Source 
file. 
To restore a source file, it is necessary to use the same WinCC flexible version which was 
used to configure the project. 

Remote on/off 
Is an option in the "Loader" menu which enables and disables remote control of the HMI 
device from the PLC. 
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Recipe 
A combination of tags to a fixed data structure. The data structure configured can be 
assigned data on the HMI device and is then referred to as a data record. The use of recipes 
ensures that when a data record is downloaded, all the assigned data is transferred to the 
PLC at the same time. 

Runtime 
Instantiation for a project on an HMI device. Refer to project file. 

Runtime software 
Is a software for process visualization with which a project on a configuration computer can 
be tested – also refer to project and configuration software. 

Acknowledge 
Acknowledgement of an alarm confirms that it has been noted. 

STEP 7 
Programming software for SIMATIC S7, SIMATIC C7 and SIMATIC WinAC. 

Start 
A project can be called in by means of a button in the Loader. This procedure is referred to 
as "starting". 

PLC 
Is a general term for devices and systems with which the HMI device communicates, e.g. 
SIMATIC S7. 

Job mailbox 
This triggers a function via the PLC. 

Fault time 
This relates to the time interval between the arrival and departure of an alarm. 

Symbolic I/O field 
Is a field for the input/output of a parameter. I.e. it contains a list of predefined entries from 
which one can be selected. 
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System, to be monitored 
A general term for machines, processing centers, systems and plants as well as processes 
which are to be operated and observed by an HMI device. 

System alarms 
Assigned to the "System" alarm class. A system alarm makes reference to internal states in 
the HMI device and the PLC.  

Tab order 
Is defined during the configuration to set the sequence in which objects are focused on 
pressing the <TAB> key. 

Transfer 
The transfer of a run-capable project to the HMI device. 

Transfer mode 
Is an operating mode on the HMI device used for transferring a run-capable project from the 
configuration computer to the HMI device. Refer to Transfer mode. 

Transfer mode 
Activates transfer mode. Setting the HMI device to transfer mode is a condition for 
transferring data from the configuration computer to the HMI device and vice versa. A logical 
connection via the data line does not exist. Refer to Transfer mode. 

Bootstrapping 
An option for updating the operating system. When a functional operating system is 
available, updating can be carried out without booting. Otherwise, updating with booting is 
necessary. In this case, the configuration computer communicates with the HMI device via 
the bootloader. 

Tag 
Is a defined memory location in which values can be written to and read from. This can be 
done from the PLC or via the HMI device. Depending on whether the tags have a connection 
to the PLC or not determines the difference between "external" tags (process tags) and 
"internal" tags. 
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Index 

A 
ACK 

Key, 9-8 
Acknowledge 

Key, 9-8 
acknowledgement 

Acoustic, 1-5, 6-17, 9-3, 12-6 
visual, 9-3 
with touch control, 9-3 

Acknowledgement groups, 1-6 
Acoustic acknowledgement, 1-5, 6-17, 9-3, 12-6 
Additional applications, 6-15 

Memory requirements, 6-15 
Air discharge, 12-7 
Alarm acquisition, 1-6 
Alarm buffer, 1-6 

in Runtime, 8-2 
Alarm events, 1-6 
Alarm indicator 

Behavior, 9-22 
in Runtime, 8-3 
Purpose, 9-22 

Alarm log 
in Runtime, 8-2 
Scope of alarm logging, 8-4 

Alarm logging, 1-6 
Alarm protocol, 8-2, 8-8 
Alarm view 

in Runtime, 8-2 
Layout, 9-23 
Operator controls, 9-24 
Purpose, 9-23 

Alarm window 
in Runtime, 8-3 

ALARM_S, 1-6 
Alarms 

Functional scope, 1-5 
in Runtime, 8-2 

Alignment 
Printer, 6-11 

Alphanumeric key assignment, 9-8 
Alphanumeric keys, 5-6 
Alphanumeric screen keyboard, 9-5 

ALT 
Key, 9-9 

Alt layer 
Screen keyboard, 9-6 

Ambient conditions, 12-7 
Angle of inclination, 3-4, 12-7 
application 

In industrial sector, 2-1 
In residential areas, 2-2 

Approvals, A-1, A-2 
Area 

Printer, 6-11 
Area of use, 1-2 
ASCII character set 

Printer, 4-8 
Authorization, iv 

Back transfer, 7-21 
in Runtime, 8-7 
Transfer, 7-21 

B 
Back transfer, 7-10 

Execute, 7-11 
Requirements, 7-11 

Back-lighting 
Screen, 1-5, 12-5 
Switch off, 6-14 

Backspace 
Key, 9-8 

Backup, 7-15, 12-6 
Backup battery, 1-9, 4-4, 12-6 

Changing, 11-2 
Bar 

Layout, 9-34 
Operation, 9-34 
Purpose, 9-34 

Barometric pressure, 12-7 
Battery, 1-9, 12-6 

Changing, 11-2 
Battery connection, 4-4 
Baud rate 

Printer, 6-11 
Transfer mode, 7-5 
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Behavior 
Alarm indicator, 9-22 
I/O field, 9-16 
Icon, 9-54 
Recipe view with screen change, 9-28 
Simple recipe view, 9-32 
Sm@rtClient view, 9-51 

Brightness 
Set, 6-7, 9-10 

Bulk storage, 1-10, 12-5 
Burst interference, 12-8 
Button 

Layout, 9-13 
Purpose, 9-13 

Button action feedback, 9-3 

C 
Cable cross-section, 4-15 
Cables, 3-2 
Calibration 

Touch screen, 6-8 
Calling 

Operator note: Touch panel unit, 9-5 
Operator note:keyboard device, 9-11 
Operator note:screen keyboard, 9-5 
Operator note:screen keyboard, 9-5 
Operator note:System function, 9-7 
Operator note:touch panel, 9-5, 9-6 
Remote control, 9-51 
Remote monitoring, 9-51 

Cancel 
Key, 9-8 

Capacity 
Alarm buffer, 1-6 
Backup battery, 12-6 
Memory, 1-5 

CE approval, A-1 
Certificate 

ESD, A-2 
CF card, 1-10 
Changing 

Battery, 11-2 
Language, 7-12 

Character set 
Printer, 4-8 

Cleaning 
Device, 11-1 

Cleaning agents, 11-1 
Clock 

Internal, 1-9 
Operation, 9-43 
Purpose, 9-43 

Close 
Dialog, 9-11 

Color display, 1-5, 12-5 
Colors, 1-5, 12-5 
Combo box 

Open, 9-9 
Commissioning for the first time, 7-1 
Communication, 1-8 

PLCs from other manufacturers, 1-9 
SIMATIC PLCs, 1-8 

Communication options, 4-5 
Compact Flash Card, 1-11, 12-5 
Compatibility conflict, 7-2, 7-3 
Compressing 

PU functions, 4-12 
Conditions for use, 3-2 
Conduction 

RF, 12-8 
Configuration, 10-6 

Memory location, 7-7 
Of recipes, 10-6 
Source file, 7-7 

Configuration computer 
Connecting, 4-13 

Configuration phase, 1-4 
Configuration software, 1-3, 1-5 
Configuring 

Interface IF1B, 4-11 
Conflict 

Compatibility, 7-2, 7-3 
Connecting 

Configuration computer, 4-13 
External keyboard, 4-9 
HMI device, 4-4 
Mouse, 4-9 
PLC, 4-11 
Power supply, 4-15 
Printer, 4-7 
UPS, 4-14 

Connection 
Electrical, 4-4 
Order, 4-4 
To configuration computer, 4-13 
To external keyboard, 4-9 
To mouse, 4-9 
To PLC, 4-11 
To printer:, 4-7 

Contact discharge, 12-7 
Control keys, 5-5 
Control mode 

Remote control, 9-52 
Sm@rtClient view, 9-52 

Conversion functions, 1-7 
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Copy 
Recipe data record in Runtime, 10-15 

create 
Recipe record on the HMI device, 10-15 

Create 
Labeling strips, 5-8 

Cross-section 
Power supply cable, 4-15 

CSV file, 10-5 
C-Tick, A-1 
CTRL 

Key, 9-9 
Cursor 

Key, 5-6, 9-8 
Cut-out 

Installation, 12-5 

D 
Data 

Technical, 12-5 
Data log 

in Runtime, 8-5 
Data loss, 7-16 
Data mailbox 

For recipes, 10-8 
Data record 

exporting, 10-18 
importing, 10-18 
reading, 10-17 
Transfer, 10-17 

Date, 6-5, 7-2 
Date / time field 

Behavior, 9-41 
Keyboard control, 9-41, 9-42 
Layout, 9-41 
Mouse control, 9-42 
Purpose, 9-41 
Touch control, 9-41 

Date and time 
synchronizing, 6-5 

Default setting 
Printer, 6-12 

Degree of protection, 1-2, 3-3, 12-5 
Delete 

Key, 9-8 
deleting 

Recipe data record in Runtime, 10-16 
Depth 

Installation, 12-5 
Device data 

Displaying, 6-10 

Dialog 
Closing, 9-11 

Dim back-lighting 
Screen, 6-13 

Dimensions, 12-5 
MP 370 12" Key, 12-4 
MP 370 12" Touch, 12-1 
MP 370 15" Touch, 12-3 

Directives 
EEC, 12-7 
ESD, A-2 

DirectKey, 9-2 
Discharge 

Static, 12-7 
Display, 1-5 

Set brightness, 6-7 
DNS server, 6-18 

E 
Editing, 10-5 

Recipe data record in WinCC flexible, 10-5 
Recipe record, 10-5 

Electrostatic discharge 
Precautions, A-2 

EMC directives, 3-1 
END 

Key, 9-8 
Enter 

Key, 9-8 
ENTER 

Key, 9-8 
ESC 

Key, 9-8 
ESC/P compatibility, 4-7 
ESD, A-2 

Handling, A-3 
Measuring, A-3 
Shipping, A-3 

Ethernet, 6-17 
Ethernet interface, 4-4 

Assignment, 12-10 
Ex Zone 2/22, A-1 
Example 

Network functions, 6-21 
Exchange 

Labeling strips, 5-7 
exporting 

Recipe, 10-18 
Recipe record, 10-18 
User data, 8-8 

Extend 
Memory, 1-10 
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External dimensions, 12-5 
External keyboard 

Connecting, 4-9 
Operation, 5-9 

F 
Features 

MP 370, 1-5 
Multi Panels, 1-1 

Flashing 
LED, 5-4 

FM approval, A-2 
Foil 

Labeling strips, 5-8 
Forcing 

Permissions in remote operation, 9-52 
Format 

Paper, 6-11 
Front panel 

Thickness, 3-3, 3-4 
Front view 

MP 370 12" Key, 12-4 
MP 370 12" Touch, 12-1 
MP 370 15" Touch, 12-3 

Function keys, 1-5, 5-2 
LED, 5-4 

Functional scope, 1-5 

G 
Gauge 

Layout, 9-40 
Operation, 9-40 
Purpose, 9-40 

General operation 
Keyboard unit, 9-7 
Touch panel unit, 9-2 

Global softkey, 5-4 
Graphic I/O field 

Purpose, 9-18 
Ground connection, 4-4, 4-6 
Grounding, 4-6 
Grounding screw, 4-6 
Group acknowledgement, 1-6, 9-8 

H 
Hardware options, 1-9 
Hazardous location, A-1 

Help text, 1-7 
Calling:keyboard device, 9-11 
calling:screen keyboard, 9-5 
Calling:system function, 9-7 
Calling:Touch panel, 9-5, 9-6 
viewing (key), 9-8 

Hide 
Screen keyboard, 9-5 

High frequency radiation, 2-1 
HMI device 

Connecting, 4-4 
Name in the network, 6-5 
Recommissioning, 7-3 
remote control, 9-51 
remote monitoring, 9-51 
Transfer mode, 7-3 

HOME 
Key, 9-8 

Housing, 12-5 

I 
I/O field 

Behavior, 9-16 
Keyboard control, 9-17 
Layout, 9-16 
Mouse control, 9-17 
Purpose, 9-16 
Touch control, 9-16 

Icon, 5-4 
Behavior, 9-54 
Purpose, 9-54 

Immunity to interference 
EMC directives, 3-1 

importing 
Recipe, 10-18 
Recipe record, 10-18 
User data, 8-8 

Increase 
Brightness, 6-7 

Indicators, 12-5 
information 

General, 2-1 
Safety, 2-1 

Input 
Alphanumeric values:touch panel, 9-5 
Numeric values:touch panel, 9-5 

Input of alphanumeric values 
Touch panel unit, 9-5 

Input of numeric values 
Touch panel unit, 9-5 
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Installation 
Configuration computer, 4-13 
External keyboard, 4-9 
in 19 inch cabinets, 4-1 
Keyboard unit, 4-1 
Mechanical, 4-1 
Mouse, 4-9 
PLC, 4-11 
Printer, 4-7 
Touch panel unit, 4-2 

Installation conditions, 3-3 
Installation cut-out, 12-5 

Keyboard unit, 3-4 
MP 370 12 inch touch panel unit, 3-4 
MP 370 15 inch touch panel unit, 3-4 

Installation depth, 12-5 
Installation dimensions 

19 inch cabinets, 4-1 
Installation location, 1-2, 3-3 
Installation position, 12-7 
Interface assignments, 12-8 
Interface IF1A 

Assignment, 12-8 
Interface IF1B 

Assignment, 12-9 
Interface IF2 

Assignment, 12-9 
Interfaces, 1-5 

Configure 1F1B, 4-11 
IF1A, 4-11 
IF1B, 4-11 
IF2, 4-13 

Internet Explorer, 1-12 
Irradiation 

RF, 12-7 

K 
Key pads, 5-2 
Keyboard, 1-5, 12-6 

Connecting, 4-9 
Keyboard control 

Date / time field, 9-41, 9-42 
I/O field, 9-17 

Keyboard layers, 9-6 
Keys 

Remote control, 9-53 

L 
Labeling 

Softkey, 5-6 

Labeling strips, 4-1 
Exchange, 5-7 
printing, 5-8 
Template file, 5-8 

Landscape format 
Printer, 6-11 

Language 
Set, 7-12 

Language switching, 1-8, 7-12, 9-1 
Layout 

Alarm view, 9-23 
Bar, 9-34 
Button, 9-13 
Gauge, 9-40 
I/O field, 9-16 
Recipe view, 9-28 
Simple alarm view, 9-26 
Simple recipe view, 9-31 
Simple user view, 9-46 
Slider control, 9-38 
Sm@rtClient view, 9-51 
Status force, 9-48 
Switch, 9-14 
Trend view, 9-35 
User view, 9-44 

LCD type, 12-5 
LED control, 5-4, 8-9 
Length 

Alarm text, 1-6 
Light emitting diode 

Acknowledge, 9-8 
Help text, 9-8 
Softkey, 5-4 
Toggle, 9-8 

Limit value monitoring, 1-7 
Lines, 3-2 
Literature, 1-5 
Lithium battery, 12-6 

Warning, 11-3 
Load 

Project data, 7-1 
Recipe data record in Runtime, 10-15 

Loader, 6-1 
Password protection, 6-2 

Local function keys, 5-4 
Log 

in Runtime, 8-3 
Memory options, 8-4 

Logging, 1-7 
Scope of alarm logging, 8-4 

Log-off time 
exporting/importing, 8-8 
in Runtime, 8-8 
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M 
Maintenance, 11-1 
Manual transfer, 7-3 
Margin 

Printer, 6-12 
Mechanical installation, 4-1 
Membrane keyboard, 1-5, 12-6 
Memory, 1-5 
Memory card, 1-10 
Memory extension, 1-5 
Memory location 

Project file, 7-7 
Menu bar 

Enable, 9-11 
Modal dialogs, 7-4 
Mode 

Printer, 6-11 
modify 

Recipe data record in Runtime, 10-15 
Modifying recipe structures, 10-19 
Monitoring mode 

Sm@rtClient view, 9-52 
Mouse 

Connecting, 4-9 
Operation, 5-9 

Mouse control 
Date / time field, 9-42 
I/O field, 9-17 

Mouse pointer, 5-9 
MPI address 

Transfer mode, 7-5 
MPI transfer, 7-6 
Multi Panels, 1-1 
Multifunctional platform, 1-1 
Multiple key operation, 9-1 

N 
Navigating 

Operating system, 9-10 
Network connection, 12-7 
Noise immunity, 12-7, 12-8 
Norms, 12-7 

Number 
Alarms, 1-5 
Colors (display), 12-5 
Data records, 1-7 
Fields per screen, 1-6 
Graphics lists, 1-7 
Languages, 1-8 
Recipes, 1-7 
Scripts, 1-8 
Tags per screen, 1-6 
Text lists, 1-7 
User, 1-7 

Numeric keyboard assignment, 9-8 
Numeric screen keyboard, 9-5 

O 
OEM applications, 6-15 

Memory requirements, 6-15 
Offices, iii 
Offline test, 7-9 
Online test, 7-9 
OPC, 1-8 
Open 

Combo box, 9-9 
Tab, 9-11 
Task Manager, 9-10 
Windows CE Start menu, 9-10 

Operating a keyboard device, 9-7 
Operating mode 

Changing, 7-13 
Offline mode, 7-13 
Online mode, 7-13 
Transfer mode, 7-13 

Operating mode switchover, 7-9 
Operating recipes 

Copying a recipe data record, 10-15 
Creating recipe records, 10-15 
Data record transfer, 10-17 
Delete recipe data record, 10-16 
Exporting data records, 10-18 
Import a data record, 10-18 
Load recipe data record, 10-15 
Modify recipe record, 10-15 
Modifying the recipe structure, 10-19 
Read recipe data record, 10-17 
Synchronizing recipe tags, 10-16 

Operating system, 1-1, 1-5, 12-5 
Navigation, 9-10 
Updating, 7-18 

Operating the touch panel (TP), 9-2 
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Operation 
Bar, 9-34 
Clock, 9-43 
Gauge, 9-40 
Keyboard unit, 9-7 
Touch objects, 9-2 
Touch panel unit, 9-2 

Operator controls 
Alarm view, 9-24 
Recipe view, 9-29 
Simple alarm view, 9-27 
Simple recipe view, 9-32 
Status force, 9-49 
Trend view, 9-35 

Optimization 
Brightness, 6-7 

Option 
Back transfer, 7-23 
Transfer, 7-22 

Options 
Backup battery, 1-9 
CF card, 1-10 
Memory card, 1-10 
PC card, 1-10 

Order 
The connections, 4-4 

Overheating, 3-4 
Overview, 1-1, 1-5 

P 
Page margin 

Printer, 6-12 
Paper size, 6-11 
Password 

exporting/importing, 8-8 
in Runtime, 8-7 

Path specification 
Project file, 7-7 

PC 
Connecting, 4-13 

PC card, 1-10, 1-11, 12-5 
PCL compatibility, 4-8 
PE connection, 4-4 
Permission 

forcing (remote operation), 9-52 
PG 

Connecting, 4-13 
PG interface, 4-11 
Pin assignment, 12-8 
Pin plug connector, 4-15 

Plan view 
MP 370 12" Key, 12-4 
MP 370 12" Touch, 12-1 
MP 370 15" Touch, 12-3 

PLC 
Connecting, 4-11 

Plug connections, 3-2 
Plug-in terminal block, 4-15 
Port 

Printer, 6-11 
Portrait format 

Printer, 6-11 
Power cables, 3-2 
Power consumption, 12-6 
Power supply, 4-4, 4-15, 12-6 
Print functions, 1-7 
Print quality 

Set, 6-11 
Printer 

Connecting, 4-7 
Set, 6-10 

printing 
Report, 8-5 
Runtime, 8-8 
Screen, 8-8 

Process running phase, 1-4 
Processor type, 1-5, 12-5 
Product category, 1-1 
PROFIBUS DP, 4-11 
Profiles, 4-1 
Programming voltage, 1-11 
Project 

Back transfer, 7-10 
Replace, 7-3 
Test, 7-9 
Test offline, 7-9 
Test online, 7-10 

Project data 
Load, 7-1 

ProSave, 7-14 
Backup, 7-15 
Integrated, 7-14 
Restore, 7-17 
Stand-alone, 7-14 

PU functions, 1-8 
Pulse modulation, 12-7 
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Purpose 
Alarm indicator, 9-22 
Alarm view, 9-23 
Bar, 9-34 
Button, 9-13 
Clock, 9-43 
Gauge, 9-40 
I/O field, 9-16 
Icon, 9-54 
Recipe view, 9-28 
Simple alarm view, 9-25 
Simple recipe view, 9-31 
Simple user view, 9-46 
Slider control, 9-38 
Sm@rtClient view, 9-51 
Status force, 9-48 
Switch, 9-14 
Trend view, 9-35 

Q 
Quality 

Graphic printing, 6-11 

R 
Radio interference, 12-8 
Radio interference level, 12-8 
Rated voltage, 12-6 
Recipe, 10-3, 10-4 

Basic principles, 10-3 
Configuration options, 10-6 
Configuration settings, 10-6 
Data record, 10-4 
Design, 10-3 
Display in Runtime, 10-1, 10-12 
exporting, 10-18 
importing, 10-18 

Recipe record, 10-4 
Copy, 10-15 
Create on the HMI device, 10-15 
deleting, 10-16 
Design, 10-3 
Editing in WinCC flexible, 10-5 
exporting, 10-18 
importing, 10-18 
Load, 10-15 
modify, 10-15 
synchronizing, 10-16 
Transfer, 10-5 
Transfer options, 10-5 

Recipe screen, 10-13 
Overview, 10-13 

Recipe view, 10-12 
Behavior with screen change, 9-28, 10-14 
Layout, 9-28 
Operation with function keys, 10-14 
Operator controls, 9-29 
Overview, 10-12 
Purpose, 9-28 

Recipes, 1-7 
Recommissioning 

HMI device, 7-3 
Reduce 

Brightness, 6-8 
Regional setting, 6-13 
Relative humidity, 12-7 
Remote control 

calling, 9-51 
Forcing permission, 9-52 
of HMI devices, 9-51 
Stop, 9-52 

Remote monitoring 
calling, 9-51 
of HMI devices, 9-51 
Stop, 9-52 

Report 
in Runtime, 8-5 
printing, 8-5 

Representatives, iii 
Resolution 

Indicators, 1-5, 12-5 
Restore, 7-16 
Reverse poling protection, 4-15 
RF conduction, 12-8 
RF irradiation, 12-7 
RJ45 plug, 12-10 
RTS signal, 4-11 
Runtime 

Language switching, 9-1 
Multiple key operation, 9-1 
Operation, 9-1 
Pictograms, 9-2 

Runtime software, 7-7 
Load, 7-1 

S 
Safety, 1-7 

in Runtime, 8-7 
Safety notes 

High frequency radiation, 2-1 
Work on the cabinet, 2-1 

Scheduler, 1-8 
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Screen, 12-5 
printing, 8-8 
Set brightness, 6-7, 9-10 
Templates, 9-2 

Screen change, 5-4 
Screen diagonals, 1-5 
Screen keyboard, 9-4 

Alphanumeric, 9-5 
Numeric, 9-5 
Set, 6-6 

Screen objects, 1-6 
in Runtime, overview, 8-1 

Screen objects in Runtime 
Overview, 8-1 

Screensaver, 6-13 
Screw type clamps, 4-2 
Scripts, 1-8 
Scrolling back 

Key, 9-8 
Scrolling up 

Key, 9-8 
Seal, 3-3, 4-3 
Securing, 4-1 

Touch panel unit, 4-2 
Selection 

all, 9-10 
Serial printer, 4-8 
Service 

In the Internet, iv 
Service life 

Backup battery, 11-2 
Servicing, 11-1 
Set up 

Network, 6-17 
Printer, 6-10 

Settings 
Brightness, 6-7, 9-10 
Contrast, 6-7 
Date/time, 6-5 
Language, 7-12 
Network, 6-6 
Printer, 6-10 
Regional, 6-13 
Save, 6-9 
Screen keyboard, 6-6 
Touch calibration, 6-7, 6-8 
Volume, 6-17 

SHIFT 
Key, 9-8 

Shift layer 
Screen keyboard, 9-6 

Shift+Alt-Gr layer 
Screen keyboard, 9-6 

Shock loading, 12-7 

Side view 
MP 370 12" Key, 12-4 
MP 370 12" Touch, 12-1 
MP 370 15" Touch, 12-3 

Signal lines, 3-2 
Signal tone, 6-17 
SIMATIC 500/505 DP, 1-8 
SIMATIC 500/505 serial, 1-8 
SIMATIC HMI HTTP Protocol, 1-8 
SIMATIC S5 AS511, 1-8 
SIMATIC S5 DP, 1-8 
SIMATIC S7-200, 1-8 
SIMATIC S7-300/400, 1-8 
SIMATIC WinAC, 1-8 
SIMOTION, 1-8 
Simple alarm view 

Layout, 9-26 
Operator controls, 9-27 
Purpose, 9-25 

Simple recipe view 
Behavior, 9-32 
Layout, 9-31 
Operator controls, 9-32 
Purpose, 9-31 

Simple user view 
Layout, 9-46 
Purpose, 9-46 

Size 
Paper, 6-11 

Slider control 
Layout, 9-38 
Purpose, 9-38 

Slot A, 1-10 
Slot B, 1-10 
Sm@rtClient view 

Behavior, 9-51 
Control mode, 9-52 
Layout, 9-51 
Monitoring mode, 9-52 
Purpose, 9-51 

Softkey, 5-4 
Labeling, 5-6 
Remote control, 9-53 

Softkeys, 1-5 
Software, 12-5 
Software options, 1-12 
Source file 

Memory location, 7-7 
Special characters 

Key, 9-9 
Stand-alone ProSave 

Backup, 7-15 
Standard cables, 4-13 
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Standard layer 
Screen keyboard, 9-6 

Start screen, 7-2 
Start up, 7-1 
Static discharge, 12-7 
Status force 

Layout, 9-48 
Operator controls, 9-49 
Purpose, 9-48 

Stop 
Remote control and monitoring, 9-52 

Storage location 
Project file, 7-7 
Runtime software, 7-7 
Source file, 7-7 

Sub-D plug, 12-9 
Sub-D socket, 12-8, 12-9 
Sunlight, 3-4 
Supply source 

Backup battery, 11-2 
Support 

In the Internet, iv 
Surge coupling, 12-8 
Switch 

For 1F1B interface, 4-11 
Layout, 9-14 
Purpose, 9-14 

Switch off 
Back-lighting, 6-13 
Power supply, 1-12 

Switch settings 
Interface IF1B, 4-11 

Symbolic I/O field 
Purpose, 9-20 

Synchronization 
With controller, 10-8 

synchronizing, 6-5 
Synchronizing 

Recipe record, 10-16 
Synchronizing recipe tags, 10-16 
System alarms, A-4 

Meaning, A-4 
Parameters, A-4 

System function, 10-5 
to transfer of recipe data records, 10-5 

System keys, 1-5, 5-3, 5-5 
System settings, 6-2 

T 
TAB 

Key, 9-8 

Tabulator 
Key, 9-8 

Tags 
in Runtime, 8-3 

Task Manager, 9-10 
Technical specifications, 12-5 
Technical Support, iv 
TeleService, 1-1 
Test 

Network, 6-20 
Project, 7-9 

Thickness 
Front panel, 3-3, 3-4 

Time, 6-5, 7-2 
Time zone, 6-5 
Toggle 

Key, 9-8 
Torque, 4-3 
Touch control 

Date / time field, 9-41 
I/O field, 9-16 

Touch objects 
operating, 9-2 

Touch screen 
Calibration, 6-8 

Trademark, iii 
Training center, iv 
Transfer, 10-5 

Of recipe data records, 10-5 
Options, 7-5 
Start manually, 7-3 
TeleService, 1-1 

Transfer mode, 9-10 
Transients, 12-6 
Trend view 

Layout, 9-35 
Operator controls, 9-35 
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